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COURSE INTRODUCTION

This course on Computer Fundamentals and PC Software is designed with an aim to ac-

quaint the learners with the basics of computer, operating systems, hardware and software and also

how to use basic application programs for managing data in a computer system.

The course consists of eleven units. It includes the fundamental concept of an Operating System

besides MS DOS, MS Windows and LINUX operating systems are inctroduced in this course. The

course also deals with Microsoft Office which is an application software  consists of different applica-

tions that helps us to perform different activities. It covers MS-Word, MS-Excel  and MS-PowerPoint.

MS-Word is the word processing program that allows us to create documents and reports. MS-Excel

helps us to develop spreadsheets that display data in various tabular and visual formats. MS-PowerPoint

creates multimedia presentations to display information in a graphical format.

Each unit of this course includes some along-side boxes to help you know some of the difficult,

unfamiliar terms. Some “EXERCISES” have been included to help you apply your mind to some of the

points in the units. You may find some boxes marked with: “LET US KNOW”. These boxes will provide

you with some additional interesting and relevant information. Again, you will get “CHECK YOUR

PROGRESS” questions. These have been designed to enable you to self-check your progress of study.

It will be helpful for you if you solve the problems put in these boxes immediately  after you go through the

sections of the units and then match your answers with “ANSWERS TO CHECK YOUR PROGRESS”

given at the end of each unit.
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UNIT 1 : INTRODUCTION TO COMPUTER

UNIT STRUCTURE

1.1 Learning Objectives

1.2 Introduction

1.3 Computer Evolution and Generation

1.4 Classification of Computer

1.5 Applications of Computer

1.6 Let Us Sum Up

1.7 Answers to Check Your Progress

1.8 Further Readings

1.9 Model Questions

1.1 LEARNING OBJECTIVES

After going through this unit, you will be able to :

 trace the evolution of Computer

 classify the different types of Computer

 describe the model and functioning of a Computer

1.2 INTRODUCTION

Computer is the most powerful tool man has ever created. Computers

have made a great impact on our everyday life.Today, computer technology

has permeated every sphere of existence of modern man . With the growing

information needs in the modern world ,the computer has become  one of

the vital components for the survival of the business houses. Their presence

is felt  in almost every working place from the bus,air and railway ticket

counters to satellite launching, from retail stores to medical diagnosis and

from home use to research and design organization .- everywhere, we

witness the elegance, sophistication and efficiency made  possible only

with the help of computers.Computer has become a part and parcel of our
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daily existence.

In this unit, we will introduce you to the computer fundamentals

including its various components and  functionality. Besides discussing  the

characteristics of computers including its evolution and generations. We

will also throw light on the categories of computers along with its application

in the various fields of the modern world.

1.3 COMPUTER EVOLUTION AND GENERATION

The term computer is derived from the word compute, which means

to calculate. It can be defined as an Electronic machine capable of

performing calculations and other manipulations of various types of data,

under the control of a stored set of instructions. In the simplest form, a

computer can be defined as a programmable machine.  A computer

accepts data from an input device and processes it into useful information

which it displays on its output devices. A general purpose computer generally

has  an input unit, an output unit, a cental processing unit and a memory

unit.

Most of today’s computer designs are based on the concepts

developed by John Von Neumann refered to as the “ Von Neumann

architecture”. According to this structure, a computer must have two units

- a processing unit and a single separate storage unit. The term

“storedprogram computer” is generally used to mean a computer of this

design. The processing unit is termed as central processing unit (CPU)

which mainly comprises  another two units, namely Arithmetic and Logic

Unit (ALU) and Control Unit (CU). The ALU performs the  arithmetic

operations on data such as addition, subtraction,multiplication and division,

and the logical operations such as, >, <, >=. <=  etc. The control unit directs

the ALU to perform specific arithmetic and logical functions on the data.

The storage unit is used to store instructions and data temporarily. This

component is referred to as memory. The memory unit stores all the

information in a group of memory cells, also called memory locations, as

binary digits(bits). Each memory location has a unique address and can be
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addressed independently.

The following figure shows the basic structure of a conventional Von

Neumann machine :

Fig. 1.1 : Von Neumann Architecture

Depending on the major technological development, the whole evolution

process of the computer can be categorised into some generation which

possessed some special characteristics.

There are five generations of computers as follows :

First Generation (1945 – 55) : The computers of this generation

used vacuum tubes and consumed more power. Assembly languages were

used for preparing programs. Mercury delay line memories and Electrostatic

memories were used for storing programs. Punched cards and paper tape

were invented to feed programs and data and to get results. The cost of the

first generation computers were very high and they were  mainly used for

scientific computations.

Examples of computers of this generation are :

ENIAC – Electronic Numerical Integrator And Calculator

EDSAC – Electronic Delay Storage Automatic Calculator

EDVAC – Electronic Discrete Variable Automatic Computer

  Central Processing Unit (CPU) 

 Operational Registers 

 Control Unit 

 Arithmetic and 
Logic Unit 

 Main Memory 

 Address 
Interconnection 

 Data and instruction 
Interconnection 

 

  

 

  
Input/Output System 

NOTE :
All the arithmetic and
logical operations are
performed in the CPU in
special storage areas
called registers. The size
of the  register is one of
the important consider-
ations in determining the
processing capabilities of
the CPU. Register size
refers to the amount of
information that can be
held in a register at a
time for processing. The
larger  the register size,
the faster may be the
speed of processing
CPU. Processing power
is measured in Million
Instruction Per Second
(MIPS).
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UNIVAC – Universal Automatic Computer IBM 701

Second Generation (1955 – 65) : The second generation computers

used transistors. They consumed less power and were smaller in size.

Magnetic ferrite core memories were used as main memory  and magnetic

tapes and magnetic disks were used as secondary memory. High level

languages such as FORTRAN, COBOL etc were used. Examples of

computers of this generation are– IBM 7030, Digital Data Corporation’s PDP

1/5/8 Honeywell 400.

Third Generation (1965 – 75) : The third generation computers

used IC(Integrated Circuits). Small Scale Integration and Medium Scale

Integration technology were implemented during this generation.

Semiconductor memories were introduced in this generation computers

They became smaller in size  with fast processors and the cost of the

computers had gone down.

Examples of computers of this generation are - 360 Mainframe from

IBM, PDP-8 Mini Computer from Digital Equipment corporation).

Fourth Generation (1975 – 89) : Microprocessors were introduced

as CPU. Very large Scale Integration (VLSI) techniques were used during

this generation. Semiconductor memory chips were used as main memory.

Hard disks, floppy disks, magnetic tapes were used as secondary memory.

A lots of technology like parallelism, pipelining, cache memory, virtual

memory and networking techniques were applied during this generation.

Examples of computers of this generation are - Intel’s 8088, 80286,

80386, 80486 .., Motorola’s 68000, 68030, 68040, Apple II, CRAY I/2/X/MP

etc.).

Fifth Generation (1989 to present) : Computers based on artificial

intelligence are available in the fifth generation. ULSI (Ultra Large Scale

Integration) technology used in fifth generation computer, for example, Intel’s

Pentium 4 microprocessor contains 55 million transistors, millions of

components on a single IC chip. Superscalar processors, Vector processors,

SIMD processors, 32 bit micro controllers and embedded processors, Digital

Signal Processors (DSP) etc have been developed in fifth generation.

Recent development of grid technology and  nanotechnology will radically

Introduction to ComputerUnit 1



Computer Fundamentals and PC Software 11

change the phase of computers.

Examples of computers of this generation are– IBM notebooks,

Pantium PCs-Pentium 1/2/3/4/Dual core/Quad core.. SUN work stations,

Origin 2000, PARAM 10000, IBM SP/2).

1.4 CLASSIFICATION OF COMPUTER

Computers can be classified according to their size and power as

follows :

 Micro computer

 Mini computer

 Mainframe

 Supercomputer

Micro Computers :
 A microcomputer uses a microprocessor as its central Processing

Unit. Microcomputers are tiny computers that can vary in size

from a single chip to the size of a desktop model

 They are designed to be used by only one person at a time

 Small to medium data storage capacities 500MB – 2GB or more

The common examples of microcomputers are chips used in washing

machines, TVs, Cars and Note book/Personal computers.

E.g. : IBM PC, PS/2 and Apple Macintosh

Applications : Used in the field of desktop publishing, accounting,

statistical analysis, graphic designing, investment analysis, project

management, teaching, entertainment etc. The different models of

microcomputers are given    below :

a) Personal computers : The name PC was given by the IBM for

its microcomputers. PCs are used for word processing,

spreadsheet calculations, database management etc.

b) Note book or Lap Top : It is small in terms of size and can be

folded and carried around.Its monitor is made up of LCD and the

keyboard and system units are contained in a single box. It has

all the facilities of a personal computer (HDD, CDD, Sound card,

Introduction to Computer Unit 1
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N/W card, Modem etc) and a special connection to connect to

the desktop PC which can be used to transfer data.

c) Palm Top : Smaller model of the microcomputer.Its size is similar

to that of a calculator – pocket size. It has a processor and

memory and a special connection to connect to the desktop PC

which can be used to transfer data.

d) Personal Digital Assistance :  A personal digital  assistant is a

small palm-sized hand-held computer which has a small colour

touch screen with audio and video features. They are used as

smart phones, web-enabled plamtop computers, portable media

players or gaming devices. Most PDAs today have a touch screen

for data entry, a memory card, bluetooth, Wi-Fi or an infra red

connectivity and can be used to access the Internet and other

networks.

a) Personal computer b) Notebook computer

d) Palmtop computer e) PDA (personal digital assistant)

Fig. 1.6 : Micro Computer

Mini Computers :

 Perform better than micros

 Large in size and costlier than micros

Introduction to ComputerUnit 1
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 Designed to support more than one user at a time

 Possess large storage capacities and operate at higher speed

 Support faster peripheral devices like high speed printers

 Can also communicate with main frames

Applications :

 These computers are used when the volume of processing is

large For example Data processing for a medium sized

organization

 Are used to control and monitor production processes

 Used to analyze results of experiments in laboratories

 Used as servers in LANs (Local Area Networks)

Examples of mini computers are - Digital Equipments PDP 11/45

and VAX 11 etc. The following fig. shows a mini computer :

Main Frame Computers :

 Are able to process large amount of data at a very high speed

 Support multi-user facility

 Number of processors varies from one to six.

 Cost: 3500 to many million dollars

 Are to be kept in air conditioned room to keep them cool

 Support many I/O and auxiliary storage devices

 Support network of terminals

Fig. 1.7 : Mini computer

Introduction to Computer Unit 1



Computer Fundamentals and PC Software14

Fig. 1.8 : Mainframe computer

Applications :

 Mainframe computers are used to process large amount of data

at a very high speed such as in the case of Banks/ Insurance

Companies/ Hospitals/ Railways…which need online processing

of large number of transactions and requires massive data

storage and processing capabilities

 used as controlling nodes in WANs (Wide Area Networks)

 used to mange large centralized databases

Examples of main frame computers are– IBM 370, IBM 3081, IBM

3000 series, Univac 1180, DEC IBM 3000 series, CDC Cyber - 2000V etc.

Super Computer : Supercomputer is a broad term for one of the

fastest computers currently available. The main characteristics of a super

computer are :

 Most powerful Computer system -it needs a large room

 Minimum world length is 64 bits

 CPU speed: 100 MIPS (Million instruction per second)

 Equivalent to 4000 computers

 High cost: 4 – 5 millions

 Able to handle large amount of data

 High power consumption

 High precision

Introduction to ComputerUnit 1



Computer Fundamentals and PC Software 15

Fig. 1.9 : PARAM 1000 Series Super Computer

Applications :

 In petroleum industry - to analyze volumes of seismic data which

are gathered during oil seeking explorations to identify areas

where there is possibility of getting petroleum products inside

the earth

 In Aerospace industry - to simulate airflow around an aircraft at

different speeds and altitude. This helps in producing an effective

aerodynamic design for superior performance

 In Automobile industry – to do crash simulation of the design of

an automobile before it is released for manufacturing – for better

automobile design

Introduction to Computer Unit 1
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 In structural mechanics – to solve complex structural engineering

problems to ensure safety, reliability and cost effectiveness. For

example the designer of a large bridge has to ensure that the

bridge must be proper in various atmospheric conditions and

pressures from wind, velocity etc and under load conditions.

 Meteorological centers use super computers for weather

forecasting

 In Biomedical research – atomic nuclear and plasma analysis –

to study the structure of viruses such as that causing AIDS

 For weapons research and development, sending rockets to

space etc.

Examples of supercomputers are : Cray-1(1976), Cray-2(1985), Cray

T3D(1993), NEC’s SX-S/44(1991), Fujitsu VP 2600/10(1991), Hitachi 820/

80(1987), C-DAC’s PARAM Series of supercomputers etc. A PARAM 10000

series super computer of IIT  Guwahati is shown in the above figure.

1.5 APPLICATIONS OF COMPUTER

Now a days ,computeris are  used almost in every aspect of life.

Every company , small or large, government offices, educational institutions

are now directly or indirectly dependent on computers mainly for information

processing. Computer based railway and airway reservation system  is a

common example of  computer application. Computer system is helping in

the efficient management of the banking sector, hospital records, payroll

records and so on. Some of the areas where computers are being used

mostly can be listed as below:

Science : Scientists are using computers to carry out their research

works based on complex computations because of computer’s  fast speed

and the accuracy.

Education : In schools and colleges, to make education much more

interesting, computers are used now a days. Computer Aided Education

(CAE) and Computer Based Training (CBT) packages are making learning

much more interactive.

Introduction to ComputerUnit 1
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Health and Medicine : Starting from diagnosing the illness to

monitoring a patient’s status during a surgery , in pathological analysis ,in

CAT scans or MRI scans etc. , doctors are using computers. Some special

purpose computers are available which can even be operated within the

human body.

Engineering : Engineers and architects are using computers in

designing machineries, drawing design layouts. Architects can  object that

can be viewed from all the three dimensions by using techniques like virtual

reality. In manufacturing industries, using computerized robotic arms

hazardous jobs can be performed. The packages like Computer Aided

Designing (CAD), Computer Aided Manufacturing (CAM) and so on are

used in designing the product, ordering the parts and planning production.

Entertainment : With the use of multimedia facilities , computers

are now greatly used in entertainment industry. Computers are used to

control and bring special effects  on image and sound.

Communication : Computer network and finally the Internet has

brought a drastic change in communication system. Through E-mail or

Electronic mail, it is possible to send messages and reports very fast  from

one person to another or a group of persons with the aid of computers and

telephone lines.

Business and Banking :  Computer network and finally the Internet

has brought a drastic change in communication system. Through E-mail or

Electronic mail, it is possible to send messages and reports very fast  from

one person to another or a group of persons with the aid of computers and

telephone lines.

In order to deposit or withdraw cash from bank, people can use

ATM (Automated Teller Machine) services 24 hours of the day. Through the

computer networks among different branches of a bank, inter branch

transactions can be carried out without delay.

Apart from the above mentioned applications , there are many other

applications of computers that can be seen in our day to day activities.

Introduction to Computer Unit 1
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CHECK YOUR PROGRESS

Q.1. State True or False:

i) PARAM is a super computer.

ii) A laptop is a portable computer.

iii) Vacuum tubes were part of the second generation

computers.

iv) Micro computers are more powerful than mini computers.

v) EDSAC is an example of a second generation computer.

Q.2. Fill in the blanks :

i) Physical components of a computer are called

__________.

ii) The basic components of first generation computers was

__________.

iii) PDA stands for __________.

iv) __________ is a very small computer that can be held in

the palm of the hand.

v) Analytical Engine was developed by __________.

Q.3. What is a PDA?

............................................................................................

Q.4. Name some storage device used in computer.

............................................................................................

ACTIVITY

 Create a table on various generations of computers with

hardware and software details.

 Prepare a list of areas where computers are used. Mention

the specific software for each application and its significance.

 

 

Introduction to ComputerUnit 1
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1.6 LET US SUM UP

 Computer is an electronic device that is used to perform  diverse

operations with the help of  instructions  to process the data in order

to produce desired results.

 Computer development is divided into five generations.

 The first generation of computers used vacuum tubes for circuitry

and magnetic drums for memory, and were often enormous, taking

up entire rooms.

 In the second generation of computers, transistors replaced vacuum

tubes.

 The integrated circuits were used in the  third generation of

computers.

 The  fourth generation of computers are based on microprocessors.

 Fifth generation computers are based on  artificial intelligence.

 Micro computer is a small, low cost digital computer and includes

desktop, laptop, PDA.

 A mini computer is a small digital computer which is  more powerful

than a micro computer.

 A mainframe computer consists of several processors that carry

out most of the computations and have direct control  over all the

other computers in a network.

 Supercomputers are the most powerful computers used for

processing complex scientific applications that involve task with

highly complex calculations and solving problems with mechanical

physics, such as weather forcasting and climate research systems,

nuclear weapon simulation and simulation of automated aircrafts.

1.7 ANSWERS TO CHECK YOUR PROGRESS

Ans. to Q. No. 1 : i) True,  ii) True,  iii) False, iv) False, v)

False

Ans. to Q. No. 2 : i) Hardware, ii) Vacuum tubes, iii) Personal Digital

Introduction to Computer Unit 1
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Assistant, iv) Palmtop,  v) Charles Babbage.

Ans. to Q. No. 3 : A personal digital  assistant is a small palm-sized hand-

held computer which has a small colour touch screen

with audio and video features.

Ans. to Q. No. 4 : Hard Disk, CD-ROM, DVD-ROM, Pen Drive etc.

1.8 FURTHER READINGS

 Computer Fundaments by P. K. Sinha, BPB Publication.

 Computer Fundaments by B. Ram, New Age International Publishers.

1.9 MODEL QUESTIONS

Q.1. Who invented the concept of stored program ? Why is this concept

so important ?

Q.2. List the key hardware technologies used in building computer of each

of the five generations.

Q.3. What are the advantages of transistors over vacuum  tubes?

Q.4. What is an IC ? How does it help in reducing the size of computers

Q.5. Discuss the important features of various generations of

computers. Give some examples of the computers of each

generation.

Q.6. What is computer? What are the characteristics of a Computer?

Do you think computers are superior to human being?

Q.7. Describe the evolution of computers.

Q.8. How are computers  categorized into different categories?

Introduction to ComputerUnit 1
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UNIT 2 : BASIC COMPONENTS OF COMPUTER

UNIT STRUCTURE

2.1 Learning Objectives

2.2 Introduction

2.3 Concepts of Bits and Bytes

2.4 Block Diagram of a Computer

2.5 Computer Memory

2.5.1 Primary Memory

2.5.2 Secondary Memory

2.6 Input Devices

2.6.1 Keyboard

2.6.2 Mouse

2.6.3 Hand-held Devices

2.6.4 Optical Input Devices

2.7 Output Devices

2.7.1 Display Devices

2.7.2 Printers

2.8 Computer Bus

2.9 Let Us Sum Up

2.10 Further Readings

2.11 Answers to Check Your Progress

2.12 Model Questions

2.1 LEARNING OBJECTIVES

After going through this unit, you will be able to :

 explain the concept of bits and bytes

 understand the block diagram of a computer

 discuss the primary and secondary memory in computer

 analyse the different types of input and output devices

 know the different types of buses
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2.2 INTRODUCTION

A computer system is composed of various components which

perform their unique functions. In this unit, we will introduce you to the basic

components of a computer system where you will first learn how the data

are represented in the form of bits and bytes. Through this unit you will be

acquinted with the types of computer memory. Various types of input and

output devices and the basic functioning of a bus are also included as a part

of discussion in this unit.

2.3 CONCEPTS OF BITS AND BYTES

You may be surprised to know that the computer is made up of

millions of tiny electric circuits that are not visible to us. The memory elements

are also built with these tiny circuits  which are used for storing data. For

every circuit in a computer chip, there are two possibilities:

 an electric current flows through the circuit, or

 an electric current does not flow through the circuit.

When an electric current flows through a circuit, the circuit is on.

When no electricity flows, the circuit is off.  An “on” circuit is represented by

the number one (1) and an off circuit is represented by the number zero (0).

The number 1 or  0 is called bit. A number system that uses only two digits,

0 and 1, is called the binary number system. The binary number system

is also called the base two system. The two symbols 0 and 1 are known as

binary digit. The word bit comes from “binary digit”.

Always remember that each time a computer reads an instruction, it

translates that instruction into a series of bits, 1’s and 0’s.  On most computers
 

1           0         1          1          1        0          1       0 

1 byte 

8 bit 

Fig. 2.1

Basic Components of ComputerUnit 2
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every character from the keyboard is translated into eight bits, a combination

of eight 1’s and 0’s.  Each group of 8 bits is called 1 byte as shown in the

follwing figure. Each group of four bits is called a nibble.

Thus, 8 bits = 1 byte and 4 bits = 1 nibble

and 1024 byte = 1 kilo byte

We know that, all the quantities, physical or abstract, can be

measured in some units. For example, time is measured in second; length

is measured in metres ,and mass in grams. Similarly, the computer memory

can be measured in terms of bits, bytes, kilobytes, megabytes, gigabytes

etc.

The followings are the measuring units given in terms of bytes :

1 kilobyte (KB) = 1,024 byte

1 megabyte (MB) = 1,048,576 bytes

1 gigabyte (GB) = 1,073,741,824 bytes

1 terabyte = 1,099,511,627,776

2.4 BLOCK DIAGRAM OF A COMPUTER

All general-purpose computers require the following hardware

components:

Input Unit : This  is the unit through which data and instructions

enter into a computer. Usually a keyboard and mouse are the common

input devices.

Output Unit : This unit communicates the results to the user. A

display screen and a printer are the common devices that let you see what

the computer has accomplished.

Central Processing Unit (CPU) : Execution of programs is the

main function of the computer. The program to be executed is a set of

instructions that is stored in the computer's memory. A task becomes

completed when the instructions of the program are executed by the central

processing unit. All the major calculations and comparisions are carried out

inside the CPU. The CPU is responsible for activating and controlling the

operations of various units (input & output) of the computer system.
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Fig. 2.2

The CPU is made up of three major components : the registers,

the arithmetic and logic unit (ALU) and the control unit. The registers

are responsible for storing the intermediate data during the execution of

program. The control unit supervises the transfer of information between

the registers and instructs the ALU to perform the required operation.

Fig. 2.3 : Components of CPU
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Control Unit(CU) : The control unit controls and guides the

interpretation, flow and manipulation of all the data and information. It does

not perform the actual processing of data, but manages and coordinates

the entire computer system, including the input and output (I/O) devices.

Control unit retrieves and interprets the instructions from the main memory

and send signals to the other units to execute them one after the other.

Some special purpose registers found inside the CPU like instruction register,

program counter etc. help the CU to perform its function smoothly.

Arithmetic Logic Unit (ALU) : The ALU performs all the arithmetical

functions +, -, *, / and some logical functions like <, >, =, <=, >=, <> etc.

When two numbers are required to be added, these numbers are sent from

memory to ALU where addition takes place and the result is sent back to

memory. In the same way, ALU has the special circuitry to carry out the

logical operations.

Storage Unit : The storage unit allows a computer to permanently

retain large amount of data. The storage unit can be categorised into two

types namely primary storage and secondary storage which we will discuss

in the next section. Common mass storage devices include disk drives and

tape drives etc.

2.5 COMPUTER MEMORY

The term memory usually refers to a form of semiconductor storage

and sometimes other forms of fast but temporary storage. In a computer

the data and instructions are stored and subsequently retrieved from the

memory. We have come to know that the CPU has some storage elements

known as registers for storing data and instructions during the program

execution. Every computer requires storage space for storing programs

and data temporarily during the time of program execution or storing the

data parmenently for future use. Generally, a computer has three set of

memories :

a) Primary storage or main memory : Primary memory, also

known as memory, is the only one directly accessible to the

CPU. The CPU continuously reads instructions stored there and
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executes them. Any data actively operated on is also stored there

in uniform manner. It is a  form of semiconductor storage known

as random access memory (RAM) and sometimes other forms

of fast but temporary storage. It is small-sized, light, but quite

expensive. This type of memory is divided into the following two

types :  RAM (Random Accress Memory), ROM (Read Only

Memory).

b) Secondary storage or auxiliary memory : Secondary memory

or storage provides the facility of storing information and

programs permanently . It differs from primary storage in that it

is not directly accessible by the CPU. The computer usually uses

its input/output channels to access secondary storage and

transfers the desired data using intermediate area in primary

storage. Secondary storage does not lose the data when the

device is powered down; it is non-volatile. It is typically also an

order of magnitude  less expensive than primary storage.

c) Internal processor memory : It consists of a small set of high-

speed registers that are used as a temoprary locations inside

the processors during the execution of instructions.

Another type of memory, the cache memory, is  gaining wide

acceptance in modern computers. Its logical position is between the

mainmemory and the  internal memory(registers). Its primary function is to

store and cache part of the main memory's contents that the processor is

currently using.

The computer system has a memory hierarchy consisting of the

storage devices in it. A typical memory hierarchy is illustrated in the figure

2.4 below :

There are three key characteristics of the memory. They are cost,

capacity and access time. On moving down the memory hierarchy, it is

found that  the cost of the storage devices decreases but their storage

capacity as well as the memory access time increases. In other words, the

smaller memories are more expensive and much faster. These are

supplemented by the larger, cheaper and slower storage devices.
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Fig. 2.4 : Memory hierarchy

Thus, from the above figure it can be seen that the registers are at

the top of the hierarchy and so provides the fastest, the smallest and the

most expensive type of memory device for the CPU to access data.

Memory Capacity : Capacity in a computer system is defined in

terms of the number of bytes that it can store in its main memory. This is

usually stated in terms of kilobytes (KB) which is 1024 bytes or megabyte

which is 1,048,576 bytes. The rapidly changing memory capacity of computer

system has resulted in defining the capacity in terms of gigabytes (GB)

which is 1,073,741,824 bytes. Thus, a computer system having a memory

of 1GB is capable of storing (1024 X 1024 X 1024) bytes.

2.5.1 Primary Memory

We have found that primary memories can be categorised into

two types - RAM and ROM. We will now briefly describe  them in

this sub section.

Random Access Memory (RAM) : A computer’s main memory

is often referred to as RAM - an area in the computer system unit
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that temporarily holds user data, operating system instructions and

program instructions. Every time we turn on our computer, a set of

operating system instructions is copied from hard disk into RAM.

These instructions, which help control basic computer functions,

remain in RAM until we turn the computer off.

RAM features :

a) RAM is the place  which holds the data that has to be processed

by the  computer’s preocessor. Moreover, it holds the operating

system and other application programs also.

b) RAM is made up of different ICs (Integreted Circuits). They are

also called semiconductor memory.

c) Each element of RAM is a memory location in which data can

be stored. Each location has a unique address. Using this

address data can be directly retrieved or stored.

d) Since RAM must hold both the data to be processed and the

instructions for processing, its size or capacity is one of the

measures of power of the computer.

e) RAM is a volatile memory. It loses its data when the computer is

turned off.

There are generally two broad categories of random access

memory :

i) DRAM memories (Dynamic Random Access Memory)

ii) SRAM memories (Static Random Access Memory)

DRAM : Dynamic RAM is a type of RAM in which data is stored

in a storage cell, consisting of transistors and capacitors. A common

property of a capacitor is its tendency to get discharge, it means the

current goes down in the circuit and finally data cannot holds for

long time. To  come over this effect, the DRAM needs to be

continuously refreshed with power supply and thus it has one

refreshing circuit which rewrites the data in certain time intervals.

This refreshing circuit refreshes or rewrites the data several hundred

times in a second.
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SRAM : Static RAM is a type of RAM that holds its data as long

as power is supplied to the circuit. The SRAM does not need any

refreshing circuit. SRAMs are used for specific applications within

the PC. The SRAM has the following properties :

 Simplicity : SRAMs don’t require external refresh circuitry  in

order for them to keep their data intact.

 Speed : SRAM is faster than DRAM.

In contrast, SRAMs have the following weaknesses, compared

to DRAMs:

 Cost : SRAM is more expensive than DRAM.

 Size : SRAMs take up much more space than DRAMs

Read Only Memory (ROM) : One major type of memory that is

used in PCs is called read-only memory, ( ROM ). ROM is the

memory that stores the data permanently i.e. the instructions in ROM

are permanent whether the power is on or off. We have no way to

change them, unless we remove the ROM chips from the main board

and replace them with another set.

Read-only memory is most commonly used to store system-

level programs that we want to be made available to the PC at all

times. For example, the ROM-BIOS (ROM basic input and output

services) programs are stored in ROM chips which are used to boot

up (start up) the computer.

The following are the different types of ROMs with a description

of their relative modifiability :

Programmable ROM (PROM) : This is a type of ROM that can

be programmed using special equipment; it can be written to, but

only once.

Erasable Programmable ROM (EPROM) :  EPROM is a ROM

that can be erased and reprogrammed. Ultraviolet light of a specific

frequency is used for erasing  the EPROM and for allowing it to be

reprogrammed again.

Electrically Erasable Programmable ROM (EEPROM) : The

next level of erasability is the EEPROM, which can be erased under
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software control. This is the most flexible type of ROM, and is now

commonly used for holding BIOS programs.

2.5.2 Secondary Memory

Secondary memory  or storage provides the facility of storing

information and programs permanently . It differs from primary

storage in that it is not directly accessible by the CPU. The computer

usually uses its input/output channels to access secondary storage

and transfers the desired data using intermediate area in primary

storage. Secondary storage does not lose the data when the device

is powered down; it is non-volatile. It is also typically  an order of

magnitude  less expensive than primary storage. Consequently,

modern computer systems typically have an order of magnitude

more secondary storage than primary storage and the data is kept

for a longer time there. The following figure shows the commonly

used secondary storage devices and their classification.

Fig. 2.5 : Secondary storage devices and their classification

In modern computers, hard disks are usually used as secondary

storage. The time taken to access a given byte of information stored

on a hard disk is typically a few thousandths of a second, or
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milliseconds. By contrast, the time taken to access a given byte of

information stored in random access memory is measured in

thousand-millionths of a second, or nanoseconds.  Some other

examples of secondary storage technologies are: Flash Memory (

e.g. USB sticks or keys), Floppy Disks, Magnetic tape, Paper

tape, Punch Cards, standalone RAM disks, and Zip drives.

CHECK YOUR PRPOGRESS

Q.1. State True or False:

i) The secondary memory is slower than the main memory

but has a large capacity.

ii) In random access memory any memory location can be

accessed independently.

iii) Cache memory increases load on main memory.

iv) Flash memory is one kind of ROM.

v) High speed memories are needed to bridge the gap of

speed between I/O device and memory.

vi) Registers are the fastest memory element in computer

system.

vii) Main memory of a computer system cannot store very

large data.

Q.2. Which memory is known as the main memory of the

computer system ?

............................................................................................

............................................................................................

Q.3. What are the differences in :

a) Volatile versus Non-volatile memory

......................................................................................

......................................................................................

......................................................................................
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b) Static RAM versus dynamic RAM

......................................................................................

......................................................................................

......................................................................................

......................................................................................

Q.4. What is the similarity between ROM and PROM?

............................................................................................

............................................................................................

2.6 INPUT DEVICES

We have already mentioned about the input unit of a computer

system whose main function is to provide information into the computer

system for execution. Programs and data must be entered into the computer

memory for processing through the input devices, and the results obtained

from the execution by the CPU must be displayed or recorded for the user's.

The most commonly used input devices can be classified into the following

categories :

 Keyboard devices

 Point and draw devices (mouse, track ball, joystick, light pen,

touch screen)

 Scanning devices (optical mark recognition, magnetic ink ch

aracter recognition, optical bar code reader, digitizer, electronic

card reader)

 Voice recognition devices

 Vision-input devices (Webcam, video camera etc)

2.6.1 Keyboard

It is the main input device used in most of the computer systems.

It has letter and number (alphanumeric) keys, and some function

keys, computer specific task keys, that allow  the user to use an

English-like language to issue instructions to an electronic

environment. It uses a cursor to keep your place on the screen and
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to let you know where to begin typing. You are able to input

commands, type data into documents, compose documents, draw

pictures with use of certain keys, pull down menus, and respond to

prompts issued by the computer. The keyboard contains special

function keys labelled F1, F2, ......., F12 to manipulate the user

interface. When a key is touched, an electrical impulse is sent

through the device which is picked up by the operating system

software, and sent through the computer to be processed.

The keyboard operates as a typical typewriter and uses a

standard “QWERTY” keyboard. QWERTY is the way the keyboard

is set up for typing. If you look at the keyboard under the top number

row, you will see that the alphabet top row begins with QWERTY.

Some special purpose keyboards are also found which are used

for specific applications. A very typical example of such kind of

keyboards can be seen at the Automatic Teller Machines or the ATMs

where the keyboard is required for limited functionality by the

customers.

2.6.2 Mouse

The mouse is a hand held pointing device that lets you point to

and select items on your screen. In a PC mouse there are mostly 2-

3 buttons and on a Mac there is one. A ball under the mouse senses

movement. The mouse is included in almost every computer that is

sold today. Besides becoming an important input tool, it has provided

access to the computer for many individuals with disabilities that

might not otherwise have the opportunity to use the computer.

Variants of a Mouse :

Touchpad : A touchpad is a touch sensitive input device which

takes user input to control the onscreen pointer and perform other

functions similar to that of a mouse. Instead of having an external

peripheral device such as a mouse, the touchpad enables the user

to interact with the device through the use of one or multiple fingers
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being dragged across the relative positions on a sensitive pad. These

touch pads are mostly found in Notebook and Laptops.Touchpads

are pressure and touch sensitive.

Fig. 2.6 : Touchpad of a Laptop

2.6.3 Hand-held Devices

Trackball : The trackball is an upside-down mouse that remains

stationary on your desk. It is the same principle as the mouse except

that the rollers are reversed and the ball is on top. This ball does not

need as much attention as the normal mouse because the only

thing that touches it is your hand as the normal mouse touches a

surface.

Joystick : The Joystick is a vertical stick that moves the graphic

cursor in the direction the stick is moved. It consists of a spherical

ball, which moves within a socket, and has a stick mounted on it.The

user can move the ball with the help of the stick in any direction.

Video games, training simulators and control panel of robots are

some common uses of a joystick.

Fig. 2.7 : Trackball Fig. 2.8 : Joystick
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Light pen : The light pen is a pen shaped tool that allows the

user to touch the computer screen with a lighted pen to activate

commands and make selections. Light pens are typically used in

CAD (Computer Aided Design) applications to directly draw on

screen.

Touch Screen : A touch screen is probably one of the simplest

and most intuitive of all input devices. It uses optical sensors in, or

near, the computer screen that can detect the touch of a finger on

the screen.

2.6.4 Optical Input Devices

Scanner : Scanning devices are input devices used for direct

data entry from the source document into the computer system.

Scanners capture and store information in a graphical format, and

then display it on the graphical screen. A scanner consists of two

parts, one that illuminates the page for capturing the optical image,

and the other  that converts and stores the graphical image in a

digital format. Once this is done, the computer can then see and

directly process this scanned graphical image. A scanner’s

sophistication is the ability to translate an unlimited number of analog

voltage levels to digital values. The scanner takes the information it

sees on a page and converts into code that the computer can use.

A picture once scanned can be edited, printed, or used in an

application. Capturing information by using  scanners reduces the

possibility of human error typically seen during large data entry.

Optical Mark Recognizer (OMR) : Optical mark recognization

devices sense the marks on computer readable paper. They are

usually used by academic institutions for grading aptitude tests where

the correct option is marked from multiple options given on special

kinds of answer sheets. The OMR device directly reads this paper,

and the computer can then use it for further processing.
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Fig. 2.9 OMR Device

Magnetic Ink Character Recognition (MICR) : MICR is similar

to optical mark recognition and is used exclusively by the banking

industry. The banking industry makes use of MICR devices for directly

reading the account numbers written on cheques and for processing

them further as required. MICR characters are printed in special

typefaces with a magnetic ink or toner, usually containing iron oxide.

Optical Barcode Reader (OBR) : Data coded in the form of

small vertical lines forms the basis of barcoding. Alphanumerikc

data is represented using adjacent vertical lines called barcodes.

These are of varying width and the spacing between them is used to

uniquely identify books, merchandise in stores, postal packages etc.

A barcode reader uses laser beam technology. The laser beam is

moved across the patterns of bars in a barcode. These bars reflect

the beams in different ways. The reflected beam is then sensed by

a light-sensitive detector, which then converts the light patterns into

electrical pulses, thereby transmitting them to logic circuits for further

conversion to alphanumeric value.

Fig. 2.10 Barcode Reader

Digitizer : The digitizer is  another kind of input device used for

converting (digitizing) picture,maps and drawings into digital form

for storage in computers. These devices are commonly used in the
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area of Computer Aided Design (CAD) by architects and engineers

to design car, buildings, medical devices, robots and mechanical

devices.

Electronic Card Reader : Card readers are devices that allow

direct data input into a  computer system. The electronic-card reader

is connected to a computer system and reads the data encoded on

an electronic card and transfers it to the computer system for further

processing. Typical example of electronic cards are the plastic

coated cards provided by the banks to its customers for use in

Automatic Teller Machines or ATMs.

2.7 OUTPUT DEVICES

The outputs produced by a computer system can be in two forms :

hard copy and soft copy.

Hard copy : The output produced in a physical form is called hard

copy output. This type of output is permanent and a relatively stable form of

output. Paper is one of the most commonly used hard copy output media.

The most widely used hard copy output device is the printer.

Soft copy : The output that remains in electronic form, stored in

computer memory or on disk are called soft copy outputs. This kind output

is not permanent and is usually displayed on monitor or screen. It includes

both audio and visual forms of output.

A wide range of output devices are available today which are :

 Display device ( monitors, multimedia projectors, terminals)

 Plotters (flatbed, drum)

 Voice response system (voice response system, speech synthe-

sizer)

 Printers

2.7.1 Display Devices

The display device shows the processed output from a computer

system. The increasing demand for displaying the graphics and
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pictures for presenting information in a visual form has led to the

popularity of graphics display device. Display screen technology may

belong to one of the following categories :

a) Cathod Ray Tube(CRT) : The CRT is a vacuum tube containing

an electron gun (a source of electrons) and a fluorescent screen,

with internal or external means to accelerate and deflect the

electron beam.It is used for creating images in the form of light

emitted from the fluorescent screen. A CRT display can be either

of the following two types : Raster scan display and Vector

display.

b) Liquid Crystal Display(LCD) : The LCD technology is a thin,

flat electronic visual display that uses the light modulating

properties of liquid crystals. They are common in consumer

devices such as video players, gaming devices, clocks, watches,

calculators, and telephones. LCDs have displaced cathode ray

tube (CRT) displays in most applications. They are usually more

compact, less energy consuming, lightweight, portable, less

expensive, more reliable, and easier on the eyes.

Monitor : The monitor is the common output device mostly used.

It can be thought of as a high resolution TV set. The monitor displays

text and images (pictures) converted to output from the video adapter.

The video adapter is an expansion card that plugs into the

motherboard. The adapter changes the instructions from the central

processing unit (CPU) into a way that the monitor can understand it.

Most computer monitors are based on Cathode Ray Tube (CRT)

technology. The basic operation of these tubes is similar to that in

television sets. With the widespread use of smaller computers like

PDAs and laptops now-a-days, a new type of display screen Liquid

Crystal Display (LCD) has been used.

2.7.2 Printers

It is a widely used hard copy output device. A printer prints
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information and data from the computer onto a paper. Some printers

can produce only textual information but some others can produce

graphics also.

Printers can be classified into categories based on : printing

technology, printing speed, printing quality.

Printing technology : Printers can be divided into two types -

(i)impact printers and (ii)non impact printers.

(I)Impact printers : The printers that work by physically striking a

head or needle against an ink ribbon to make mark. Impact printers

are divided into Dot matrix printers , Daisy-Wheel  printers and Drum

printers.

Dot Matrix Printer : This printer is the cheapest but loudest of

all  the printers. This printer prints one character at a time. The printer

uses a fine stripe of carbon and depending on what pin it is, will

determine the quality of the printing. The pin sizes range from 9-24.

The print head hits the ink ribbon with one of its many pins causing

it to form a letter number or character.

Fig. 2.11 : A Dot-Matrix Printer

With the pins hitting the ribbon this printer becomes quite loud.

The ppm (page per minute )ranges from 1 to 3 but with new changes

in the technology it is being more and more used in offices today

and it can also print 3 - 6 ppm ;besides it is much quitter. The

drawback in most dot matrix printers is the on-roll paper which has

a track which feeds it through the printer. Also, in most new dot matrix

printers there is a paper feed which allows most forms of paper.

Daisy Wheel Printer : Daisy-wheel printers operate in much
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the same fashion as a typewriter. A hammer strikes a wheel with

petals (the daisy wheel), each petal containing a letter form at its tip.

The letter form strikes a ribbon of ink, depositing the ink on the page

and thus printing a character. By rotating the daisy wheel, different

characters are selected for printing.You can change the daisy wheel

to print different fonts. This printer is also called the letter quality printer.

Drum printer : Drum printer is one of the most commonly used

line printers.

Fig. 2.12 : Printing Mechanism of a Drum Printer

In a typical drum printer design, a fixed font character set is engraved onto

the periphery of a number of print wheels, the number matching the

number of columns (letters in a line) the printer could print. The

wheels, joined to form a large drum (cylinder), spin at high speed

and the paper and an inked ribbon are stepped (moved) past the

print position. As the desired character for each column passes the

print position, a hammer strikes the paper from the rear and presses

the paper against the ribbon and the drum, causing the desired

character to be recorded on the continuous paper. Because the drum

carrying the letterforms (characters) remains in constant motion,
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the strike-and-retreat action of the hammers has to be very fast.

Typically, they are driven by voice coils mounted on the moving part

of the hammer.

(ii)Non impact printers : The printers that work by not physically striking a

head or needle against an ink ribbon to make a mark. Inkjet, Laser

and thermal printers fall under this category of printers.

The non impact printers commonly used are :

Inkjet Printer : This printer is set at the standard for home use.

It is a non impact printer and it does not touch the paper while printing.

Instead, the print head sprays ink onto paper forming an image or

text

For business letters a ink jest printer is the most common one

used for its high quality printing. The common speed on an ink jet

printer is  about 3 ppm and 300 dpi (dots per inch).

Laser Printer : Among the different types of printers, laser

printers remain the fastest, and the most efficient way to reproduce

text and images, offering high resolution and quick speeds at a

relatively low cost. A laser printer uses an electrostatic process similar

to a photocopier. The laser charges the areas of a photosensitive

image drum. Toner particles are then attracted to these areas of the

drum. By rolling this drum against a piece of paper, the printer creates

an image on a page.In the final stage, heat is used to fuse the toner

to the paper.

Fig. 2.13 : Inkjet printer and Laser Printer

Plotter : A plotter is a hard copy output device which is used to

draw high-resolution charts, graphs, maps, and other line based

Basic Components of Computer Unit 2



Computer Fundamentals and PC Software42

diagrams. It is a pen based output device , attached to a computer

for making vector graphics ,that is, images created by a series of

many straight lines. A plotter is a very slow and expensive output

device. It is mainly used for Computer Aided Design(CAD) and

Computer Aided Manufacturing applications. Plotters are classified

as Drum plotters and Flatbed plotters.

Fig. 2.14 : Plotter

Audio Output : Voice response systems enable the computer

to talk to its users. It consists of an audio-response device that

produces the audio output. Voice response systems are of two types

: voice reproduction system and speech synthesiser.

Voice reproduction system produce an audio output by selecting

the appropriate response from a predefined set of responses. These

responses may be in the form of speech (words or phrases spoken

by human beings), musical sounds, alarms, or other sounds. Text is

converted into spoken words by speech access systems.

CHECK YOUR PROGRESS

Q.5. State true or false

a) One of the most common input device is keyboard.
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b) Plotters are devices used for outputting  pictures,

drawings.

c) Digitizers are used as output devices.

d) In case where graphical user interfaces are common

mouse should not be used.

e) Speech recognition devices are input devices.

Q.6. Answer the followings :

a) What are electronic card readers?

b) Compare and contrast the Laser and Dot Matrix Printers.

c) What is an OMR device?

d) On what basis are the printers classified?

2.8 COMPUTER BUS

Bus is an electrical pathway through which the processor

communicates with the internal and external devices that are assembled

with the computer. It is resposible to carry memory address as well as data

to the control location in memory. Computer system contains a number of

different buses that provide pathways between components at various levels

of the computer system hierarchy. The name of the bus is determined by

the type of the signals it carries and the operations it performs.  A  bus that

connects major computer components (CPU, memory, I/O) is called a

system bus.

The interaction between the CPU and memory and CPU and I/O

takes place very frequently. To enable this interaction, some type of

connectivity is needed between the  units of a computer system. This

connectivity channel is known as bus. A key characteristic of a bus is that it

is a shared transmission medium. Physically, a bus is set of wires, which

carries a group of bits in parallel and has an associated control scheme.

The bus width is defined as the number of parallel lines in the bus. Every

computer has three types of buses for interconnecting the CPU and memory

and CPU and I/O. The functions performed by bus are as follows :

 Bus transfers data between the computer subsystem. It sends
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instructions and commands to and from the processors.

 It connects all internal computer components to the main memory

and the CPU.

 It logically connects various peripheral devices which can easily

communicate with the CPU.

 It has the clock speed which is measured in MHz.

Fig. 2.15 A Typical Bus

Data Bus : The data bus is used to transfer data between the CPU

and memory and CPU and I/O. The one that you hear most about is the

data bus. The bus width of the data bus is an important parameter that

affects the overall speed of a computer system. This is because each wire

of a bus can transfer one bit at a time. Hence, a 8-bit bus can move 8 bits

data time, a 16 bit bus can transfer two bytes, and 32 bit bus can transfer

four bytes at a time. This is similar to a multi-lane highway. The wider the

highway, the more traffic can flow simultaneously. Similarly the wider the

bus enables more bits of data to travel, simultaneously resulting in faster

exchange of data. The data bus is also referred to as a memory bus which

is often called  system bus

Address Bus : Every location in the memory has a unique address.

The address of a location does not change, but the data stored in it can

change. In order to retrieve some data from memory, it is necessary to

specify the address of the location where the data is stored. The address
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bus is used to carry the address of a memory location whenever data is to

be transferred to or from memory.

Again, a computer system normally has multiple I/O devices like

disk, tape, network etc simultaneously connected to it. Each I/O device has

a unique identifier associated to it. The address bus is used to carry the

address of the I/O device to be accessed by the CPU.

Control Bus : In addition to spending address and exchanging data

with the memory, the CPU also needs to send control signals to the memory

to specify whether the data is to be read from or written to the specified

address location. The control bus carries such signals, which are in the

form of READ/WRITE commands. A typical Bus structue is shown in the

following figure :

Fig. 2.16 The three types of Bus

ACTIVITY

 Find out the capacity and structure of the memory types used

in a computer system.

 Prepare a list of all old and new input and output devices

with illustrations.
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2.9 LET US SUM UP

 Data inside a computer is stored in the form of 0s and 1s. These 0

and 1s are called bit. 4 bit constitute a nibble and 8 b it constitute a

byte.

 The memory usually refers to a form of semiconductor storage i.e.

primary memory and storage refers to mass storag i.e. secondary

memory.

 Random access memories are the semiconductor memory. They

are volatile in nature. RAMs are of two types - dynamic RAM and

static RAM.

 ROMs are also the semiconductor memory. The instructions in ROMs

are permanent whether the power is on or off. PROM, EPROM,

EEPROM are the types of ROMs.

 Cache memory is a special type of RAM which is the faster memory

used in a computer system in between the CPU and main memory.

 Secondary memory also called secondary storage stores information

and programs permanently. In personal computer, secondary

memory typically consists of hard disk or any removable media, if

present, such as a CD or DVD etc.

 Magnetic tapes are the magnetic-coated plastic tapes, which are

used for storing data and audio or video files.

 Input device is an electromechanical device that accepts data or

information from the user in user readable form, and translates them

into computer readable form.

 An output device is an electromechanical device, which produces

the output of processing by the computer to the user. Computer

produces the output in a machine readable form, and the output

device converts it to a human readable form.

 Bus is an electrical pathway through which the processor

communicates with the internal and external devices that are

assembled with the computer. Basically ,the buses are of three types :
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data bus, address bus and control bus.

2.10 FURTHER READINGS

 Computer Fundamentals Architecture and Organization, B.

Ram, New Age International (P) Ltd.

 Introduction to Computer Science, ITL Education Solution Limied,

Pearson Education

 Digital Logic and Computer Design, M. M. Mano, PHI

 Computer Fundamentals, P K Sinha, BPB Publication

 DOEACC O & A Level Books.

2.11 ANSWERS TO CHECK YOUR PROGRESS

Ans. to Q. No. 1 : i) True, ii) True, iii) False, iv) True, v)True,

vi)True,

vii) True

Ans. to Q. No. 2 : Random Access Memory is known as the main memory

of the computer system.

Ans. to Q. No. 3 :

a) Volatile Memory Non-volatile memory

i) Power is required all the time i) Power is not required

once data is stored

ii) Temporary storage ii) Permanent storage

iii) Normally faster than iii) Slower than volatile

non-volatile types memories.

b) Static memory Dynamic memory

i) Loses its signal i) Doesnot lose signal strength

ii) Periodic refreshing of

memory is needed ii) No refreshing

iii) Expensive iii) Cheap

iv) Used as Cache iv) Used as main memory
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Ans. to Q. No. 4 : The similarity in ROM and PROM is that both write

operations which can be performed only once and

whatever has been written cannot be changed.

Ans. to Q. No. 5 : a) True, b) True, c) False, d) False, e) True

Ans. to Q. No. 6 : a) Card readers are devices that allow direct data

input into a  computer system. The electronic-card

reader is connected to a computer system and

reads the data encoded on an electronic card and

transfers it to the computer system for further

processing.

b) Laser Printer Dot Matrix Printer

i) High cost i) Low cost

ii) Forms character using ii) Use Dot Matrix to print

laser beam character

iii) Non-impact printer iii) Impact printer

iiv) High quality output iv) Output is of low quality

v) Noiseless operation v) Noisy

vi) Cannot produce multiple vi) Can produce multiple copies

copies of a single print in a single print with the help

of carbon paper.

c) An input device (a scanner) is capable of

recognizing a pre-specified type of mark made by

pencil or pen. Any input data that is of a choice or

selection nature can be recorded for OMR input.

d) Printers can be classified into categories based on

: printing technology, printing speed, printing quality.

Printing technology : Printers can be divided into

two types - impact printers and non impact printers.
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2.12 MODEL QUESTIONS

 Q.1. Differentiate between a bit and a byte.

Q.2. What do you understand by computer memory ? List the two different

categories of memory.

Q.3. What is a RAM? What are its two types? Differentiate between them.

Q.4. What is a ROM? Why is it called so? List the differenet types of

ROMs and their key features.

Q.5. What is a cache memory? How is it different from a primary memory?

Q.6. Differentiate between

a) PROM and EPROM.

b) Static RAM and Dynamic RAM

Q.7. Why are input and output devices necessary for a computer system?

Q.8. What are pointing devices? Discuss some of the commonly used

pointing devices.

Q.9. Explain the different types of printers. Make a clear difference  among

them in terms of speed, cost, and method of operation.

Q.10. What is a bus? List out the main functions performed by  buses in a

computer system.

Q.11. Write short note :

a) RAM b) Light pen

c) MICR d) Scanner

e) Computer Bus
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UNIT 3 : INTRODUCTION TO OPERATING SYSTEM

UNIT STRUCTURE

3.1 Learning Objectives

3.2 Introduction

3.3 Definition of Operating System

3.4 Functions of Operating System

3.5 Types of Operating System

3.5.1 Single User Operating System

3.5.2 Multi User Operating System

3.5.3 Single Tasking Operating System

3.5.4 Multi Tasking Operating System

3.5.5 Multiprogramming Operating System

3.5.6 Real Time Operating System

3.5.7 Network Operating System

3.5.8 Distributed Operating System

3.6 Let Us Sum Up

3.7 Further Readings

3.8 Answers to Check Your Progress

3.9 Model Questions

3.1 LEARNING OBJECTIVES

After going through this unit, you will be able to  :

 learn about the basic definition of operating systems

 describe the different functions of operating systems

 distinguish the various types of operating systems

 distinguish between network operating system and distributed

operating systems.

3.2 INTRODUCTION

Operating systems have evolved through a number of phases during

the last half of a century or earlier. The earliest electronic computer developed
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in the mid-1940s had no operating system at all. At that time, the machines

were equiped with a console consisting of toggle switches and display lights.

There were no programming languages or translators for developing high-

level language programs and converting them to machine understandable

instruction. The scene was improved from 1960 onwards. A lot of new

techniques and technology were developed and finally the concept of

operating system came. Operating System is an important component of a

computer. The primary objective of an operating system is to make computer

system convenient to use and utilise computer hardware and various  resources

in an efficient manner. An operating system is a large set of software which

is also an interface between users and computer systems. It is a system

software. Operating system also manages resources of the computer

system, such as memory, processor, file system and input/output devices.

The introductory concepts and principles of operating system will

be the main issues for our discussion in this unit. Moreover, various types of

operating system will also be covered in this unit.

3.3 DEFINITON OF OPERATING SYSTEM

A Computer system is made up of hardware, operating system and

user interface. Computer software can be divided into system programs

which manage the operation of the computer itself and the application

programs, which solve problems for their users. Operating System is the

most fundamental of all the system programs (or System Software). The

operating system controls the entire computer's resources and provides

the base upon which the application programs can be written.

We can define operating system in different ways. Some of the

definitions are:  An operating system is program that makes the computing

power available to users by controlling the hardware. Another definition is

that operating system is a program that controls the execution of application

programs. It is a set of processes permanently or transitively resident within

the computer that makes the resources of the computer system available

to the user in a consistent, reliable, friendly way.
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Operating system can be divided into two parts: the Kernel and the

shell. The kernel is the essential centre of a computer operating system,

the core that provides basic services for all other parts of the operating

system. A synonym of kernel is nucleus. A kernel can be contrasted with a

shell, the outermost part of an operating system that interacts with user

commands. Kernel and shell are terms used more frequently in UNIX. Users

interact with operating system through Command Line Interfaces (CLIs) or

Graphical User Interfaces (GUIs). The operating system thus contributes

to the simplification of the human interaction with the computer hardware.

They are responsible for linking application programs with the hardware,

thus achieving an easy user access to the computers.

Fig. 3.1

3.4 FUNCTIONS OF OPERATING SYSTEM

There are various functions performed by an operating system. The

basic functions are :

Input/Output management

Memory management

Process management

File and directory management

Security management

Command interpretation
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Input/Output management : An operating system makes efficient

usage of input and output devices and controls them properly. The Input/

output management module of the operating system coordinates and

assigns different input and output devices, namely terminals, printers, disk

drives, tape drives ect. It controls all input and output devices, keeps track

of input and output requests, issues commands to these devices and takes

measures which would ensure that data is transmitted efficiently and

correctly to and from input and output devices.

Memory or storage management : Memory is an important

resource for a computer system. So memory allocation and deallocation

for programs and data is an another function  of an operating system.

Memory management module of an operating system takes care of allocation

and de-allocation of main memory to various procsses. It allocates the main

memory and secondary memory to the system programs, user programs

and data.

Process  management : Process can be defined as  a program in

execution. It is the job which is currently being executed by the processor

(CPU) . During its excution , a process would require certain system

resources, such as processor time, main memory, files, input and output

devices etc. UNIX operating system supports multiple processes

simultanously. The process management module of UNIX takes care of

creation and termination of processes, assigning required resources to

different processes currently running, scheduling processor’s time to different

processes etc.

Files and directory management : Files and directories are also

properly managed by an operating system. Data is stored in a computer

system as files. The file management module of the operating system would

manage files as well as directories held on various storage devices as well

as transfer of files from one storage device to another device. Thus ,file

management takes care of organization, storage, retrieval, naming, sharing

and protection of different files. It also allows files to be read and modified by

using text editors or some other file manipulation software packages.
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Security  management : It is also one of the most important function

of an operating system to protect its various resources from the outer world.

Security management module of the operating system which are executing

concurrently in the memory, in such a way that system can ensure data

security and integrity. That is, it protects data and program stored in the

computer system from destruction and unauthorised access. It keeps

different programs and data in such a way that they donot interfere with

each other. Moreover, it protects files from being accessed or modified by

unauthorised users.

Role of Operating System  :

 Must communicate with the PC’s hardware

 Works with the BIOS to provide access to devices such as hard

drives

 Communicates with device drivers

 Provides a user interface

Let us explain these in details :

To communicate with the PC’s hardware, the operating system starts

running immediately after the PC has finished its Power-On Self Test (POST),

when it takes control of the PC. The operating system works with the BIOS

to provide access to devices such as hard drives, floppy drives, keyboards,

mice, and basic video. If a user wants to access a file on a diskette in a

floppy drive, the operating system passes the request to the appropriate set

of BIOS instructions that tells the floppy controller to send the requested

information to RAM.

If the BIOS is unable to talk with the hardware, the operating system

talks to the hardware directly. For this capability, it needs some additional

programming. Device drivers provide the code necessary for the operating

system to communicate with specific hardware. Device drivers are written

specifically for a particular operating system, usually by the hardware

manufacturer.

In addition to communicating with hardware, the operating system

provides for some type of error handling and error notification. If a piece of

hardware is not functioning properly, the operating system tries to fix the
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problem or tries to communicate with the device a few more times. If it is

still unable to communicate with the device, it provides an error screen

notifying the user of the problem.

Providing a user interface is the second function of an operating

system. Basically, the operating system organizes applications so that the

users can easily access them, use them, and store application data. When

an application is opened, the operating system lets the application provide

the majority of the user interface. That is, the operating system disappears

or moves away from the center of the screen. The operating system still

has the responsibility of providing access to the hardware for whatever the

application needs. If the program cannot function properly, the operating

system again takes control, stops the application, and provides some sort

of error message.

3.5 TYPES OF OPERATING SYSTEM

Operating systems are categorised based on the types of computers

they control and the sort of applications they support. The types are:

Single User Operating System

Multi User Operating System

Single Tasking Operating System

Multi Tasking Operating System

Multiprogramming Operating System

Real Time Operating System

Network Operating System

Distributed Operating System

3.5.1 Single User Operating System

A computer system in which only one user can work at a time is

called a single user operating system. The familiar Intel processor

based Windows OS personal computer is an example of single user

system. Such a typical system will have a single keyboard, mouse

Introduction to OS Unit 3



Computer Fundamentals and PC Software56

and monitor as I/O devices for the user to interact with the system.

Users apply command through the keyboard and mouse and the

computer displays its responses (output) on the monitor.

3.5.2 Multi User Operating System

This type of operating system which is running on a computer

will manage the work of all different users, without letting them know

that they all are actually working on a single computer. A multi user

operating system allows a number to work together on a single

computer. Each user will be provided with a terminal and all such

terminals will be connected to the single computer. For example,

UNIX, Linux, Windows XP etc.

A multi user operating system allows many different users to

take advantage of the computer’s resources simultaneously. The

operating system must make sure that the requirements of the

various users are balanced, and that each of the programs they are

using has sufficient and separate resources so that a problem with

one user doesnot affect the entire community of users. Unix,

mainframe operating systems, such as MVS, are examples of multi

user operating systems.

3.5.3 Single Tasking Operating System

It  is one  type of operating system which can execute a single

job at a time.It is known as Single Tasking operating system. For

example, MS-DOS is a single tasking operating system because

one can open and run only one application at one time in MS-DOS.

When a single program is allowed to run at a time, the system is

grouped under a single-tasking system.

3.5.4 Multi Tasking Operating System

Multitasking is concerned with a single user executing more than

one program simultaneously or concurrently. Now a days most of
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the operating systems such as UNIX, LINUX, OS/2 etc. are multi

tasking operating system.

Multi tasking can be of two types namely, pre-emptive and co-

operative. In pre-emptive multitasking, the operating system slices

the CPU time and dedicates one slot to each of the programs. Unix

like operating systems such as Solaris and Linux support pre-emptive

multi tasking. Cooperative multi tasking is achieved by relying on

each process to give time to the other processes in a defined manner.

MS Windows prior to Windows 95 used to support cooperative

multitasking.

3.5.5 Multiprogramming Operating System

In multiprogramming technique of processing , the CPU runs

several programs at the same time. Multiprogramming is

implemented in such a way that it appears as if many programs are

being executed concurrently. Mltiprogramming keeps the CPU busy,

switching its attention from one program to another. For example,

while one program is waiting for some input or output operation,

another program can use the processor because of the high speed

of the processor.

Multiprogramming is the rapid switching of the CPU between

multiple processes in memory. It is done only when the currently

running process requests I/O, or terminates. It was commonly used

to keep the CPU busy while one or more processes are doing I/O. It

is now mostly superceded by multitasking, in which processes also

lose the CPU when their time quantum expires.

Multiprogramming makes efficient use of the CPU by overlapping

the demands for the CPU and its I/O devices from various users. It

attempts to increase CPU utilization by always having something

for the CPU to execute.

The prime reason for multiprogramming is to give the CPU

something to do while waiting for I/O to complete. If there is no DMA,
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the CPU is fully occupied doing I/O, so there is nothing to be gained

(at least in terms of CPU utilization) by multiprogramming. No matter

how much I/O a program does, the CPU will be 100% busy. This of

course assumes that the major delay is the wait while data is copied.

A CPU could do other work if the I/O were slow  for other reasons

(arriving on a serial line, for instance). I/O operations are exceedingly

slow (compared to instruction execution). A program containing even

a very small number of I/O operations, will spend most of its time

waiting for them. Hence, poor CPU usage when only one program

is present in memory.

3.5.6 Real Time Operating System

Real time operating systems work towards providing immediate

processing and also responding to user’s commands in a very short

period of time. This type of operating system is more commonly

used in chemical industries for process control and scientific

processing like airplane control and space vehicle control operations.

The success of a real time operating system does not depend only

on the correctness of the result but also on the timeliness of the

result. For example  HP-RT and VTWorks etc.  It is a multitasking

operating system that aims at executing real-time applications. Real-

time operating systems often use specialized scheduling algorithms

so that they can achieve adeterministic nature of behavior. The main

object of real time operating system is their quick and predictable

response to events. They either have an event-driven or a time-

sharing design.

An event-driven system switches between tasks based on their

priorities while time-sharing operating systems switch tasks based

on clock interrupts.

3.5.7 Network Operating System

Network Operating System (NOS) is an operating system

specifically designed to establish network connections for
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workstations, personal computers (PC) accross the world via Local

Area Network and internetworking. NOS provides support for

multiuser operating system as well as administrative, security and

network management functions. Some examples of network

operating system are Windows NT, Novell’s Netware ect.

A network operating systems has to acknowledge and respond

to requests from many workstations, managing network access,

resource allocation and sharing, data protection as well as error

control.

Features of Network OS :

All network ooperating system provide certain core functions

such as connection to other computers on the network. Some of the

significant features of NOS are as follows :

 It gives the features of basic (Operating System) such as

protocols, processors, hardware detection and multi processing.

 It suppors name and directory services.

 It provides file and print services over the network, back up and

replication services, web services.

 It facilitates internetworking such as routing, switching, wireless

set-up and WAN ports.

 It provides cluster and grid computing capabilities, fault tolerance

and high availability systems.

 It provides user management services such as logon, logoff,

remote access, auditing tools with Grapgical User Interface (GUI)

features and administration tools.

 It strictily provides security features such as authentication,

authorization, logon restrictions for users and access controls

etc.

3.5.8 Distributed Operating System

A distributed system  is composed of large a number of

computers connected by high-speed networks. The computers in
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the distributed system are independent, but they appear to the users

as a single system. A distributed operating system hides the existence

of multiple computers which are interconnected by a network from

the user. That is, the user remains unaware of the fact that many

computers are being used to process the data. These computers

may be located at many places around the globe.

Distributed Operating System provides single-system image to

its users. All these computers work in close coordination with each

other. Processes and systems resources are managed globally and

controlled from specific locations.

An operating system that manages a group of independent

computers and makes them appear to be a single computer is known

as a distributed operating system. The development of networked

computers that could be linked and communicate with each other,

gave rise to distributed computing. Distributed computations are

carried out on more than one machine. When computers in a group

work in cooperation, they make a distributed system.

Advantages :

i) Data sharing : Allows data sharing access to common databases.

ii) Device sharing : Allows many users to share expensive

peripherals like high resolution printers, scanners and digital

cameras.

iii) Communication : Makes communication between users easier.

iv) Spreads the availability workload over independent computers

of the system in cost-effective way.

Disadvantages :

i) Network communication is delayed due to saturation or other

problems.

ii) Security : Needs tools and techniques for providing controlled

access to sensitive data.
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CHECK YOUR PROGRESS

Q.1. Choose the correct option :

(i) An operating system is a software that

(a) helps the operators who are maintaining a computer

system.

(b) helps other programs to run.

(c) helps in resource management.

(d) all of the above.

(ii) UNIX is an example of

(a) batch processing operating system

(b) time sharing operating system.

(c) real time operating system.

(d) none of these.

(iii) The program which takes user input , interprets it and

takes necessary actions is

(a) kernel (b) system calls

(c) shell (d) scheduler.

(iv) The main job of one of the following is to allocate CPU to

process

(a) kernel (b) shell (c) sceduler (d) login

(v) The objective of a multiprogramming operating system

is to

(a) minimize the net execution time.

(b) maximize the processor utilization.

(c) minimize the user response time.

(d) none of above.

(vi) In UNIX, a process is a

(a) program in execution.

(b) sub-program which can be called from other

programs.
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(c) sequence of commands required to run a program.

(d) none of above.

(vii) MS-DOS operating system is a

(a) time sharing operating system

(b) single user operating system.

(c) distributed operating system

(d) all of the above.

(viii) The example of real time operating system is

(a) UNIX (b) MS-DOS

(c) WINDOWS 2000 (d) HP-RT

(ix) Example of embedded operating system is

(a) FreeBSD (b) Unix

(c) MS-DOS (d) Linux.

3.6 LET US SUM UP

An Operating System is an important component of a computer

system. The primary objecives of an operating system is to make computer

system convenient to use and utilise computer hardware and various

resources in an efficient manner. An operating system is a large set of

software which is also an interface between users and computer systems.

It is also a system software.

Input and Output management : An operating system makes

efficient usage of input and output devices and controls properly.

Memory or storage management : Memory is an important

resource for a computer system. So memory allocation and deallocation

for programs and data is an another function  of an operating system.

Process management : Process can be defined as  a program in

execution.It is the job which is currently being executed by the processor

(CPU).

Files and directories management : Files and directories are also

properly managed by an operating system.Data is stored in a computer

system as files.
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Scheduling : The operating system also establishes and enforces

process-priority. That is, it determines and maintains the order in which

jobs are to be executed by the computer system.

Security  management : It is also one of the most important function

of an operating system to protect its various resources from the outer world.

 Single user Operating System the simplest operating system which

allows only one user to work.

 Multi user operating system which is running on a computer will

manage the work of all different users.

 Multitasking operating system allows the user to perform more

than job at the same time on a computer.

 In multiprogramming technique of processing , the CPU runs

several programs at the same time.

 Real time operating system work towards providing immediate

processing and also responding to user’s commands in a very short

period of time.

 Network operating System (NOS) is an operating system

specifically designed to support interconnection of several

computers.

 A distributed operating System hides the existence of multiple

computers which are interconnected by a network from the user.

3.7 FURTHER READINGS

 Andrew S Tanenbaum, Albert S. Woodhull, “Operating Systems

Design and Implementation”, Prentice-Hall India publication.

 Deitel & Deitel, Choffnes, “Operating System”,  Pearson Education.

3.8 ANSWERS TO CHECK YOUR PROGRESS

Ans. to Q. No. 1 : (i) (d),  (ii) (b),  (iii) (c),  (iv) (c),  (v) (b),  (vi) (a),
(vii) (b),  (viii) (d), (ix) (a)
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3.9 MODEL QUESTIONS

Q.1. What is an operating system? Why is it necessary to use operating

system for a computer ?

Q.2. What is process? What are the main objectives of the process-

management module of the operating system?

Q.3. Differentiate between multiprigramming and multi-tasking operating

system.

Q.4. Describe the role of operating system in the computer system.

Q.5. What are different functions performed by an operating system?

Q.6. Describe different types of operating systems?

Q.7. What is virtual memory? Why is it so called? How is it used?

Q.8. What is network operating system? How is it different from the

distributive operating system?
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UNIT 4 : MS DOS OPERATING SYSTEM

UNIT STRUCTURE

4.1 Learning Objectives

4.2 Introduction

4.3 DOS Operating System

4.4 System Files of DOS

4.5 Concept of Booting

4.6 Files and Directory Structure

4.7 Concept of Paths

4.8 Internal and External Commands

4.9 Batch File

4.10 Let Us Sum up

4.11 Further Readings

4.12 Answers to Check your Progress

4.13 Model Questions

4.1 LEARNING OBJECTIVES

After going through this unit, you will be able to  :

 describe the DOS operating system

 identify the system files of DOS

 describe files and directory structure

 identify the internal and external commands

 identify the batch files.

4.2 INTRODUCTION

By now you are aware of the basic definition of an operating system

including its functions and various types. In this unit, we will introduce you to

the Microsoft Disk Operating System (MS DOS) which is a single user,

single tasking operating system. We will discuss about the system files of

DOS, files and directory structure and internal and external commands of

DOS.
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4.3 DOS OPERATING SYSTEM

Microsoft Disk Operating System (MS-DOS) is the most popular

single user operating system in the world. Microsoft Corporation of USA

had released it in August 1981. First version of MS-DOS was a refined version

of an operating system developed by Tim Peterson of Seattle Computers,

which he had named as QDOS (Quick and Dirty Operating System) as he

had developed it in record two months and could not introduce some good

functions of process management and memory management into it. After

the release of the first version of MS-DOS, every time some refinement is

made, a new version of it is launched. The latest version of MS-DOS available

in the market are 9.x.

4.4 SYSTEM FILES OF DOS

The modern DOS operating system is distributed on 3-5 high density

floppy disks. It comes with backup utilities and (depending on how the

lawyers feel) disk compression drivers. However, all the stuff that goes into

C:\DOS and its subdirectories are programs and utilities. The core DOS

operating system consists of six files:

 The boot sector is a 512 byte record placed at the beginning of

the C: drive when DOS was installed, or placed there

subsequently using the “sys c:” command.

 Two “hidden” files are stored in the root directory of the C: drive.

They do not show up in a DIR listing unless the /A switch is

used. On IBM PC DOS systems, they are IBMBIO.SYS and

IBMDOS .SYS. On MS DOS systems, they are called IO.SYS

and MSDOS.SYS. These files form the kernel of the DOS

system.

 COMMAND.COM is the “shell” or command interpreter. It prints

out the “C:\&gt “ prompt and reads user commands. It also

supports BAT files.

 The user configuration files are CONFIG.SYS and AUTOEXEC.

BAT. The reader is assumed to be familiar with these files.

MS DOS Operating SystemUnit 4
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COMMAND.COM is initially stored in the C:\ root directory. The

problem is that OS/2 and Windows NT have their own versions of

COMMAND.COM. To avoid confusion, each COMMAND.COM should be

stored in the subdirectory that belongs to its particular operating system. In

normal use, this means that the DOS version should be in C:\DOS. To

relocate it, two statements must be added to the user configuration files:

“SHELL=C:\DOS\COMMAND.COM” is added to CONFIG.SYS.

“SET COMSPEC=C:\DOS\COMMAND.COM” is added to

AUTOEXEC.BAT.

The hidden files IBMBIO, IBMDOS, IO, or MSDOS have names

that do not conflict with each other or with any system file belonging to any

other operating system. They can stay in the C:\ root directory no matter

what gets added to the system. This means that the volatile part of the

DOS system consists of the boot record, C:\CONFIG.SYS, and

C:\AUTOEXEC. BAT.

4.5 CONCEPT OF BOOTING

The term 'boot' is used to describe the intial loading of an operating

system or of some other program into a computer. The word “boot” comes

from the term “Bootstrap”. The loading of DOS into main memory involves

loading of three essential files of DOS i.e. IO.SYS, MSDOS.SYS and

COMMAND.COM into the main memory. Loading these files into main

memory is called booting up of the computer. The booting up process is a

step by step process as described below

a) As soon as the machine is switched on, POST (Power On Self

Test) is performed which checks for integrity of all the

components (CPU,RAM, I/O devices etc.) of a computer system.

If any component is found faulty, an error message is displayed.

b) A chip called ROM-BIOS (Read Only Memory-Basin Input-Output

Services) is read and executed. Then a check is performed for

DOS files presence in the following order

i) First in ‘A drive’; if found there, DOS is loaded from the drive  A.
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ii) If not found in drive A, then ‘C drive’ scanned for the DOS

files and if available there from the C drive DOS is loaded.

iii) If nowhere DOS file is located, an error message will come.

c) If  DOS files are found in a drive, its very first sector (called boot

sector) is read which stores a small program called bootstrap

loader in which instructions for booting up process are stored.

The bootstrap loader is then loaded into the main memory and

its instructions are executed and as a result DOS system files

IO.STS, MSDOS.SYS and COMMAND.COM will be loaded into

the main memory one by one.

Two files IO.SYS and MSDOS.SYS make the kernel of DOS which

actually interacts with the hardware and the gets the work done. The user

interacts with the shell of DOS which is COMMAND.COM. The shell in turn

interprets user request and interacts with the kernel for carrying out the

user request. Shell is resposible for user interface.

Fig. 4.1 : Hierarchy of Interaction with MS-DOS

4.6 FILES AND DIRECTORY STRUCTURE

Files : Any information which is to be stored on the computer’s

secondary storage, would be stored as a file. A file is a logically related

information, such as a file containing all details about mid-term exams, a

file containing monthly sales data etc. Each file stored on the system is
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given a name. The file name has two parts : primary file name and secondary

file name (also called extension). A primary file name consists of one to

eight (1-8) characters in length. File extension consists of a period followed

by zero to three (0-3) characters. Extensions are optional, but it is better to

us as they are useful for describing the contents of a file. The primary file

name and file extensions can have any characters other than following :

[ ] / \ : , ; < > + “ = ? |

Extension .exe specifies that it is an executable file, .doc specifies

that it is a document file, .bas specifies it is a BASIC program file, .pas

specifies that it is a PASCAL file.

Directories : In an office, the file cabinet is divided into shelves,

shelves into boxes, boxes into drawers etc. and files are kept in them. Similar

types of files are groupd and kept in the same drawer or box or shelf. In the

same way files on the disk are stored. The disk (similar to file cabinet) is

divided into sub-directories (similar to shelves); each sub-directory can

further be divided into sub-directory (similar to box) and so on. DOS files

with some similarity (e.g. belonging to the same project) are grouped together

and a directory is formed for them under which they are kept.

So, directories let you group your files in convenient categories.

These directories, in turn, may contain other directories (referred to as sub-

directories). This organised file structure  is referred to as multilevel or

hierarchical directory system.

The first level in a multilevel directory system is root directory, which

is created automatically at the time of the disk formatting. Within the root

directory, additional directories and sub-directories can be created. Within

each directory or sub-directory, new files or new sub-directories can be

created.

Immediately after the booting, root directory is the current directory

or working directory i.e. by default all operations will be performed under it

unless you specify another directory or files for it. Working directories can

be changed using CD or CHDIR command of DOS.
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Fig. 4.2

In the Fig. 4.2 D1, D2, D3 are sub-directories or child directories of

root directory and root is the parent directory of D1, D2, D3. D4 is the child

directory of D1 and D5 is the child directory of D2; D1 is the parent directory

of D4 and D2 is the parent directory of D5. One thing, to be kept in mind is

that, a directory can have many sub-directories (child), but a child directory

can have only one parent directory, it cannot have more than one parent

directory. Directory names follow the file naming rules.

4.7 CONCEPT OF PATHS

Full name of a file or directory consists of path primary name.

extension .Path is a sequence of directory names which give you the

hierarchy to access a particular directory or file name. Let us consider the

following directory structure :

Fig. 4.3

 Root 
Directory 

D1 D2 D3 F1 

F2 F3 D5 

D4 F4 

Project Sales Accounts 

PROJ1 CL.DAT PROJ2 Monthly yearly Cash Act  Bank Act History 

MAIN 
PRG 

JAN_SAL 

FEB_SAL 

1994 SAL 

1995 SAL 

CASH 
ACT  

BANK 
ACT  

THREE 
PAS 

TWO PAS ONE PAS 

Root  

A : 
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Now, the full name directories PROJECT, SALES and ACCOUNTS

will be

A: \PROJECT, A: \SALES and A:| ACCOUNTS respectively.

So format of path can be given as

Drive-letter: \directory[\directory.......]

Where first \ (backslash) refers to root directory and other (‘\’ s)

separate a directory name form the previous directory name. Now the  path

of directory JAN SAL will be :

A: \SALES\Monthly\JAN SAL

As to reach JAN SAL the sequence one has to follow is under drive

A, under root directory (first \), under SALES subdirectory of root, under

Monthly subdirectories of SALES, there lies JAN SAL directory.

Similarly the full name of ONE PAS file under PROJ2 subdirectory will

be :

A: \PROJECT\PROJ2\ONE PAS

Now, you can see that there are two files with the same name CASH

ACT, one under the Accounts directory and the other under HISTORY

directory but according to DOS rule no two files can have same names

(path names). Both these files have same names but their path names

differ, therefore, these can exist on system. So, the paths of the two files will

be

A: \Accounts\CASH ACT

and A: \Accounts\HISTORY\CASH ACT

Above mentioned path names are absolute path names as they

mention the paths from the top most level of the directory structure.

Relative pathnames mention the paths relative to current working

directory. Let us assume that the current working directory now is, say,

PROJ2. The symbol . and .. can be used now in relative paths and path

names. The symbol . can be used in place of current working directory and

.. denotes the parent directory.

So, with PROJ2 as current working directory, pathyname of TWO

PAS will be :

.\TWO PAS (PROJ2 being working directory)
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Which means under current working directory, there is file TWO

PAS. Similarly, path name for file CL DAT will be :

..\CL DAT (PROJ2 being working directory)

Which means under parent directory of current directory, there is a

file CL DAT. Similarly, path name for MAIN PRG will be :

..\PROJ1\MAIN PRG

that is under parent directory of current directory, there lies a file

MAIN PRG.

4.8 INTERNAL AND EXTERNAL COMMANDS

We have seen that, user interface is the shell’s responsibility.

Therefore, a user passes its request ( in the form of DOS command ) to the

shell i.e. COMMAND.COM. Whenever a request is passed to it, the shell

interprets it and then  searches for its specification i.e. what is to be done ?

and how it is to be done inside COMMAND.COM. These specification of

commands can either be found inside the shell or outside it, thus giving rise

to two types of DOS commands.

i) Internal Commands : DOS commands for which specifications

are available within the shell (i.e. COMMAND.COM) are called

Internal Commands (as they are internally available in shell).

ii) External Commands : DOS commands for which specifications

are not internally available within the shell (i.e. COMMAND.COM)

are called External Commands. The specification for these

commands are made available to the shell through external

specification files e.g. FORMAT is an external command and its

specifications are available in FORMAT.COM, for DISKCOPY

external command, specification file is DISKCOPY.COM and so

on. The specification files are executable files i.e. files with

extensions .EXE or .COM.

A) Internal Commands : The Internal commands include the

following some important commands :

File Commands – File commands are those commands which
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operate on files. Under file commands we will discuss the

following commands –

1. COPY : Allows the user to copy one or more files to an alternate

location.

Syntax :
Copies one or more files to another location.

COPY [/A | /B] source [/A | /B] [+ source [/A | /B] [+ ...]] [destination] [/A | /B]]

[/V] [/Y | /-Y]

source Specifies the file or files to be copied.

/A Indicates an ASCII text file.

/B Indicates a binary file.

destination Specifies the directory and/or filename for the new

file(s).

/V Verifies that new files are written correctly.

/Y Suppresses prompting to confirm you want to overwrite

an existing destination file.

/-Y Causes prompting to confirm you want to overwrite an

existing destination file.

The switch /Y may be preset in the COPYCMD environment variable.

This may be overridden with /-Y on the command line.

To append files, specify a single file for destination, but multiple files

for source (using wildcards or file1+file2+file3 format).

Examples :
copy *.* a:
Copy all files in the current directory to the floppy disk drive.

copy autoexec.bat c:\windows
Copy the autoexec.bat, usually found at root, and copy it into the

windows directory; the autoexec.bat can be substituted for any file(s).

copy win.ini c:\windows /y
Copy the win.ini file in the current directory to the windows directory.

Because this file already exists in the windows directory it normally

would prompt if you wish to overwrite the file. However, with the /y

switch you will not receive any prompt.
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copy myfile1.txt+myfile2.txt
Copy the contents in myfile2.txt and combines it with the contents in

myfile1.txt.

copy con test.txt

Finally, a user can create a file using the copy con command as

shown above, which creates the test.txt file. Once the above

command has been typed in, a user could type in whatever he or

she wishes. When you have completed creating the file, you can

save and exit the file by pressing CTRL+Z, which would create ^Z,

and then press enter. An easier way to view and edit files in MS-

DOS would be to use the.

2. DEL : Del is a command used to delete files from the computer.

Syntax :

Windows 2000 and Windows XP syntax

Deletes one or more files.

DEL [/P] [/F] [/S] [/Q] [/A[[:]attributes]] names

ERASE [/P] [/F] [/S] [/Q] [/A[[:]attributes]] names

names- Specifies a list of one or more files or directories.

Wildcards may be used to delete multiple files. If a

directory is specified, all files within the directory will be

deleted.

/P Prompts for confirmation before deleting each file.

/F Force deleting of read-only files.

/S Delete specified files from all subdirectories.

/Q Quiet mode, do not ask if ok to delete on global wildcard

/A Selects files to delete based on attributes

attributes R - Read-only files, S - System files, H - Hidden files,

A - Files ready for archiving

Windows 2000 and Windows XP recovery console syntax

Deletes one file.

del [drive:][path]filename

delete [drive:][path]filename

[drive:][path]filenameSpecifies the file to delete.

MS DOS Operating SystemUnit 4



Computer Fundamentals and PC Software 75

Delete only operates within the system directories of the current

Windows installation, removable media, the root directory of any hard disk

partition, or the local installation sources.

Del and delete do not support replaceable parameters (wild cards).

del test.tmp = Deletes the test.tmp in the directory that you

currently are in, if the file exists.

del c:\windows\test.tmp = Delete the c:\windows\test.tmp in the

windows directory if it exists.

del c:\windows\temp\*.* = (* is for wild character(s)) *.* indicates

that you would like to delete all files in

the c:\windows\ temp directory.

In the previous directory structure, to delete all the files having the

.PAS extension under PROJ2, the command will be :

Del A:\PROJECT\PROJ2\*.PAS/P

This command will be carried out by displaying all PAS file names

for confirmation i.e.

ONE.PAS Delete (Y/N) ? Y

TWO.PAS Delete (Y/N) ? Y

THREE.PAS Delete (Y/N) ? N

3. REN (RENAME) : Used to rename files and directories from the

original name to a new name.

In earlier releases of MS-DOS instead of using ren or rename you

need to use the move command to rename your MS-DOS directories or files.

Syntax :
Renames a file/directory or files/directories.

RENAME [drive:][path][directoryname1 | filename1] [directoryname2

| filename2]

REN [drive:][path][directoryname1 | filename1] [directoryname2 |

filename2]

Note that you cannot specify a new drive or path for your destination.

rename c:\chope hope
Rename the directory chope to hope.

rename *.txt *.bak
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Rename all text files to files with .bak extension.

In our example to rename file CL DAT as CLASS DAT under

PROJECT, the command will be

REN A:\PROJECT\CL DAT CLASS DAT

4. TYPE : Allows the user to see the contents of a file.

To edit the files, the user would need to use either edit or copy con.

Syntax :
Displays the contents of text files.

TYPE [drive:][path]filename

Examples :
type c:\autoexec.bat
This would allow you to look at the autoexec.bat

In our example, to display the content of the file 1995 sal under

yearly subdirectory, the command will be as follows :

TYPE A:\SALARY\YEARLY\1995 SAL

Directory Commands : In this section four internal commands of

DOS will be discussed.

5. DIR : The dir command allows you to see the available files in

the current and/or parent directories.

Microsoft Windows 2000 and Windows XP syntax
Displays a list of files and subdirectories in a directory.

DIR [drive:][path][filename] [/A[[:]attributes]] [/B] [/C] [/D] [/L] [/N]

[/O[[: ]sortorder]]  [/P] [/Q] [ /S] [/

T[[:]timefield]]

[/W] [/X] [/4]

[drive:][path][filename] - Specifies drive, directory, and/or files to

list.

/attributes D Directories

R Read-only files

H Hidden files

A Files ready for archiving

S System files

- Prefix meaning not
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/B Uses bare format (no heading infor-

mation or summary).

/C Display the thousand separator in file

sizes. This is the default. Use /-C to

disable display of separator.

/D Same as wide but files are list sorted

by column.

/L Uses lowercase.

/N New long list format where filenames

are on the far right.

/O List by files in sorted order.

sortorder N  By name (alphabetic)

S  By size (smallest first)

E  By extension (alphabetic)

D  By date/time (oldest first)

G  Group directories first

-  Prefix to reverse order

/P Pauses after each screenful of

information.

/Q Display the owner of the file.

/S Displays files in specified directory and

all subdirectories.

/T Controls which time field displayed or

used for sorting

timefield C Creation

A Last Access

W Last Written

/W Uses wide list format.

/X This displays the short names

generated for non-8dot3 file names.

The format is that of /N with the short

name inserted before the long name. If

no short name is present, blanks are
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displayed in its place.

/4 Displays four-digit years

dir

Lists all files and directories in the directory that you are currently in.

dir /ad

List only the directories in the current directory. If you need to move

into one of the directories listed use the cd command.

dir /s

Lists the files in the directory that you are in and all sub directories

after that directory, if you are at root “C:\>” and type this command

this will list to you every file and directory on the C: drive of the

computer.

dir /p

If the directory has a lot of files and you cannot read all the files as

they scroll by, you can use this command and it will display all files

one page at a time.

dir /w

If you don’t need the info on the date / time and other information on

the files, you can use this command to list just the files and directories

going horizontally, taking as little as space needed.

dir /s /w /p

This would list all the files and directories in the current directory

and the sub directories after that, in wide format and one page at a

time.

dir /on

List the files in alphabetical order by the names of the files.

dir /o-n

List the files in reverse alphabetical order by the names of the files.

dir \ /s |find “i” |more

A nice command to list all directories on the hard drive, one screen

page at a time, and see the number of files in each directory and the

amount of space each occupies.

dir > myfile.txt
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Takes the output of dir and re-routes it to the file myfile.txt instead of

outputting it to the screen.

6. CHDIR/CD : CD (Change Directory) is a command used to switch

directories in MS-DOS. For example, if you needed to run

Windows 3.11 from DOS, you would type:

cd windows - Changing the directory to Windows;

win - To run the win.com file within the windows directory.

Syntax :

CHDIR [drive:][path]

CHDIR[..]

CD [drive:][path]

CD[..]

Examples :

cd\

Goes to the highest level, the root of the drive.

cd..

Goes back one directory. For example, if you are within the

C:\Windows\ COMMAND> directory, this would take you to

C:\Windows>

Windows 95, 98, and later versions have a feature in the CD

command that allows you to go back more than one directory when

using the dots. For example, typing: cd... with three dots after the

cd would take you back two directories.

cd windows

If present, would take you into the Windows directory. Windows can

be substituted with any other name.

cd \windows

If present, would first move back to the root of the drive and then go

into the Windows directory.

cd windows\system32

If present, would move into the system32 directory located in the

Windows directory. If at any time you need to see what directories

are available in the directory you’re currently in use the dir command.
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7. MKDIR (MD) : Allows you to create your own directories in MS-

DOS.

Syntax :

Creates a directory.

MKDIR [drive:]path

MD [drive:]path

Examples :

md test

The above example creates the “test” directory in the directory you

are currently in.

md c:\test

Create the “test” directory in the c:\ directory.

8. RMDIR (RD) : Removes empty directories in MS-DOS. To delete

directories with files or directories within them the user must

use the deltree command, or if you are running Microsoft

Windows 2000 or Windows XP use the /S option.

Syntax :

Removes (deletes) a directory.

RMDIR [drive:]path

RD [drive:]path

Windows 2000 and Windows XP Syntax.

RMDIR [/S] [/Q] [drive:]path

RD [/S] [/Q] [drive:]path

S Removes all directories and files in the specified directory in

addition to the directory itself. Used to remove a directory tree.

/Q Quiet mode, do not ask if ok to remove a directory tree with /S.

Examples :

rmdir c:\test

Remove the test directory, if empty. If you want to delete directories

that are full, use the deltree command or if you’re using Windows

2000 or later use the below example.

rmdir c:\test /s

Windows 2000, Windows XP and later versions of Windows can
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use this option with a prompt to permanently delete the test directory

and all subdirectories and files. Adding the /q switch would suppress

the prompt.

Miscellaneous Commands :

In this section, we will discuss some different commands of MSDOS

i) Break : Break can be used to enable or disable the breaking

capability of the computer. For example, if a user wanted to

cancel a batch file or another MS-DOS processes, that user

could simply press CTRL + C (break), which would then prompt

the user if they wish to cancel the current process.

Turning break off will cancel CTRL + C; however, the user will still

be able to press CTRL + PAUSE/BREAK and have the capability of getting

out of a batch file / current running process.

Note : Newer versions of Windows (Windows ME, Windows 2000,

Windows XP, and higher) only include this command for backwards

compatibility and turning the break off has no effect.

Syntax :
Sets or clears extended CTRL+C checking.

BREAK [ON | OFF]

Type BREAK without a parameter to display the current BREAK

setting.

Examples :
break on
Turns on the break, which allows the Ctrl + C function.

break off
Turns off the break, not allowing Ctrl + C to cancel a process.

ii) CLS : Cls is a command that allows a user to clear the complete

contents of the screen and leave only a prompt.

Syntax :
CLS

Examples :
cls
Running the cls command at the command prompt would clear your
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screen of all previous text and only return the prompt.

iii) DATE : Displays or sets the date.

Syntax :
DATE [date]

Type DATE without parameters to display the current date setting

and a prompt for a new one. Press ENTER to keep the same date.

Examples :

date

Display the current date and prompt for a new one. If no date is

entered, the current date will be kept.

iv) PATH : Path is used to specify the location where MS-DOS looks

when using a command. For example, when using the command

“format”, if the path is not specified to where the command is

you will receive bad command or file name.

Syntax :

Displays or sets a search path for executable files.

PATH [[drive:]path[;...]]

Type PATH ; to clear all search-path settings and direct Windows to

search only in the current directory.

Type PATH without parameters to display the current path.

Examples :

path=c:\windows\command

This is where a lot of DOS commands are stored in Window 95; if

you are not able to do a dos command, type this command in,

allowing all commands you type in, such as “deltree”, to be loaded

from this directory. However, if you have another file in another

directory such as C:\DOS it will no longer look there.

v) TIME : Allows the user to view and edit the computer’s time.

Syntax :

Displays or sets the system time.

TIME [time]

Type TIME with no parameters to display the current time setting

and a prompt for a new one. Press ENTER to keep the same time.
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Examples :

time 12:00

Set the time to 12:00

vi) VER : Displays the version of MS-DOS or if running Windows

95 or above the version of Windows. Information about Windows

versions can be found on our Windows version page.

Syntax :

Displays the MS-DOS version.

VER

Examples :

ver

Display what version of MS-DOS or Windows command prompt

you’re using. Below is an example of what this may look like.

Microsoft Windows XP [Version 5.1.2600]

vii) VOL : Displays the volume information about the designated

drive.

Syntax :

Displays the disk volume label and serial number, if they exist.

VOL [drive:]

Examples :

vol c :

Display the volume of drive c: as shown in the below example.

Volume in drive C has no label.

Volume Serial Number is 1C24-AB20

B) External Commands : It has already been mentioned that

external commands are those, for which specifications are not

available within COMMAND.COM. Some important external

commands are discuss in this section.

1. COMP : A simple compare that compares two or more files.

Syntax :

Compares the contents of two files or sets of files.

COMP [data1] [data2] [/D] [/A] [/L] [/N=number] [/C]
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data1 Specifies location and name(s) of first file(s) to

compare.

data2 Specifies location and name(s) of second files to

compare.

/D Displays differences in decimal format.

/A Displays differences in ASCII characters.

/L Displays line numbers for differences.

/N=number Compares only the first specified number of lines in

each file.

/C Disregards case of ASCII letters when comparing files.

To compare sets of files, use wildcards in data1 and data2

parameters.

Examples :

Note : Unless the /N option is used the comp command will only

compare the size of the file.

comp file1.txt file2.txt /N=10 /A

Compares file1.txt with file2.txt. In this example we are using the /A

option to display the ASCII characters that the compare has found

different. If the /A option is not displayed, the comp command will

display the differences in hexadecimal notation.

2. FORMAT : Format is used to erase all of the information off of

a computer diskette or fixed drive.

Syntax :

Microsoft Windows 2000 and Windows XP syntax

Formats a disk for use with Windows 2000.

FORMAT volume [/FS:file-system] [/V:label] [/Q] [/A:size] [/C] [/X]

FORMAT volume [/V:label] [/Q] [/F:size]

FORMAT volume [/V:label] [/Q] [/T:tracks /N:sectors]

FORMAT volume [/V:label] [/Q] [/1] [/4]

FORMAT volume [/Q] [/1] [/4] [/8]

volume Specifies the drive letter (followed by a colon),

mount point, or volume name.
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/FS:filesystem Specifies the type of the file system (FAT, FAT32,

or NTFS).

/V:label Specifies the volume label.

/Q Performs a quick format.

/C Files created on the new volume will be compressed

by default.

/X Forces the volume to dismount first if necessary.

All opened handles to the volume would no longer

be valid.

/A:size Overrides the default allocation unit size. Default

settings are strongly recommended for general use.

NTFS supports 512, 1024, 2048, 4096, 8192, 16K,

32K, 64K.

FAT supports 512, 1024, 2048, 4096, 8192, 16K,

32K, 64K, (128K, 256K for sector size > 512 bytes).

FAT32 supports 512, 1024, 2048, 4096, 8192, 16K,

32K, 64K, (128K, 256K for sector size > 512 bytes).

Note that the FAT and FAT32 files systems impose

the below restrictions on the number of clusters on

a volume:

FAT: Number of clusters <= 65526 FAT32: 65526

< Number of clusters < 268435446

Format will immediately stop processing if it decides

that the above requirements cannot be met using

the specified cluster size.

NTFS compression is not supported for allocation

unit sizes above 4096.

/F:size Specifies the size of the floppy disk to format

(160,180, 320, 360, 640, 720, 1.2, 1.23, 1.44, 2.88,

or 20.8).

/T:tracks Specifies the number of tracks per disk side.

/N:sectors Specifies the number of sectors per track.

/1 Formats a single side of a floppy disk.
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/4 Formats a 5.25-inch 360K floppy disk in a high-

density drive.

/8 Formats eight sectors per track.

3. LABEL : Label is used to view or change the label of the

computer disk drives.

Syntax :

Creates, changes, or deletes the volume label of a disk.

LABEL [drive:][label]

Examples :

label a: mydisk

This would label the disk currently in the drive to “mydisk”, but will

not label if your disk is write protected.

4. MEM : Allows you to determine the available, used and free

memory.

Syntax :

Displays the amount of used and free memory in your system.

MEM [/CLASSIFY | /DEBUG | /FREE | /MODULE module name]

[/PAGE]

/CLASSIFY or /C Classifies programs by memory usage. Lists the

size of programs, provides a summary of memory

in use, and lists largest memory block available.

/DEBUG or /D Displays status of all modules in memory, internal

drivers, and other information.

/FREE or /F Displays information about the amount of free

memory left in both conventional and upper

memory.

/MODULE or /M Displays a detailed listing of a module’s memory

use. This option must be followed by the name

of a module, optionally separated from /M by a

colon.

/PAGE or /P Pauses after each screen full of information.
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Examples :

mem

This would display information about your memory as seen in the

below examples.

Windows 2000 and Windows XP example output:

655360 bytes total conventional memory

655360 bytes available to MS-DOS

633872 largest executable program size

1048576 bytes total contiguous extended memory

0 bytes available contiguous extended memory

941056 bytes available XMS memory

MS-DOS resident in High Memory Area

mem /f

Display the amount of conventional memory free.

5. PRINT : Print was first introduced in MS-DOS 2.0 as PRINT.COM

and later was changed to PRINT.EXE in MS-DOS 5.0 and above.

This command allowed users to print a text file to a line printer,

in the background.

Syntax :

print /d:device /b:size /u:ticks1 /m:ticks2

drive:\path\ filename /c /p

/d:device Name of printer device

Printer Ports: LPT1, LPT2 orLPT3

Serial Ports:Com1, Com2, Com3 or Com4

/b:size Sets size (in bytes) of internal buffer.

Default=512 with range of 512 to 16384.

/u:ticks1 Maximum number of clock ticks PRINT is to

wait for a printer to become available.

Default=1 with a range of 1 to 255.

/m:ticks2 Maximum number of clock ticks PRINT can

take to print a character or printer. Default=2

with a range of 1 to 255.
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drive:\path\ filename Location and filename of file to be printed.

/c Removes files from the print queue.

/p Adds files to the print queue.

Examples :

print c:\file.txt /c /d:lpt1

Prints the file file.txt to the parallel port lpt1.

6. TREE : Allows the user to view a listing of files and folders in an

easy to read listing.

Syntax :

TREE Drive:\ Path /f /a

Drive:\Path Drive and directory containing disk for display of

directory structure.

/f Displays file names in each directory. /a ext characters

used for linking lines, instead of graphic characters.

/a is used with code pages that do not support graphic

characters and to send output to printers that do not

properly interpret graphic characters.

Examples :

tree

List a tree listing of the current drive. Below is a basic example of

what a directory may look like.

C:.

Common

Director

Flash

Shockwave 8

DswMedia

Prefs

Xtras

update

7. XCOPY : Xcopy is a powerful version of the copy command

with additional features; has the capability of moving files,

directories, and even whole drives from one location to another.
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Syntax :
Windows 2000 and XP xcopy syntax
XCOPY source  [destination] [/A | /M]  [/D[:date]]  [/P] [/S [/E]] [/V] [/

W] [/C] [/I] [/Q] [/F] [/L] [/H] [/R] [/T] [/U] [/K] [/N] [/O] [/X] [/Y] [/-Y] [/Z]

[/EXCLUDE: file1[+file2][+file3]...]

source Specifies the file(s) to copy.

destination Specifies the location and/or name of new files.

/A Copies only files with the archive attribute set, doesn’t

change the attribute.

/M Copies only files with the archive attribute set, turns

off the archive attribute.

/D:m-d-y Copies files changed on or after the specified date.

If no date is given, copies only those files whose

source time is newer than the destination time.

/EXCLUDE: file1 [+file2][+file3]... Specifies a list of files containing

strings. When any of the strings match any part of

the absolute path of the file to be copied, that file will

be excluded from being copied. For example,

specifying a string like \obj\ or .obj will exclude all

files underneath the directory obj or all files with the

.obj extension respectively.

/P Prompts you before creating each destination file.

/S Copies directories and subdirectories except empty

ones.

/E Copies directories and subdirectories, including

empty ones. Same as /S /E. May be used to modify

/T. /V Verifies each new file.

/W Prompts you to press a key before copying.

/C Continues copying even if errors occur.

/I If destination does not exist and copying more than

one file, assumes that destination must be a directory.

/Q Does not display file names while copying.

 /F Displays full source and destination file names while

copying.
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/L Displays files that would be copied.

/H Copies hidden and system files also.

 /R Overwrites read-only files.

/T Creates directory structure, but does not copy files.

Does not include empty directories or subdirectories.

/T /E includes empty directories and subdirectories.

/U Copies only files that already exist in destination.

 /K Copies attributes. Normal Xcopy will reset read-only

attributes.

 /N Copies using the generated short names.

 /O Copies file ownership and ACL information.

/X Copies file audit settings (implies /O).

/Y Suppresses prompting to confirm you want to

overwrite an existing destination file.

/-Y Causes prompting to confirm you want to overwrite

an existing destination file.

/Z Copies networked files in restartable mode.

Examples :

xcopy c:\temp /e

The above example is the basic xcopy command to copy the files,

directories, and subdirectories to the directory you’re currently in.

xcopy “c:\documents and settings\hope” /e

In the above example the xcopy command would copy all files and

directories in the user “hope” directory to the directory or drive you’re

currently in.

xcopy h:\*.* /a /e /k

The above command would copy everything located on the H drive

to the drive you are currently on.

4.9 BATCH FILE

In MS-DOS, OS/2, and Windows, a batch file is a text file containing

a series of commands intended to be executed by the command interpreter.
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When a batch file is run, the shell program (usually COMMAND.COM or

cmd.exe) reads the file and executes its commands, normally line-by-line.

A batch file is analogous to a shell script in Unix-like operating systems.

Batch files are useful for running a sequence of executables

automatically. Many system administrators use them to automate tedious

processes. Although batch files support elementary program flow commands

such as if and goto, they are not well-suited for general-purpose

programming.

DOS batch files have the filename extension .BAT. Batch files for

other environments may have different extensions, e.g. .CMD in Windows

NT and OS/2, or .BTM in 4DOS and related shells.

File extension : .bat .cmd .btm

Type of format : Scripting

CHECK YOUR PROGRSS

Q.1. It is required to create six directories viz. A,B,C,D,E,F. These

directories should follow the hierarchy shown in the following

tree.

The directory A should be created in the root directory of drive

C. Give the sequence of MS-DOS commands which would

yeild the desired results.

............................................................................................

............................................................................................

............................................................................................

 A 

B 

C D 

E F 
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Q.2. How the DOS XCOPY command differ from DOS COPY

command.

............................................................................................

............................................................................................

............................................................................................

Q.3. Many times, the computer goes into hang. Which key

combination is used to reboot the system?

............................................................................................

4.10 LET US SUM UP

 MS-DOS is an acronym for Microsoft Disk Operating System, first

released in August 1981.

 Loading of DOS into main memory is known as booting.

 The three system files of MS-DOS are loaded in order of IO.SYS,

MSDOS.SYS and COMMAND.COM

 DOS commands are of two types : internal and external.

 Internal commands are those that are directly interpreted by the

command processor, COMMAND.COM.

 External commands are those that are interpreted with the help of

external files (with extension .COM or .EXE)

 Storage area on a disk are known as directories. A directory may

contain files and/or subdirectories inside it.

 Path is a sequence of directory names which give you the hierarchy

to access a particular directory or file name.

 The full name of a file or directory (including path) is also called

path.

 Some DOS internal commands are COPY, DEL/ERASE, REN,

TYPE, DIR, CHDIR/CD, MKDIR/MD, RMDIR/RD, BREAK, CLS,

DATE, TIME, PATH, VER etc.

 Some external commands are DISKCOMP, DISKCOPY, FORMAT,

LABEL, MEM, PRINT, TREE, XCOPY etc.
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 Batches of MS-DOS commands stored under a filename with

extension .BAT are known as batch files.

 The batch file with the name AUTOEXEC.BAT is automatically

executed by MS-DOS at the time of booting.

4.11 FURTHER READINGS

 Peter Norton’s DOS Guide by Peter Norton (Author)

 DOS 6.2 by Thomas Robert.

4.12 ANSWERS TO CHECK YOUR
PROGRESS

Ans. to Q. No. 1 : C>MD A

C>MD C:\A\B

omitting C: as it is the current i.e. dafault drive

C>MD \A\B\C

C>MD \A\B\D

C>MD \A\B\D\E

C>MD \A\B\D\F

Or alternatively

C>MD A

C>CD A

C>MD B

C>CD B

C>MD C

C>MD D

C>CD D

C>MD E

C>MD F

Ans. to Q. No. 2 : COPY can only copy the specified files from one

directory only whereas XCOPY /s can copy the files
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from subdirectories also. COPY can not ask for

confirmation before copying files whereas XCOPY /p

can ask for confirmation also.

Ans. to Q. No. 3 : Ctrl + Alt + Del

4.13 MODEL QUESTIONS

Q.1. What do you understand by kernel and shell of MS DOS? What are

their roles ?

Q.2. What do you understand by internal and external commands? How

are they different ?

Q.3. Write the purpose of the following commands? Also state whether

they are internal or external commands.

TYPE, PROMPT, DISKCOPY, MEM

Q.4. Write the purpose of the following commands? Also state whether

they are internal or external commands.

RD, VER,MEM, LABEL, FORMAT

Q.5. What functions do the following commands perform?

a) DISKCOPY b) DISKCOMP

Q.6. How is XCOPY a better copy command then COPY?
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UNIT 5 : MS WINDOWS OPERATING SYSTEM

UNIT STRUCTURE

5.1 Learning Objectives

5.2 Introduction

5.3 Features of Windows 7

5.4 Exploring Components of Windows

5.4.1 The Desktop

5.4.2 The Icons

5.4.3 Working With Windows

5.4.4 The Start Menu and Taskbar

5.4.5 Quitting Windows

5.5 Customizing the Desktop

5.6 Files and Folders

5.7 Let Us Sum Up

5.8 Further Readings

5.9 Answers to Check Your Progress

5.10 Model Questions

5.1 LEARNING OBJECTIVES

After going through this unit, you will be able to:

 introduce yourself to Windows 7

 describe the features of Windows 7

 explore the components of Windows 7

 customize your Windows working environment

 work with files and folders to suit your needs.

5.2 INTRODUCTION

Windows 7 is the latest version of Operating System to have evolved

in the Microsoft Windows Operating Systems family, and is the best-reviewed

and technically better than the earlier versions of Windows. Hence Windows
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7 has proved to be the most universally accepted operating system so far.

Unlike its predecessor Windows Vista, which introduced a large number of

new features, Windows 7 was intended to be a more focused, incremental

upgrade to the Windows line, with the goal of being compatible with

applications and hardware with which Windows Vista was already

compatible. Windows 7 is technically an evolution of Windows Vista in terms

of stability and security, maintaining everything that was good about Vista.

Some of the improved features of Windows 7 that make this version more

superior to Vista are: greater speed, less hardware requirements and its

user-friendliness.

In this unit, we will discuss about the features that are new in

Windows 7 making it a better and more accepted operating system than

the earlier versions. The different components of Windows 7 like the desktop,

icons, menus etc that are somewhat more improved will also be discussed.

And lastly, the technique of customizing the desktop to suit our usage needs

will also be covered.

5.3 FEATURES OF WINDOWS 7

The Windows 7 operating system is more stable, intuitive and easy

to use than any previous version. Here we look at some of the most

compelling overall end-user features that will make a difference on the

desktop. Some are small, and some are major, but taken all together it

makes for the most exciting upgrade for Windows users since the arrival of

Windows XP.

1. Speed : Even aside from incompatibilities and other issues that

many people had with Windows Vista, one of the most

straightforward was speed as it just felt too sluggish compared

to XP, even on good hardware. Windows 7 brings a more

responsive and sprightly feel, and Microsoft has spent a lot of

time and effort getting the Start Menu response just right.

Microsoft has also recognized the need for improved desktop

responsiveness, which gives the impression that the computer
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is responding to the user and that they are in control. One can

also expect faster boot times, and the boot sequence is now not

only prettier than it was with Vista, but it is speedier too.

2. Compatibility : In simple terms, compatibility on Windows 7 is

far better than it was with Vista. Many programs that individuals

and companies used on Windows XP did not work immediately

and required updates, but with Windows 7 almost all applications

that work on Vista should still run. In essence, Windows Vista

has done most of the hard work for Windows 7 in this respect.

3. Lower hardware requirements : Windows Vista gained a

reputation for making even the best hardware look rather

ordinary. Windows 7, however, runs well on lower end hardware,

making the transition from Window XP less painful.

4. Search and organization : Search is vastly improved in

Windows 7. We type a search term in the window (the window

right above the Start key when we click on it), and get a list

of all results. What is great is that the results are not just

presented as one huge list, but are grouped into categories like

Programs, Music and Documents. It makes finding files a lot

easier. Search is also lightning-fast with no more waiting, like in

Vista or XP.

5. TaskBar/Start menu : At first glance, the task bar looks like

nothing much has changed since Windows Vista. In fact, that is

not the case and it is a lot more powerful. Microsoft is now making

best use of its aero technology. By default, taskbar icons are

now larger and items are grouped together and are not labeled

with clumsy text. If we have multiple Word/ Windows Explorer

windows open then we will see a stack appear on the task bar.

When we hover over the application, each window will be visible

in a thumbnail. If we hover over each thumbnail it will become

visible, while all other open windows temporarily disappear. We

can close each document or Window down from the thumbnail

directly or click on it to bring it to the front.
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6. Aero-shake : The favorite new visual feature of Windows 7 is

called ‘Aero Shake’. In case we have a multitude of Windows

open but want to focus on just a single Window, all we have to

do is grab it by the title bar (at the top) and shake with the mouse.

This minimizes all the other Windows leaving just the one we

grabbed on the desktop.

7. Stacking : Another great touch is Stacking, whereby we may

simply drag a Window to the sides of the screen and it will stick

automatically to the side filling half the screen, thus making it

quick and easy to view documents side by side. If we move to

the top, it will maximize to the whole screen.

8. Action Center : The User Account Control (UAC) was one of

the headline annoyances in Windows Vista. In a reaction to

malware problems, the Windows designers introduced the UAC,

a dialogue box that popped up every time any changes were

made to Windows when installing apps. It proved quite annoying,

especially to power users who tended to turn it off straight away,

thereby negating any benefit it might have. In Windows 7, a

slider has been added, enabling users to tone down its nagging

factor, making them less likely to turn it off completely.

9. Touch : The most whizz-bang visual feature to come to Windows

7 is its touch capability. This of course will only be available to

those with a touch enabled PC, but for those suitably equipped

it will provide a new way of interacting with their PC. The video

will let them open applications from the taskbar, scroll up and

down by flicking, and zoom and rotate pictures by holding and

turning.

10. Gadgets : Windows Vista introduced Gadgets and a sidebar

which provides the ability to anchor Gadgets to the side of the

user’s desktop. In Windows 7, the sidebar has been removed,

while gadgets can still be placed on the desktop. Windows 7

adds a Windows Media Center gadget to the default collection

while removing the Contacts and Notes gadgets. Managing
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gadgets is more closely integrated with Windows Explorer, but

the gadgets themselves continue to operate in a separate

sidebar.exe process. The Desktop context menu includes a new

“Gadgets” menu option to access the gadget gallery, and a

“View” sub-menu option to show or hide gadgets. Hiding gadgets

results in the sidebar.exe process being unloaded, which

Microsoft says is a power-saving practice.

5.4 EXPLORING WINDOWS

The Windows system is made up of several parts that function

separately in their own unique way. These parts or components provide the

users many utilities, using which the users can perform several tasks in a

very user-friendly manner.

The Windows system consists of several separate components like

the desktop, which is the very first thing we get to see on starting Windows.

It consists of a taskbar which is used to launch and monitor applications, a

start button that is visible at all times in the lower left-hand corner of the

screen, a Start Menu that serves as the central launching point for

applications, providing a customizable, nested list of programs for the user

to launch, as well as a list of most recently opened documents, a way to

find files and get help, and access to the system settings. Files in the

Windows system provide a very easy and safe way to store different kinds

of information related to different application. These files can be saved and

stored and can later be also edited or deleted. The help and support system

in Windows is also a very interesting feature that provides easy assistance

to users who are in need of help while working with the Windows system. In

the later sub-sections we will get to know about these components of

Windows, and discuss in detail the different features and functionalities of

these components.

5.4.1 The Desktop

The desktop is the main screen area that we get to see after

turning on a computer and logging on to Windows as shown in Figure
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5.1. The desktop serves as a surface for work, with open programs

or folders appearing on the desktop. We can also put things on the

desktop, such as files and folders, and arrange them accordingly.

The desktop is sometimes defined more broadly to include the

taskbar which sits at the bottom of the screen. The taskbar shows

us the running programs and allows switching between them. It also

contains the Start button, which allows us to access programs,

folders, and computer settings.

Fig. 5.1 : The Desktop

CHECK YOUR PROGRESS

Q.1. State whether the following statements are True or False.

(i) The Windows 7 operating system is more stable, intuitive

and easy to use.

(ii) The desktop serves as a surface for work.

(iii) The taskbar shows us the running programs and allows

switching between them.

(iv) The Start button does not allow us to access programs,

folders, and computer settings.

(v) In Windows 7, the sidebar has been removed, while

gadgets can still be placed on the desktop.
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5.4.2 The Icons

Icons are small pictures representing files, folders, programs,

and other items of a computer. These icons give quick access to

frequently used programs, files and folders. When we first start

Windows, we can see at least one icon on the desktop: the Recycle

Bin. Some examples of desktop icons are shown below.

When we double-click an icon, the corresponding window of

that icon opens. We can also add, remove, rename and move icons

on the desktop according to our needs. Common desktop icons

include My Computer, the user’s personal folder, the Recycle Bin,

and Control Panel.

Fig. 5.2 : The Desktop icon settings dialog box
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 Adding or Removing desktop icons

1. Firstly we right-click on empty area of the desktop, and then

click Personalize.

2. In the left pane, we click Change desktop icons which opens

the Desktop icon settings dialog box as in Figure 5.2

3. Under Desktop icons, we select the check box for each

icon that we want to add to the desktop, or clear the check

box for each icon that we want to remove from the desktop,

and then click OK.

To remove an icon from the desktop we may right-click the icon,

and then click Delete. In case the icon is a shortcut, only the shortcut

is removed but the original item is not deleted.

 Renaming icons – A desktop icon can be easily renamed by

the following steps:

1. Firstly we right-click the icon on the desktop

2. Then from the pop-up menu we select the rename option

3. We then enter a new name for the icon

OR

1. We first select the icon to be renamed

2. Then we press the F2 key

3. Finally we enter a new name for the icon

 Moving icons : Icons on the desktop are stacked in columns

on the left side of the desktop. But if desired such an arrangement

can be changed by moving an icon by dragging it to a new place

on the desktop. To do so we follow these steps:

1. Firstly we select the item to be moved

2. Pressing and holding the left mouse button, we move the

icon to the desired destination

3. As soon as the destination is reached we release the mouse

button

 Arranging icons : Windows can also arrange our icons

automatically. To do so we follow these steps:

1. Firstly we right-click an empty area of the desktop
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2. We then select View and click on Auto arrange icons

3. Windows automatically stacks our icons in the upper-left

corner and locks them in place

In order to unlock the icons to move them again, we may click

Auto arrange icons again, clearing the check mark next to it.

 Moving multiple icons : In order to move or delete a bunch of

icons at once, we must first select all of them. To do so we follow

these steps:

1. At first we click an empty area of the desktop and drag the

mouse.

2. We surround the icons that we want to select with the

rectangle that appears.

3. When the desired icons are surrounded we release the

mouse button.

4. Now we can drag the icons as a group or delete them.

5.4.3 Working with Windows

While working in the Windows environment, we perform many

tasks like creating different application files, editing them, managing

them and many other tasks that require us to constantly use a number

of windows that are related to the currently used processes. In such

a situation we need to ‘move’, ‘minimize’, ‘maximize’, ‘restore’,

‘resize’, ‘close’ and perform other tasks related to separate windows.

In this section we will be discussing these in detail, as to how to

control separate windows according to our needs.

When we open a program, file, or folder, it appears on the screen

in a frame called a window. These windows are of two types as

shown below–

1. Program application window : These windows are associated

with application programs and their look and feel may vary across

different application software. Figure 5.3 shows the window of

MS Excel 2007 which is a MS Office application program window.
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Fig. 5.3 : A program application window

2. Folder window : These windows are viewed when we browse

through the different folders in a hierarchical order to work with

different files and folders. A typical folder window is shown in

Figure 5.4 below.

Fig. 5.4 : A folder window

Although program application windows and folder windows are

used for different purposes, there are some features that are

common between both the types.

 Minimizing a window : A window can be minimized by doing

any one of the following :
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 By clicking the minimize button. 

 With the keyboard shortcut Alt + (space) + n

On minimizing a window it disappears from the desktop and is

visible only as a button on the taskbar as shown below.

MS Word as a Taskbar button

 Restoring a window : A window can be restored by doing any

one of the following:

 By clicking the restore button. 

 By the keyboard shortcut  +  

 By the keyboard shortcut Alt + (space) + R

 By dragging the window down from the top of the screen

 By double-clicking the title bar

On restoring a window its size decreases from all the four sides

but it does not get minimized.

 Maximizing a window : A window can be maximized by doing

any one of the following:

 By clicking the restore button. 

 By the keyboard shortcut  +  

 By double-clicking the title bar

 By the keyboard shortcut Alt + (space) + X

 By dragging the window up against the top of the screen

On maximizing a window it gets maximized to its full size covering

the entire desktop.

 Moving a window : A window can be moved only when it is in a

restored position by doing any one of the following:

 By clicking on the title bar of the window and dragging it to

the position we want

 By the keyboard shortcut Alt + (space) + M. We have to

then use the arrow keys to position the window accordingly,

and finally we press the Enter key when positioning is done.
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 Resizing a window – A restored window can be resized by

following these steps:

1. Firstly we point to any of the window’s borders or corners.

2. When the mouse pointer changes to a two-headed arrow,

we drag the border or corner to shrink or enlarge the window.

Fig; 5.5 : Resizing a window

 Closing a window : A window can be closed by doing any one

of the following:

 By clicking the close button  located in the upper-right

corner

 By pressing Alt + F4

 By double-clicking the upper-left corner of the window

 By using the keyboard shortcut Alt + (space) + C

 By right-clicking the window’s taskbar button, and then

choosing Close

 By right-clicking the title bar and choosing Close

 By choosing File > Close

5.4.4 The Start Menu and Taskbar

The START menu : The Start menu as in Figure 5.6 is the first

doorway to a computer’s programs, files folders, settings etc. In

other words, it provides the users an entry-point wherefrom they

can START using a computer and access all its resources. We can

use the Start menu to perform many activities like start different

programs, open commonly used folders, search for files, control

computer settings, get help with the Windows operating system,

turn off the computer, log off or switch user accounts etc.
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 To open the Start menu, we may do any one of the following:

 Click the Start button  in the lower-left corner of the

screen.

OR

 Press the Windows logo key  on the keyboard

The Start menu is split down the middle into two columns :

1. Left column (white) : At the top and above the thin divider line is

the pinned items list, which the user can modify. It lists programs,

folders, documents and everything else that we need to open

quickly. This list never changes unless we change it. Below the

fine line is the standard Window’s most frequently used

programs list. This list is automatically computed by Windows

and may change from day to day. At the very bottom is the All

Programs list which includes a list of all the installed programs

in the computer, plus the search box.

2. Right column (dark) : In general, the right side of the Start menu

lists important places on the computer namely folders like

documents, pictures and music or special windows like network,

control panel, and computer.

At the bottom is the Shut down button, which turns the PC

off. The button    next to it offers several variation of ‘off’ like ‘log-

off’, ‘lock’, ‘restart’, ‘sleep’ and ‘hibernate’.

Search box : The search operation can find files, folders,

programs and all sorts of documents that are in the computer. The

moment we start typing in the Search box, we trigger Window’s

very fast computer search function. It also finds anything in the Start

menu, thus making it a very quick way to pull up something without

clicking through a bunch of sub-menus.
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Fig. 5.6 : The Start menu

The Taskbar : The long horizontal bar that we can see at the

bottom of the computer screen is the taskbar. It is divided into three

main sections as illustrated in Figure 5.7.

1. The START button is at the extreme left of the taskbar and opens

the Start menu.

2. The middle part contains the icons of the programs that are

currently open. These icons make it easier to switch from one

program to another.

3. The notification area at the extreme right includes a clock and

icons (small pictures) that communicate the status of certain

programs and computer settings.

 

Most frequently used

Pinned items Important locations and functions

Search box
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Fig. 5.7 : The Taskbar

CHECK YOUR PROGRESS

Q.2. Fill in the blanks.

(i) __________ give quick access to frequently used

programs, files, and folders.

(ii) When we __________ an icon, the corresponding

window of that icon opens.

(iii) __________ can also arrange our icons automatically.

(iv) On __________ a window it disappears from the desktop

and is visible only as a button on the __________.

(v) A window can be restored by double-clicking the

__________.

Q.3. State whether the following statements are True or False.

(i) A window can be minimized by clicking the maximize

button.

(ii) A window can be moved only when it is in a restored

position.

(iii) We can open the start menu by clicking the start button.

(iv) The Start menu is split down the middle into three

columns.

(v) The START button is at the extreme left of the taskbar.

5.4.5 Quitting Windows

After finishing our work on a computer, it is important to turn it

off in a proper manner. Shutting down a computer in a recommended

way saves energy and also helps to keep the computer more secure

by making sure that our data is saved. If this is not done, all the
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unsaved data will be lost forever. Therefore it is very important to

shut down a computer in a proper manner.

 To quit windows we should follow these steps –

1. Firstly, we need to save all the unsaved data

2. Then we click the Start button

3. The start menu opens up which includes the Shut down

button

4. When we click the Shut down button, we exit Windows and

after sometime the entire computer comes to a halt, indicating

that Windows was shut down successfully.

The button   next to the Shut down button offers several

variation of ‘off’ like ‘log-off’, ‘lock’, ‘restart’, ‘sleep’ and ‘hibernate’.

Fig. 5.8 : Quitting Windows

Log-off : When we log off from Windows, all the running

programs are closed, but the computer is not turned off. After logging

off, another user can log on without restarting the computer. Also
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we do not need to worry about losing our information if another user

turns off the computer.

 To do so we follow these steps :

1. We click the Start button 

2. Then point to the arrow   next to the Start button

3. From the menu we select the Log off option

Lock : This command locks the computer and hides the screen

from view. By doing so we can protect our computer from any

unauthorized use, because after locking a computer it can later be

accessed only by providing the correct password by the person who

provided it for locking the computer.

 To do so we follow these steps :

1. First we click the Start button 

2. Then we point to the arrow   next to the Start button

3. From the menu, we select the Lock option

Switch user : This command comes into play when we have

multiple accounts and need to switch users. When we select Switch
user, somebody else can log into the computer using their respective

name and password. Even though users switch their accounts, all

their respective settings and open files remain intact and in the same

position where they had left before switching their accounts.

 To do so we follow these steps :

1. We click the Start button 

2. Then we point to the arrow   next to the Start button

3. From the menu we select the Switch user option

Restart : This command quits all open programs, and then quits

and restarts Windows again automatically.

 To do so we follow these steps :

 First we click the Start button 

 Then we point to the arrow   next to the Start button

 From the menu we select the Restart option
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Sleep : Sometimes instead of shutting down the computer we

can put it to the sleep mode, whereby the computer goes to sleep

and the display turns off, and often the computer’s fan stops. A light

on the outside of the computer case blinks or turns yellow to indicate

that the computer is asleep. The whole process takes only a few

seconds.

Windows will remember what the computer was doing before

going to sleep, there is no need to close our programs and files

before the computer is set to sleep. But it is always recommended

to save our work before putting the computer into any low-power

mode. Later, when we turn on the computer (and enter a password,

if required), the screen will look exactly as it did when the computer

was turned off. To wake the computer, we may press the power button.

 To do so we follow these steps :

1. Firstly we click the Start button 

2. Point to the arrow   next to the Start button

3. From the menu select the Sleep option

5.5 CUSTOMIZING THE DESKTOP

We have already come across the concept of the desktop, the

different components that constitute the desktop and the ways to use those

components. In this section we will be dealing with some of the issues that

relate to customizing the desktop. The desktop is the work area on a

computer screen, similar to the top of an actual desk. The desktop contains

the Recycle Bin and icons (shortcuts to programs, files, folders, and various

types of documents such as letters, reports, or pictures) that we can arrange

just like arranging real objects on a desk.

 Customizing the desktop theme : The Desktop theme is a

combination of pictures, colors, and sounds on our computer

which includes a desktop background, a screen saver, a window

border color, and a sound scheme. Windows 7 comes with

several themes that we may choose from.

MS Windows Operating SystemUnit 5



Computer Fundamentals and PC Software 113

These are –

 An Aero theme to personalize the computer

 The Windows 7 Basic theme.

 A High Contrast theme.

 To choose a Windows theme we do the following –

1. Firstly we right-click a blank spot on the desktop

2. From the pop-up menu, we click on Personalize which opens

the Personalize control  panel as in Figure 5.11

3. There we find several pre-built themes to choose from

4. Clicking on any of those themes applies that theme to the

desktop world instantly

We may also change a theme’s pictures, color, and sounds

individually to create a customized theme by doing the following –

1. We first open the Personalize window of Figure 5.9

2. Then we select the theme that we want to customize

3. We do one or more of the following

 To change the background, we click Desktop Background

and select the check box for the image that we want to use,

and finally click Save changes.

 To change the color of window borders, we click Window

Color and click the color we want to use.  We may adjust

the intensity, and then click Save changes.

 To change the sounds for the theme, we click Sounds and

change sounds in the Program Events list under the Sounds

tabs. Finally we click OK.

 To add or change a screen saver, we click Screen Saver.

Then we click an item in the Screen saver list and change

any settings that we want, and finally click OK.
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Fig. 5.9 : The Personalize window

 Customizing the desktop background (wallpaper) : The

desktop background (wallpaper) can be set as any picture, or

we can display a slide show of pictures. To change the desktop

background we do the following:

1. We open the Personalize window of Figure 5.9

2. Then we click on Desktop Background which opens the

window as in Figure 5.10

3. We click the picture or color we want as our desktop

background. If the picture we want is not in the list of desktop

background pictures, we may click an item in the Picture

location list to see other categories, or click Browse to

search for the picture on the computer. On finding the picture,

we double-click it to apply it as the desktop background.

4. Under Picture position, we click the arrow and choose

whether to crop the picture to fill the screen, fit the picture to

the screen, stretch the picture to fit the screen, tile the picture,

or center the picture on the screen, and then click Save

changes.
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Fig. 5.10 : Desktop Background

Customizing the Start menu : If we customize the Start menu

according to our needs, it becomes easier for us to find our favourite

programs and folders.

 Pin a program icon to the Start menu : When we use a program

very often, it can be useful to create a shortcut to it by pinning

the program icon to the Start menu. These program icons appear

on the left side of the Start menu.

To do so we do the following :

 We right-click the program icon that we want to pin to the

Start menu

 Then click Pin to Start Menu.

(Tip: To unpin a program icon, right-click it and click Unpin from

Start Menu)

 Remove a program icon from the Start menu : When we

remove a program icon from the Start menu, it does not remove it

from the All Programs list or uninstalls the program.

To do so we do the following :

1. First we click the Start button

2. Then we right-click the program icon we want to remove

from the Start menu

3. Finally we click Remove from this list
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 Move the Start button : The Start button is located on the

extreme left of the taskbar. Though we cannot remove the Start

button from the taskbar, we can of course move the taskbar —

and the Start button along with it.

To do so we follow these steps :

1. Firstly we right-click on empty space on the taskbar. In case

Lock the taskbar has a check mark beside it, we uncheck it.

2. Then we click an empty space on the taskbar, and holding

down the mouse button we drag the taskbar to one of the

four edges of the desktop. When the taskbar is where we

want it, we release the mouse button.

5.6 FILES AND FOLDERS

Files : Files in a computer are items containing varied sorts of

information. Files can be of various types - e.g. text files, music files, video

files, image files, sound files etc. Files are represented by icons, thus making

it easy to recognize a type of file by looking at its icon. A file icon often

represents the application program that can open the file. The following are

some common file icons:

Folders : A folder acts as a container that can be used to store files.

Folders in a computer are used to store files in an organized way. When

there are too many files of different types all related to different purposes,

folders can be of big help in organizing those files. This can be achieved by

having different folders to store different types of files.

Folders may also store other folders, and in such cases a folder

located inside a folder is called a subfolder. We may keep on creating many

such subfolders, each holding many files and additional subfolders. Following

are two folder icons.
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 The parts of a window : Every time we open a folder, we see it

in a window having various parts which help us to navigate around

Windows or work with files and folders. Here is a typical window

with each of its parts described below:

Fig. 5.11 : Windows Files and Folders Explorer

Navigation pane : We can use this pane to access libraries, folders,

saved searches, and the hard disks. The Favorites section is used to open

the commonly used folders and searches. The   Libraries section can be

used to access our libraries. The Computer folder also enables us to browse

folders and subfolders.

Back and Forward button : These two buttons are used to navigate

other folders or libraries without closing the current window. If we use the

address bar to change folders, we can use the Back button to return to the

previous folder.
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Toolbar : The toolbar is used for some common tasks, like changing

the appearance of files and folders, burning CDs, or starting a slide show.

The buttons of the toolbar change to show only the tasks that are relevant.

That is, a toolbar for a picture file would be different from the toolbar of a

music file.

Address bar : This is used to navigate to a different folder or library

or to go back to a previous one.

Column headings : We use these to change the organization of

files in the file list. We may click the left side of a column heading to change

the order in which the files and folders are displayed, or click the right side

to filter the files in different ways.

File list : The file list displays the contents of the current folder or

library. In case we type in the search box to find a file, only the files that

match the current view will appear.

Search box : We type a word or phrase in the search box to search

an item in the current folder or library. As we begin typing the first letter, the

searching process begins — that is typing “A” will display all files with names

starting with the letter A in the file list.

Details pane : The details pane is used to see the most common

properties associated with the selected file, like the author, the modification

date, and other descriptive tags added to the file.

 Viewing and arranging files and folders : We can change the

appearance of files in a window when we open a folder or libraries

that contain them. For example, we can use the Views button I

in the toolbar to switch between larger or smaller icons, or a

view that shows different information about each file.  Clicking

the left side of the Views button changes the display of files and

folders by cycling through five different views :

 Large Icons

 List

 Details, shows several columns of information about the file

 Tiles

 Content, shows some of the content from within the file.
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On clicking the arrow on the right side of the Views button, we see

the Figure 5.12. Moving the slider up or down changes the size of the file

and folder icons.

Fig. 5.12 : The views options

 The search box : The search box located at the top of every

window is used to search for a file.

To do so we follow these steps :

1. We open the folder or library that is the starting point for the

search.

2. Then click the search box

3. As we type the name in the search box, it filters the current

view based on the typed text.

Files are displayed as search results if our search term matches

the file name, tags or other properties, or even the text inside a text

document.

 Copying and moving files and folders

While working with several files and folders, we may sometimes

need to copy and move them between different locations.

To do so we follow these steps :

1. Firstly we select the file to be copied. To select multiple files

we use Shift + Arrow keys OR Ctrl + click.

2. We right-click on them and choose Cut/Copy, or press Ctrl

+ C to copy, Ctrl + X to cut
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OR

From the Organize button we select Cut/Copy

3. Open the destination where the file/folder has to be Pasted

4. Right-click and choose Paste

OR

From the Organize button select Paste

OR

Press Ctrl + V

CHECK YOUR PROGRESS

Q.4. Fill in the blanks.

(i) Shutting down a computer in a recommended way saves

__________.

(ii) When we log off from Windows, all the running programs

are __________, but the computer is not turned

__________.

(iii) The __________ command comes into play when we

have multiple accounts and need to switch users.

(iv) The Desktop __________ is a combination of pictures,

colors, and sounds.

(v) The desktop __________ can be set as any picture.

(vi) When we use a program very often, it can be useful to

create a shortcut to it by pinning the program icon to the

__________.

Q.5. State whether the following statements are True or False

(i) When we remove a program icon from the Start menu, it

removes it from the All Programs list.

(ii) We can remove the Start button from the taskbar.

(iii) Folders in a computer are used to store files in an

organized way.

(iv) Folders cannot store other folders.
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(v) Address bar is used to navigate to a different folder.

(vi) The details pane is used to see the most common

properties associated with the selected file.

5.7 LET US SUM UP

 Windows 7 is technically an evolution of Windows Vista in terms of

stability and security.

 The hardware requirements of Windows 7 are lower than that of

Windows Vista.

 The desktop is the first thing that we get to see when we start

Windows.

 Icons are small pictures that represent files, folder and programs.

 Folder application windows are used to view and browse through

folders.

 The start menu is the first gateway to a computer’s programs, files,

folders etc.

 The search operation can find files, folders, programs and all sorts

of documents that are in the computer.

 The restart command quits all open programs, and then quits and

restarts Windows again automatically.

 We can customize the look and feel of the desktop according to

our preferences.

 Files in a computer are items containing varied sorts of information.

 A folder acts as a container that can be used to store files.

5.8 FURTHER READINGS

 David Pogue : Windows 7 – the missing manual. O Reilly.
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5.9  ANSWERS TO CHECK YOUR PROGRESS

Ans. to Q. No. 1 : (i) true,  (ii) true,  (iii) true,  (iv) false,  (v) true.

Ans. to Q. No. 2 : (i) Icons,  (ii) double-click,  (iii) windows,

(iv) minimizing, taskbar,  (v) title bar.

Ans. to Q. No. 3 : (i) false,  (ii) true,  (iii) true,  (iv) false,  (v) true.

Ans. to Q. No. 4 : (i) energy,  (ii) closed, off,  (iii) switch user,  (iv) theme,

(v) background,  (vi) start menu

Ans. to Q. No. 5 : (i) false,  (ii) false,  (iii) true,  (iv) false,  (v) true, (vi) true

5.10 MODEL QUESTIONS

Q.1. Explain any five important features of Windows 7.

Q.2. What are Windows components? Give examples.

Q.3. What are icons? What are the steps of moving icons?

Q.4. Explain briefly the types of Windows. How do we close, minimize,

move and resize a window?

Q.5. What is the Windows 7 Start menu? Explain its parts.

Q.6. How do we restart, log-off and lock a computer.

Q.7. How can we customize the start menu?

Q.8. Describe the different parts of the Window Explorer.
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UNIT 6 : LINUX OPERATING SYSTEM

UNIT STRUCTURE

6.1 Learning Objectives

6.2 Introduction

6.3 Open Source and Free Software

6.4 Advantages of Linux

6.5 Disadvantages of Linux

6.6 Linux Booting Process

6.7 Linux Filesystem Hierarchy

6.8 The Main Component of Linux Operating System

6.9 Concept of Path

6.10 Basic Linux Commmand

6.11 File Permission

6.12 Text Editor vi

6.13 Let Us Sum Up

6.14 Answers to Check Your Progress

6.15 Further Readings

6.16 Model Questions

6.1 LEARNING OBJECTIVES

After going through this unit, you will be able to :

 know about the Free and Open source

 understand the advantages and disadvantages of Linux

 discuss the Booting process of linux

 know about Linux file system hierarchy

 various Linux command.

6.2 INTRODUCTION

In the previous unit, we have discussed the Windows operating

system. In this unit we are going to discuss the Linux operating

system.Windows operating system is not free and we need to  buy in order
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to use.In addition Windows hides the detailed working of the Operating

System from the user and it will not allow the users to see or modify the

source code. But in case of Linux Operating system it is completly free and

the source code is available for free  to use or modify. The advantages of

linux operating are: Better Security, Freedom to use ,it is free,

Multitasking,Flexibility ,Stability etc.

In the following section we are going to discuss about the Open

Source and Free Software as well as the Path concept and various Linux

commands.

6.3 OPEN SOURCE AND FREE SOFTWARE

Free software is the software that can be used,modified or studied

without  restriction. It is generally available without charge, but it can also

have a fee, such as in the form  of distribution medium like CD or DVD etc.

The free software movement was conceived in 1983 by Richard

Stallman to satisfy the need for and to give the benefit of software freedom

to computer users.The definition, written by Richard Stallman, is still

maintained today and it states that software is free software if the software

have the following four freedoms:

 To run the  program for any purpose.

 To study how the program works, and change it to make it do

what you wish.

 To redistribute copies so you can help your neighbor.

 To improve the program, and release modified versions to the

public, so that the whole community benefits.

Free Software and Open Source have more or less the same aims

but differ in their philosophy and values. The fundamental difference between

the two movements is in their values, their ways of looking at the world as

mentioned by GNU Foundations.

For the Open Source movement, non-free software is a suboptimal

solution. For the Free Software movement, non-free software is a social

problem and free software is the solution.
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Open-source software is computer software that is available in source

code form provided under a software license that permits users to study,

change, improve and also to distribute the software.

6.4 ADVANTAGES OF LINUX

There are various advantage of Linux over Windows Operating as

described below:

Cost : Linux is compleley free Operating System and we can modify

or re-disrtibute the source code without any restrictions. However Windows

is not free and we have to pay for using it.

Multi User interface : Linux is multi user system .i.e. more than

one user can interact with the linux system. But  Windows is single user

system that can interact at a time.

Security : The security aspect of Linux is much stronger than that

of Windows.

6.5 DISADVANTAGES OF LINUX

Understanding : It is not so easy to understand the Linux operating

clearly. We have to give much care while learning the Linux system.

Alternative Software : There are still some applications that exist

on Windows that have no equivalent Linux application.

Compatibility : Though the kernel contributors and maintainers work

hard at keeping the kernel up to date to make it compatable with all hardware,

sometimes we can find third party applications, sometimes we can't.

6.6 LINUX BOOTING  PROCESS

Booting is a bootstrapping process  that starts operating systems

when  the user turns on a computer  system.Before going to the booting

process of linux lets take a look  at the general booting process of a machine.

Booting Sequence :

a. Turn On the PC

b. CPU jump to address of BIOS
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c. BIOS runs POST (Power-On Self Test)

d. Find bootable devices

e. Loads and execute boot sector from MBR(Master Boot Record)

f. Load the OS to RAM

BIOS (Basic Input Output System) refers to the software code run

by a computer when first powered on.Master Boot Record, a small program

that is executed when a computer boots up and typically, the MBR resides

on the first sector of the hard disk.The main function of POST is  to check

whether all  the hardware component are working properly or not and report

the errors if any to the users.

After the POST operation as described above, BIOS loads and

execute  the partition boot code from the designated boot device which

contains phase 1 of a Linux boot loader.Phase 1 loads Phase 2 boot

loader.The boot loader often presents the user with a menu of possible

boot options. It then loads the operating system. Then call the start_kernel()

which performs the memory management, device initialization etc and start

the init process. The init process starts  all the non-operating system services

and provides the user with a login screen.

In summary,

– BIOS loads the Phase1 boot loader

– Phase 1 boot loader start Phase 2 boot loader

– then start-kernel() function is called

– init process starts

– init starts all non-operating system services and presents users

with login screen.

6.7 LINUX FILESYSTEM HIERARCHY

One interesting thing about Linux is that everyting is treated as either

a file or directory.Even the hardware is considered  a file which is stored in

the  /dev  directory.Linux dosen’t use drive letters to distinguish between

different partitions and devices. the “root” is deonted as / whereas in Windows

it would most probably be C:
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Drives in linux are “mounted” to the specific directories(e.g /mnt/

pen_drive, you need to create pen_drive directory) where their data can

then be accessed, So for instance, if you need to use your thumbdrive, you

would plug it into your computer and then mount it using the “mount”

command, which specifies the path to the device.

Fig. 6.1

The image above shows the linux filesystem hierarchy and is

described in brief below:

/

this is the root folder, all other folders come under root.We can

consider it as C: drive  in a Windows context.

/bin

this folder contains all the user-essential binaries programs .e.g cp,

ls etc.
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/boot

It contains configuration files and other necessary files that are

needed by the bootloader

/dev

This folder contains device files.

/etc

This folder contains all the configuration files used by the system.

/home

This contains the home folders of all the normal  users on the system.

/lib

It  contains software libraries

/media

This is a mount point for removable devices

/mnt

This is a temporary mount point

/opt

This folder contains add on software

/sbin

This folder contains binaries that can only be run as the root user

/tmp

This folder contains temporary files that are erased upon reboot

/usr

This folder and its subfolders contains user installed programs and

utilities and libraries

/var

This folder contains files that change a lot. e.g contains log files.

/root

This folder contians the root user’s files

/proc

This folder contains information about the Linux kernel and hardware

that is updated in realtime.

Linux supports numerous file system types as described below in

brief:
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Ext2 : It uses the concepts of blocks, inodes and directories.

Ext3 : It is the enhanced version of ext2 file system with journalling

capabilities. Journalling allows fast file system recovery.

Sysfs : It is a ram-based filesystem initially based on ramfs. It is

used to exporting kernel objects so that end user can use it easily.

Procfs : The proc file system acts as an interface to internal data

structures in the kernel. It can be used to obtain information about

the system and to change certain kernel parameters at runtime using

sysctl command.

6.8 THE MAIN COMPONENT OF LINUX OPERATING
SYSTEM

The Linux operating system is made up of three parts; the kernel,

the shell and the programs.

The kernel : The kernel  is the hub of this operating system. We

can consider it as  a bridge between applications and the actual data

processing done at the hardware level.

The main function of  kernel includes memory management, device

management,process management etc.

The Shell : It acts as an interface between the user and the kernel.

Shell is  also known as command line interpreter. When the user types the

command, shell executes the command according  to the order of  command.

Fig. 6.2
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Programs : This are the program used for general application like

copying file using cp,creating directory mkdir. The shell provides the

interface for such program.

6.9 CONCEPT OF PATH

In Linux, all file systems (Hard Disks, CD-ROMs, Floppy Disks, ZIP

drives, network mounts, etc…) are “mounted” onto one logical tree. The

top of the hierarchy is traditionally called root which is represented by a /

(slash). In Linux, everything is treated as a file.  A directory is a file. It is a

file that contains a list of files and information belonging to those files.  This

would include things like who “owns” (created) the file, how long it is, and

who can use it.  Since a directory is simply a list of files, it can contain any

file in it, including other directories.

Fig. 6.3 : Part of file-system tree

You can specify a file or directory by its path name.  There are two

ways of expressing the path name: Full (absolute) path name or Relative

path name. The full path name starts with the root. /, and follows the branches

of the file system, each separated by /, until you reach the desired file.

However, a relative path name specifies the path relative to your

current working directory. Relative path names are more convenient because

they are shorter, but must be used with care. They never begin with / (slash).

Now, we have to introduce two special directory entries:

 

bin etc dev 

Kkhsou2 

usr 

/ 

home 

local 

Kkhsou3 

src 

Kkhsou1 

st111111 st222222 st333333 
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 the current directory

 the parent directory

As an example, (Using the above diagram)  assume that your current

working directory (your current position in the file  system) is kkhsou1:

1. A file named “test.txt” is placed inside the directory “st111111”.

The absolute (full) name is : /home/kkhsou1/st111111/test.txt

The relative name is : st111111/test.txt  OR ./st111111/test.txt

2. A directory named “DEC” is placed inside the directory

“kkhsou2”.

The absolute (full) name is : /home/kkhsou2/DEC

The relative name is : ../kkhsou2/DEC

3. A file named “csh” is placed inside the directory “bin”.

The absolute (full) name is : /bin/csh

The relative name is : ../../bin/csh

4. A directory named “st123456” is placed inside the directory

“kkhsou1”.

The absolute (full) name is : /home/kkhsou1/st123456

The relative name is : st123456 OR ./st123456

CHECK YOUR PROGRESS

Q.1. Write the purpose of the following directory in LINUX:

/var

/tmp

/proc

............................................................................................

............................................................................................

............................................................................................

Q.2. Mention the main component of LINUX.

............................................................................................

Q.3. Write the two the advantage of Linux.

............................................................................................
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6.10 BASIC LINUX COMMANDS

Directory Handling Command :

ls (list) :

ls command is used to lists the contents of  the current working

directory.Also to list the hidden files  we can use:

ls -a

The output of the above command will show all  the files which

name starts with dot(.). In Linux hidden file names are prefixed  with

dots(.).

Some other options along with its functions are given below .

Options Purpose

ls  -x get multi-columnar output.

-r list files and sub-directories in reverse order

-t list files and sub-directories with time order.

-a list all files, including the normally hidden files

-c list files by inode modification time.

-i list the inode for each file.

-l display permission, owner, size, modification,

time ect along with file and directory names.

-h display names of hidden files

-q display filenames having non-printable

character.

mkdir (make directory) :

This command is used to create the directory. For example, to create

a directory data we can use as :

Syntax : mkdir data

pwd (print working directory) :

To find out the absolute pathname of the currently working directory

use the following command:

Syntax : pwd

cp (copy)

Syntax : cp file1 file2
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It makes a copy of file1 in the current working directory and calls it

file 2.

rm (remove), rmdir (remove directory) :

Syntax : rm test.c

rmdir software

rm command is used to delete a file (here test.c) and rmdir is used

to delete a directory (here software).

cd :

Syntax : cd test (where soft is a directory)

This command is used to change the directory.

Important Command :

cat (concatenate)

Syntax : cat hosts

The command cat can be used to display the contents of a file on

the screen.

less :

Syntax : less text1.txt

The command  less writes the contents of a file onto the screen a

page at a time.

head :

Syntax : head kkhsou.txt

The head command writes the first ten lines of a file to the screen.

tail :

Syntax : tail science.txt

The tail command writes the last ten lines of a file to the screen.

grep :

Syntaz : grep kkhsou text1.txt

It searches files for specified words or patterns.For example the

above command searches the word ‘kkhsou’ in ‘text1.txt’ files.

wc (word count) :

Syntax : wc -w text1.txt

wc -l text1.txt
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wc command  with -w  as shown in above  is used  to count number

of  words in a particular file. Also with –l  option in wc can be used to

count the number of  lines in a particular file.

who :
Syntax : who

madhu tyy01  03:45

The who command can also tell you who is logged in at the terminal

you're using.

date :
date
Tue Nov 4 13:39:24 EST 1997

This command is used to display the current date and time of the

system.

cal :
This command is used to see the calendar of any specific month, or

a complete year. If we wish to see the calendar for the month of

December of the current year, we can provide this as applying the

following cal command:

cal dec
December  2008

Su Mo Tu We Th Fr Sa

1 2 3 4 5 6

7 8 9 10 11 2 13

14 15 16 17 18 19 20

21 22 23 24 25 26 27

28 29 30 31

echo :
This command is used to display a message on the screen or to

display the content of a variable. For example,

echo “Well Come to KKHSOU”
To display the content of a variable, we can also use echo command.

time.

x = 30
echo $x
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passwd :

The passwd command is used to change passwords.Changing

password for sysadmin.

passwd  sysadmin

(current) UNIX password:

Enter new UNIX password:

Retype new UNIX password:

REDIRECTION : We use the > symbol to redirect the output of a

command. For example, to create  a file  kkhsou.txt with a list of

student name we  can use the following command:

cat > kkhsou.txt

(Then type the student name :)

Jitu

Gunajit

Sonabar

^D (Control D to stop)

The output of the above command is the successful creation of the

file kkhsou.txt with contents having student name  as typed above.

If we use the >> as:

cat >> kkhsou.txt

(and then type the name)

mukalmua

nalbari

^D (Control D to stop)

Then the content typed later is appended to the file kkhsou.txt. So

we can say >> appends standard output to a file.

In the previous section, we have described  the redirection of the

output  of a command to file.We can use  ‘<‘  to redirect the input to

a command. For example, if the file kkhsou.txt contains the following

content:

c

b

a
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the output of the command: sort < kkhsou.txt will be:

a

b

c

6.11 FILE PERMISSION

There are three types of file access: Read, Write and Execute. Each

file belongs to a specific user and group.Access to the files is controlled by

User, Group, and Other. The term, ‘other’, is used to refer to someone who

is not the user (owner) of the file, nor is the person a member of the group

the file belongs to.

There are 10 characters that are shown on the left that indicate type

and permissions of the file. File permissions are shown according to the

following syntax example : d rwe rwe rwe

There are a total of 10 characters

in all Linux files as seen in the above

example. The first character indicates the

type of file, and the next three indicate

Read, Write, and Execute permission for

each of the three user types, User, Group

and Other.
Fig. 6.4

Type as ‘ls -l’ in the terminal you can see like :

drwxrwxrwx 4 debajit grp1 122 Dec  1  18:02 kkhsou

-rw-rw-rw- 1 debajit grp1 1873 Aug 21 08:34 test

-rw-rw-rw- 1 debajit grp1 1234 Sep 14 11:13 data

last modification

date

Size in bytes file name

File’s Group

File’s Owner

Links

Fie type and permission field
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Type field : The first character in the field indicates a file type of one

of the following:

d = directory

l = symbolic link

s = socket

p = named pipe

– = regular file

c = character (unbuffered) device file special

b = block (buffered) device file special

Links : The number of directory entries that refer to the file. In this

example the number is  4.

Let us discuss chmod command which is used to change the

permission of a file or directory.

chmod : In order to change these default permissions and set your

own, chmod command is used. Only the owner of a file can change

the permission on that file.

The syntax of chmod is:

chmod   category   operation   permission   filename

Here the argument category specifies the user’s access. The argument

operation specifies whether the permission is to be granted or denied.

The argument permission specifies the type of permission.

The different values for these arguments are listed in the following

table :

Category Operation Permission

u (owner) + (assign) r (read)

g (group) – (deny) w (write)

o (other) = (absolute assignment) x (execute)

a (all)

Table : Values of chmod argument

In the first argument we supply one or more of a (all), u (owner), g

(group) and o(other). Then we specify whether we are adding right

(+) or taking them away (-). Finally we specify one or more od r

(read), w (write) and x (execute) permissions.
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The file permissions bits include an execute permission bit for file

owner, group and other. When the execute bit for the owner is set to

"s" the set user ID bit is set. This causes any persons or processes

that run the file to have access to system resources as though they

are the owner of the file.

Changing Ownership : There are two commands that can be used

to change the Some Examples:

ownership of a file or directory. These are:

(a) chown

(b) chgrp

For example, to grant the  ownership of a file test1 to John, we can

use:

$ chown  john  test1

The command chgrp changes the group ownership of the file. This

command , like chown, can only used by the owner of the file,

irrespective of whether the user belongs to the same group or not.

Some examples :

chmod +s kkhsou.txt

sets the user ID bit on the file "kkhsou.txt". The command:

chmod g+s kkhsou.txt

sets the group ID bit on the file "kkhsou.txt".

chmod u+x  kkhsou.doc

Gives the user execute permission on kkhsou.doc .

chmod +x  kkhsou.doc

Gives everyone execute permission on kkhsou.doc.

chmod ugo +x kkhsou.doc

Gives execute permission to user, group and other.

chmod 400  kkhsou.doc

Gives the user Read permission, and removes all other permission.

Permission is also denoted  by the numbers as mentioned below:

Read permission : 4

Write permission : 2

Execute permission :1
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chmod 764 kkhsou.doc

Gives user full access(4+2+1=7), Group Read and Write

access(4+2=6), and other Read access(4).

chmod 751 kkhsou.doc

Gives user full access(4+2+1=7), Group Read and Execute

permission(4+1=5), and other, Execute permission(1).

6.12 TEXT EDITOR vi:

The vi editor is a screen-based editor and it is  the most powerful

text editor available in almost all UNIX and LINUX systems. The vi  editor

has powerful features to aid programmers, but many newvies avoid using

the different features that overwhelm them. Operating vi editor is entirely

different from that of any modern simplified editor that you are familiar with.

This editor has remarkable editing capabilities. It is rather a very simple

editor, if all the elementary vi commands are at your finger tips.

LINUX features a number of vi editors, of which vim (vi improved) is

the most common. Apart from vim, there are xvi, nvi and elvis which have

certain exclusive functios not found in the Berkeley version.

Three Modes : The three modes of vi editor are:

(a) Command Mode

(b) Input Mode

(c) Ex Mode

Command Mode : Command Mode is the mode where you will be

giving commands to the vi editor. When you invoke vi, this is the mode

where you will be placed initially.

Input Mode : When you give the commands i, I, a , A, R, s, S, or O

then you get shifted to the input mode of vi editor. It is also known as insert

mode or editing mode. In this mode you can add text to the file. For example,

when you want to insert text at the current cursor position, give i in the

command mode. you will now get placed in the input mode and you can

perform the intended mode. For example, if you type ‘a’ here it will not be

interpreted as an ‘append’ command, but as character ‘a’ to be inserted in

the file.To move back to command mode press Esc key.
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Ex Mode : Ex mode of vi editor enable us to give commands at the

command line. To move to the ex mode, press ‘:’(colon) if we are in command

mode. If we are in the input mode, forst press Esc key and then press’:’ to

move to the ex mode. Cursor moves to the bottom of the vi screen and we

can provide the ex mode commands here. Some impotant and common ex

mode commands are given below:

Command Used to

w save the change we have made to the file

q quit vi without saving changes

wq save and quit

q! force quit if’q’ does nor work

Ex mode is named after the ex line-editor of UNIX or LINUX. The

commands we give the ex mode are actually the ex line-editor’s commands.

Invoking vi Editor :

$  vi test1

The file ‘test1” will get opened in vi editor. If the file does not exist, vi

will create a new file with that name. In  either case we will see a screen full

of the tilde’~’ which indicates empty lines.

Remember that vi editor opens in the command mode. That means

we are now in the command mode.Let us started by inserting some text in

our file “test1”. For that we will have to switch to the ‘input mode’ . We can

see that to insert text ‘i’ command is used. Press ‘i’ and type the following

text.

Saving Text and Quitting vi Editor : Having inserted the text, we

now need to save these changes. To save the changes first press Esc key

to move to command mode. Now press ‘:’ to move to ex mode. Note that

now the cursor has moved to the end of the screen. Type ‘w’ to save changes.

If we want to quit vi type ‘q’. We can also save and quit vi in one go by

giving the command ‘wq’.

Note : We can also save the file in the command mode by presenting

Z (uppercase) twice, i.e ZZ.

When we quit vi, a note at the bottom of the screen indicates the

name , number of lines and number of character in the file.
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Editing File in vi : Invoke again the vi editor, by typing vi test1 at

the command prompt. We will see the text we have typed followed by multiple

empty lines, each starting with a ‘~’ sign. The cursor appears at the beginning

of the first line of the file. Let us first learn how we can move this cursor to

a particular line or character.

Adding Text : Let us now append some text to the file. For this first

move cursor to the last line of the file. Pressing ‘G’(uppercase) will move

the cursor to the beginning of the last line in the file. Additionally, you can

precede ‘G’ with the line number where we want the cursor to move. For

example , to move to 6th line then we type ‘6G’.

We can move to the beginning of a file by pressing ‘1G’. Now press

‘o’ to open a new line below this last line. By pressing ‘o’ we are in the ‘input

mode’.

Inserting Text in The Middle : If we missed any character(s) while

typing, then move the cursor to that particular line or word. Press Esc key

to move to the ‘command mode’. Now press ‘i’ to insert the character(s)

before the current cursor position or press ‘a’ to insert the character (s)

after the current cursor position. ‘A’ will append text at the end of current line.

Replacing Text : Text character can be replaced with the ‘r’, ‘R’, ‘s’

and ‘S’ commands. Before we use these commands switch to the command

mode, if we are currently in the insert mode.

First move the cursor to the character which we want to replace.

Pressing ‘r’ followed by a character replaces the existing character with the

character given after ‘r’.

To replace more than one character use ‘R’ followed by the

characters. The existing text will get overwritten with these characters.The

replacment of text with ‘R’ command is limited to the current line only.

To replace a character with multiple characters without overwriting

the subsequent text, use ‘s’ followed by the characters. ‘S’(uppercase)

replaces the entire line irrespective of the cursor position. That menas, it

deletes the current line completely and makes it ready for a new line of

text.Pressing ‘R’, ‘s’ and ‘S’ shifts you to the ‘input mode’. Press Esc key to

move back to the command mode.

LINUX Operating System Unit 6



Computer Fundamentals and PC Software142

Deleting Text : To delete a character, first move the cursor to that

particular character position. Press ‘x’ to delete a single character. We can

also precede ‘x’ with the number of characters we want to delete. For

example, ‘4x’ will delete four characters. Note that the rest of the line gets

adjusted automatically.

If we go on deleting all the characters in the current line, the

characters to the left of the current line starts getting deleted, instead of

that in the next line.

Note : To delete the current line press ‘dd’ . To delete more than one

line use ‘#dd’, where # represents the number of lines we want ot delete.

‘X’ (uppercase) is used to delete a character to the left of current

cursor position. To understand it better, it can be said that ‘x’ functions like

the delete key and ‘X’ funtion like the Backspace key.

Undoing and Repeating Commands : The repeat command (a

dot(.)) can be used to repeat the most recent command. For example, if we

have recently given the ‘a’ command and appended one character, we can

repeat the whole process again by pressing a . (dot). We will have the

character inserted two times.

The undo (u) command can be used to recover from the most

recently committed mistake. For example , press u and we will see that the

second character we have inserted using  disappears.

Let us now save our file and quit vi editor, Rememeber to press Esc

key to switch to command mode if you are not in it already and then use :wq

to save the file and quit vi.

CHECK YOUR PROGRESS

Q.4. Hidden files in LINUX can be listed using

a. ls -t b. ls -h c. ls -a d. none of the above.

Q.5. In LINUX, the command to delete all files started with sg

and ending with hj is

a. rm sg*hj b. rm sg?hj

c. rm -prefix sg -suffix hj c. none of the above.
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Q.6. The LINUX command rm -r project will

a. delete the file project from the current directory.

b. delete all the files from the directory project and all its

subdirectories.

c. recursively delete the directory project and all its

subdirectories.

d. None of the above.

Q.7. UNIX can have

a. one file system only.

b. n file systems, if it had n hard disks.

c. any number of file systems depending upon the number

of partitions.

d. none of the above.

Q.8. The UNIX command “ls | more”  displays a list of

a. files in the current directory one line at a time.

b. files in the current directory one screen time

c. all the files in the current directory and then wait for the

next command

d. none of the above.

Q.9. The UNIX ,full pathname originates from

a. your home directory b. the root directory

c. your working directory d. none of the above.

Q.10. The chmod command in UNIX

a. change the current execution status from user mode to

kernel.

b. makes the file hidden so that it cannot be seen using the

ls command.

c. changes the access permissions of a fileor directory.

d. none of the above.

Q.11. Which out of the following commands would you use to

change your password in UNIX system.

a. pass b. passwd

c. chpass d. setpass
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Q.12. The execute permission to a file allows a user to

a. execute the file b. edit the file

c. list the contents of the file d. none of the above.

Q.13. The chown command in UNIX changes the

a. home directory of a user

b. access permissions of a file or directory

c. priority of  a process.

d. none of the above.

Q.14. Find out the TRUE and FALSE statements

i. The command pwd shows the name of the current

directory.

ii. UNIX makes a distinction between the text files and the

binary files.

iii. The command mv file1 file2 renames file1 as file2.

iv. The more command appends new lines to a file.

v. A binary file is also known as an ASCII file.

vi. The command rm * removes all files from the current

directory.

vii. A file having protection 466 cannot be used by anybody

other than the owner.

viii. Only the super user can view the passwordof a user in

the file /etc/passwd file.

ix. chmod u-x gives the user permission for execution.

x. ls command is used to list the files and directories.

6.13 LET US SUM UP

 Linux Command : A command given to UNIX or LINUX is a series

of characters that one type. These characters consist of words

separated by white spaces. The first word is the command itself

and the rest are the command’s arguments. The arguments provide

information that the command may need for its execution.
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 Internal commands :  Internal commands are such programs that

are built-in into the operating system and reside in the memory along

with the kernel.

 External commands : External commands are not built in into the

operating system, but loaded from other program files.

 To create a new directory, use the mkdir command.

 You can change the working directory using the cd command

 The command rmdir followed by the directory name which is to be

removed is used for deleting a directory.

 To list the names of the files and the sub -directories of the current

directory, ls command is used. its function is equivalent to the DIR

command in MS-DOS.

 To find which directory you're currently in, use the pwd (print work

ing directory) command.

 To create a file, type the command cat at the shell prompt, followed

by a > character and the filename.

 A file can be shifted or moved from one directory to another by

using the mv command.

 The command cp is used to copy a file into another. MS-DOS

equivalent for cp is ths COPY command.

 more command allows us to view the output one screen at a time.

 The who command can also tell you who is logged in at the terminal

you're using.

 The passwd command is used to change passwords

 File and directory permissions fall into three main divisions. These

are Read permission (r), Write permission (w), Execute permission

(x)

 In order to change these default permissions and set your own,

chmod command is used.

 There are two commands that can be used to change the own -

ership of a file or directory. These are:

(a) chown

(b) chgrp
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6.14 ANSWERS TO CHECK YOUR PROGRESS

Ans. to Q. No. 1 : /var: this folder contains those file that change

frequently.

/tmp : contains temporary files that are erased upon

reboot.

/proc: This folder contains information about the Linux

kernel and hardware that is updated in realtim

Ans. to Q. No. 2 : Main components are Kernel, Shell and programs

Ans. to Q. No. 3 : Free Cost, Multi User Interface Supported and Good

Security,

Ans. to Q. No. 4 : (c)

Ans. to Q. No. 5 : (a)

Ans. to Q. No. 6 : (c)

Ans. to Q. No. 7 : (c)

Ans. to Q. No. 8 : (b)

Ans. to Q. No. 9 : (b)

Ans. to Q. No. 10 : (c)

Ans. to Q. No. 11 : (b)

Ans. to Q. No. 12 : (a)

Ans. to Q. No. 13 : (d)

Ans. to Q. No. 14 : i. (T), ii. (F), iii. (T), iv. (F), v. (F), vi. (T), vii. (F),

viii. (F), ix. ( F), x. (T).

6.15 FURTHER READINGS

 UNIX concept & Applications, Sumitabha Das,  TATA McGRAW HILL.

 Operating System Design and Implementation, Andrew S.

Tanenbaum, Albert S. Woodhull, Prentice - Hall India.
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6.16 MODEL QUESTIONS

Q.1. What is the difference between cp and mv commands? Explain

with an example.

Q.2. Distinguish between:

(a) cat and more commands

(b) tail and head command

Q.3. List out the different options and significance of ls.

Q.4. A file has got a protection 756 (octal). What protections does it really

have ?

Q.5. Explain how you can implemente  the cut, copy and paste operations

in vi .

Q.6. Give the syntax for opening a file in vi editor. Also explain the different

options.

Q.7. How can you access ex commands in vi?

Q.8. Explain the booting process of Linux?

Q.9. What do you mean by Open Source and Free Software?

Q.10. Write two advantages of Linux?
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UNIT 7 : MICROSOFT WORD-PART I

UNIT STRUCTURE

7.1 Learning Objectives

7.2 Introduction

7.3 Starting MS Word

7.4 Document Window and its Components

7.4.1 The Title Bar

7.4.2 The Menu Bar

7.4.3 The Ruler

7.4.4 The Status Bar

7.4.5 The Text Area

7.4.5 The Toolbars

7.5 Document View

7.6 Creating a New Document

7.7 Saving a Document

7.8 Opening an Existing Document

7.9 Exiting MS-Word

7.10 Working with Text

7.10.1 Erasing Text

7.10.2 Inserting Text

7.10.3 Overtyping Text

7.10.4 Highlighting Text

7.10.5 Formatting Text

7.11 Working with Paragraph

7.12 Adding Bullets and Numbers

7.13 Find and Replace Option

7.14 Cut, Copy and Paste

7.15 Let Us Sum Up

7.16 Further Readings

7.17 Answers to Check Your Progress

7.18 Model Questions
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7.1 LEARNING  OBJECTIVES

After  going through this unit, you will be able to:

 learn about MS-word

 create, save and print Word documents

 view an existing document

 open and close a new document

 learn about different bars of document window

 learn about formatting text

 work with paragraph

 include bullets and numbering

 learn about copy, cut, and paste

 find the mistakes and replace them with the appropriate words.

7.2 INTRODUCTION

Word Processor is a software package that enables us to create,

edit, print and save documents for future retrieval and reference. Creating

a document means typing by using a keyboard and saving it. Editing a

document involves correcting the spelling mistakes, if any, deleting or moving

words sentences or paragraphs.

In this unit, we will learn about a most commonly used word

processing software, Microsoft Word which works in Windows operating

system. Microsoft Word also known as MS-Word was developed by

Microsoft. Microsoft introduced MS-Word in Microsoft Office Program along

with other application programs. There are different versions of Microsoft

Office like MS-Office. This unit will introduce learners with the basics of

MS-Word 2003.   Microsoft Word is a powerful tool which helps us to create

documents like application forms, office letter, reports, resume writing,  etc.

With this unit, learners will also be acquainted with the method of inserting

hyperlink, images, tables etc. to make their documents more attractive and

understandable.
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7.3 STARTING MS-WORD

While working in MS-Word, we can use a mouse. One can also

work, to some extent, through the keyboard. The use of mouse is slightly

simpler as it is fully menu driven.

There are two ways to open MS-Word.

1. We can start Microsoft-word by clicking left mouse button on

Start  Programs  Microsoft Word as shown in the following

screenshort:

Fig. 7.1 : Way to open MS Word through Programs

2. If a shortcut of MS-Word already exists in the desktop, the Double

click on the Microsoft Word icon on the desktop.

Fig. 7.2 : MS-Word 2003 shortcut icon
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7.4 DOCUMENT WINDOW AND ITS COMPONENTS

When we start MS-Word, a new document window appears on the

screen as shown in Fig.7.3.  There are many components of Document

Window. Some of them are: title bar, menu bar, ruler bar, status bar, toolbars,

text area etc.

Fig. 7.3 : Document Window

7.4.1 The Title Bar

The Title bar displays a number of items about the currently

active document. It displays the title of the document on which we

are currently working. Word names the first new document we open

Document1. As we open additional new documents, Word names

them sequentially. When we save our document, we assign the

document a new name. Title bar also contains Minimize button,

Maximize/Restore button, and Close button.

Fig. 7.4 : The Title Bar

7.4.2 The Menu Bar

The Menu bar is generally found directly below the Title bar. The

Menu bar displays the menu. Menu bar consists of nine drop-down
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menues. Those are: File, Edit, View, Insert, Format, Tools, Table,

Window, and Help. With the help of these menues, different functions

can be performed like mail our document, use styling of text, insert

picture, save our document etc.  We can point with the mouse to a

menu option and click the left mouse button to open a drop-down

menu. We can then use the left and right arrow keys on the keyboard

connected to or computer to move left and right across the Menu

bar options. We can use the up and down arrow keys to move up

and down the drop-down menu.

Fig. 7.5 : The Menu Bar

A right arrow after a menu item signifies additional options as

shown in the following screenshot (Fig.7.6); if we select that menu

item, another submenu appears.

Fig. 7.6 : The View menu showing right arrow & submenu
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7.4.3 The Ruler

Ruler allows us to format the vertical alignment of text in a

document. If the ruler is not visible, we can select the Ruler option

from the View menu to display the ruler.

Fig. 7.7 : Ruler Bar

7.4.4 The Status Bar

Status bar shows the information about the current document

on which we are working. It provides information like page number,

line number, the number of words in our document etc. It appears at

the very bottom of our document window.

Fig. 7.8 : The Status Bar

7.4.5 The Text Area

The text area also known as workplace is the area in the

document window where we enter the text. In Fig.7.3, the cursor,

the vertical and horizontal scroll bar are labelled. The cursor marks

the insertion point. As we type, our text displays at the cursor location.

The vertical and horizontal scroll bars enable us to move up, down,

and across our window simply by dragging the icon located on the

scroll bar. We will not be able to see a horizontal scroll bar if the

width of our document fits in our screen. To move up and down our

document, we can click and drag the vertical scroll bar up and down.

Again, to move back and forth across our document, we can click

and drag the horizontal scroll bar back and forth.

7.4.6 The Toolbars

Toolbar contain buttons, drop-down menus and other controls.

These are just the shortcuts to the menu items in the Menu bar. The
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most commonly used toolbars are :

 standard toolbar

 formatting toolbar

If our document window is not showing the toolbars as shown

below (Fig. 7.9) then we can view them by clicking the View menu

and then selecting  the Standard and Formatting options from the

Toolbars submenu. This process is shown in Fig. 7.10.

Fig. 7.9 : Document window without showing the toolbars

Fig. 7.10 : Document window with the View menu and Toolbars option

Standard Toolbar : Standard toolbar provides shortcuts for menu

items. The left of the toolbar enables us to perform tasks common

to many windows-based operations, such as opening a new file or

existing file, saving or printing files, cutting and pasting of text, and

undoing and redoing the most recent actions. The right of the

standard toolbar offers some functions more specific to word

application.
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Fig. 7.11 : The Standard Toolbar

The buttons of standard toolbar with a brief description is listed

below:

New Blank document : Opens a new Word document.

Open : Opens an existing saved Word document.

Save : Saves the current document.

E-mail : Sends the contents of the document as the body of the

e-mail message.

Print : Open the print dialog box.

Print Preview : Shows how a file will look when we  print it.

Spelling and Grammar : Starts the spell check functions.

Cut : Places selected text on the Windows Clipboard.

Copy : Places a copy of selected text on the Windows Clipboard.

Paste : Pastes the contents of the Clipboard on the document.

Format Painter : Enables us to copy formatting from one object

to another.

Undo : undoes the last action.

Redo : redoes the last undone action.

Insert hyperlink : Inserts a link to a WWW site on the document.

Web Toolbar : displays the Web toolbar.

Insert Table : Inserts a word at the insertion point.

Insert Microsoft Excel Worksheet : Inserts an Excel worksheet

with Excel tools available for editing.

Tables and Borders : Inserts a table and Borders toolbar.

Columns : Changes the number of columns in a document.

Drawing : Displays or hides the Drawing toolbar.

Document Map : Turns on or off Document map.

Show/Hide : Displays nonprinting characters such as tab

characters, paragraph marks and hidden text.

Zoom : Allows you to zoom in or out to make the document

screen larger or smaller.
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Microsoft Office Word Help : Opens the Office Assistant or

Help.

Formatting Toolbar : The Formatting Toolbar contain tools that

are common to windows programs and related to formatting of text

in documents. This includes changing document style, font, font

type, color, paragraph alignments, borders etc.

Fig. 7.12 : The Formatting Toolbar

The names and functions of Formatting Toolbar are as follows:

Style : Opens a drop-down list for selection of style.

Font : Opens a drop-down list for selection of font.

Font Size : allows you to enter a new size for the selected text.

Bold : Toggles the text from bold to normal text.

Italic : Toggles the text from italic to normal text.

Underline : Underline the text.

Shadow : Applies a shadow effect to the selected text.

Left Alignment : Aligns selected text to the left.

Center Alignments : Aligns selected text to the center.

Justify : Aligns selected text at the left and right margins or

indents.

Right Alignment : Aligns selected text to the right.

Numbering : Applies a numbering format to selected text.

Bullets : Applies a bullet list format to selected text.

Increase Indent : Increases spacing between selected lines of

the text.

Decrease Indent : Decrease spacing between selected lines of

the text.

Outside Border : Add or Remove a border around the selected

text, paragraphs, pictures etc.

Highlight : Marks text so that it is highlighted.

Font Color : Formats the selected text with the color you click.
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7.5 DOCUMENT VIEW

There are five views in MS-Word to display our document, which

are: Normal, Web Layout, Reading Layout, Online Layout and Print Layout.

Let us describe each of these views briefly.

Normal View : Normal view is used most often and shows formatting

such as line spacing, font, point size, and italics.

Web Layout : Web layout view enables us to view our document as

it would appear in a browser like Internet Explorer.

Reading Layout : Reading Layout view formats our screen to make

reading our document more comfortable.

Outline View : Outline view displays the document in outline form.

Headings can be displayed without the text. If we move a heading, the

accompanying text moves with it.

Print Layout : The Print Layout view displays the document as it

will look when it is printed.

7.6 CREATING A  NEW DOCUMENT

We can create personal as well as professional documents with the

help of MS-Word. We can type a document with the help of keyboard and

save it to the hard disk of our system. Following are the steps to create our

own document.

 Select the New option from File menu of the Menu bar.

 A dialog box appears on the right of the screen as shown in

Fig.7.13. It shows different type of document we can create like

Blank document, XML document, Web page and E-mail message

etc.

 Click on Blank document link.

 A new blank document will be displayed.
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Fig. 7.13

7.7 SAVING  A DOCUMENT

We need to store the document we created on the disk so that it can

be used whenever required. Following are the steps for this process:

 Select the Save option from the File menu of the Menu bar.

 Enter a filename in the File name box and click on the Save

button.

The first and second steps are depicted in Fig. 7.14 and Fig.7.15

respectively.  In Fig.7.15, we can see that the file is saved with a file name

"education" in the My Documents folder. There are another two methods

for saving a newly created file. Those are:

 Keyboard shortcut: Ctrl + S

 Clicking the save  button from the Standard tool bar.

By default, the new document is saved as Word document with the

extension “.doc”. In the higher version of MS-Office like Windows 2007/

2010, the default MS-Word file extension is ".docx".
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Fig. 7.14 :  File Menu with showing the Save option

Fig. 7.15 :  File Menu with showing the Save  option

7.8 OPENING  AN  EXISTING  DOCUMENT

In MS-Word, we can open any existing or previously saved

documents for alteration or reading purpose. For opening an existing

document or file, we have to:

 select the Open option from the File menu of the Menu bar.

 select the appropriate drive and folder.

 double click on the desired filename to open the document.

The keyboard shortcut for opening an existing document is Ctrl+O.
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7.9 EXITING MS-WORD

To exit MS-Word, we have to:

 click  on File menu

 click Exit, which can be found at the bottom of the drop-down

File menu.

If we have already entered text then we will be prompted with a

message like  “Do you want to save changes to Document1?” If we want to

save,  then we have to click on Yes, otherwise, we have to click on No. We

have to specify the correct folder in the Save As box as discussed earlier.

LET US KNOW

During the unit, you will be asked to “click” items. When asked to

click:

 Point to the item.

 Press your left mouse button once.

If you are asked to double-click an item :

 Point to the item.

 Quickly press your left mouse button twice.

If you are asked to right-click:

 Point to the item.

 Press your right mouse button.

CHECK YOUR PROGRESS

Q.1. How do you select text in MS-Word?

............................................................................................

............................................................................................

Q.2. How do you close MS-Word current document?

............................................................................................

............................................................................................
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Q.3. How do you exit MS-Word?

............................................................................................

Q.4. Fill in the blanks:

(i) The name of the first document in MS-Word is ________.

(ii) The extension name of MS-Word 2003 and MS-Word

2007 documents are __________  and __________

respectively.

(iii) __________ shows how a file will look when we  print it.

(iv) __________ bar consists of __________ drop-down

menues.

(v) To view standard toolbar, we have to click __________

menu and then ___________ option from the Toolbars

submenu.

Q.5. Choose the correct option:

(i) The keyboard shortcut to save a file is

(a) Ctrl+S (b) Alt+F5

(c) Ctrl+V (d) Alt+S

(ii) The keyboard shortcut for opening an existing document

is

(a) Ctrl+D (b) Alt+O

(c) Ctrl+O (d) Alt+F6

(iii) The keyboard shortcut for selecting all contents of a

document

(a) Ctrl+S (b) Ctrl+A

(c) Ctrl+F2 (d) Ctrl+O

7.10 WORKING WITH TEXT

To enter text into a file in MS-Word, we simply type just as we would

if we were using a typewriter. To capitalize, we have to hold down the Shift

key while typing the letter. We do not need to press Enter key to start a new

line; Ms-Word automatically wraps at the end of the line. To start a new

parapraph, we have to press Enter key.
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7.10.1 Erasing Text

Using the Backspace Key : The Backspace key erases text

before the cursor position. On one press on the Backspace Key,

only one letter is erased. Let us consider the following example:

Example 1 :

1. Type the text : State Open University

2. Suppose you have to erase the word “University”. Now using

either the arrow keys or the mouse, place the cursor after the

letter “y” in “University”

3. Press the Backspace key until the word “University” is erased.

4. After erasing the word University, the sentence will be:

State Open

Using the Delete Key : The Delete key erases text after the

cursor position. On one press on the Delete key, only one letter is

erased. Let us consider the following example:

Example 2 :

1. Type the following text:

Indira Grandhi National Open University

2. Suppose you have to erase the word “Indira Gandhi”. Now using

either the arrow keys or the mouse, place the cursor below the

letter “I” in “Indira Gandhi”

3. Press the Delete key until the word “Indira Gandhi” is deleted.

4. The resulting text will be : National Open University

We can also erase text by highlighting the text to be erased and

then either pressing the Backspace key or the Delete key only once.

7.10.2 Inserting Text

To insert text, we must be in the Insert Mode. To check to see

whether we are in the Insert Mode, we can look at the right side of

the Status Bar. If the word “OVR” is gray, we are in the Insert Mode.

If the word “OVR” is black, we are in the Overtype Mode.
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Insert Mode

Overtype Mode

To change to the Insert Mode, we have to :

 double click the word “OVR”. The word “OVR” is now gray.

Or

 press the Insert key (or Ins key) in the keyboard.

Example 3 : Let us type the following sentence:

Indira National Open University.

Make sure the word “OVR” is gray before proceeding. Let us

insert the word  “Gandhi” between the words “Indira” and “National”:

1. Place the cursor after the word “Indira”.

2. Type the word “Gandhi”.

3. Press the Spacebar to add a space.

4. The sentence will be:

Indira Gandhi National Open University.

7.10.3 Overtyping Text

We can type over the current text (replace the current text with

new text). However, we must be in the Overtype Mode. We have to

do the following to change to the Overtype Mode.

1. Double Click “OVR” on the Status Bar.

2. The word “OVR” should now be black.

Make sure the word “OVR” is black before proceeding to the

following exercise.

Example 4 : Type the following sentence :

Faculty of Science

Now, Change the word “Science” to “Commerce”
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1. Place the cursor before the letter “S” in “Science’’

2. Type the word “Commerce”.

3. It should now read :

Faculty of Commerce

7.10.4 Highlighting Text

Throughout these units, weou will be asked to highlight  text.

We can use either of the following methods:

Highlighting by Using Arrow Keys :

For this, we have to :

1. place the cursor before or after the text we wish to highlight and

click the left mouse button.

2. press the appropriate arrow key (left arrow to move to the left or

right arrow to move to the right) until the text is highlighted. We

can use the up or down arrow key to highlight one line at a time.

Highlighting by Using the Mouse :

For this, we have to :

1. place the cursor before or after the text we wish to highlight.

2. hold down the left mouse button.

3. move the mouse left, right, up, or down until the text is highlighted.

7.10.4 Formatting Text

Formatting a document involves assigning fonts and font sizes,

aligning text, changing color of the text, paragraph specing, setting

margins etc. By selecting different menu options from Menu bars

and Toolbar buttons, we can format our documents.

Applying Fonts and Font Styles : Fonts refer to the manner or

style in which text is displayed in the document. MS-Word offers

large number of fonts styles like Arial, Arial Black, Times New Roman,

Impact, etc. For applying new styles to our text, first we have to

select text that we want to be formatted. For changing fonts and

font styles, we have to:
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 click on the Font option of the Formatting tool bar, a drop-

down list will appear on our window as depicted in Fig. 7.16.

 type the name of the desired font directly or select an option

from the drop-down list and press Enter key.

Fig. 7.16 : Window showing Formatting tool bar with Font option

Changing Font Size : Font size is measured in points. Points

and picas are used for measuring spacing, lines, and thickness and

so on. There are 12 points to a pica and six picas to an inch; therefore

there are 72 points to an inch. To change font size, we have to:

 use the drop-down list of Font Size on the Formatting toolbar.

 type the font size or select a font size from drop-down list and

press Enter key.

Fig. 7.17 : Formatting toolbar showing different options

increase/decrease
indent

Font menu

style menu font size left center right
justify alighment

highlight
color

numbered and
bulleted list

Bold, Italic,
Underline

font
color

outside
border
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 Bold, Underline and Italicize Text : If we want to make Bold,

Italic and Underline our text, first we have to select the text and

then directly click Bold , Italics , Underline 

options of the Formatting toolbar. In other way, we can click

on the bold option and type the text. Similarly, we can select

Italic and Underline button. The keyboard shortcuts for making

bold, italics and underline text are  Ctrl+B, Ctrl+I and Ctrl+U

respectively.

The other options of formatting toolsbars shown in Fig. 7.17 are

discussed below:

 Allignment : This option is used to align text to the left,center or

right side of the page or it can be justified across the page.

 Numbered and Bulleted Lists : This option is used to add

numbers or bullets to the highlighted text.

 Increase/Decrease Indent : This option is used to change the

indentation of a paragraph in relation to the size of the page.

 Outside Boarder : When this option is used, it adds a border

around a text selection.

 Highlight Color : This option is used to change the color behind

a text selection. The color displayed on the button is not the

default color but it is the last color used. To change a different

color we have to click on the drop-down arrowhead. It will display

the available colors. We have to select the color of our choice.

 Text Color : This option is used to change the color of the text.

The color displayed on the button is the last color used. We

have to click the drop-down arrowhead to select another color.

Alternatively we can use Font dialog box (Fig. 7.18) which appear

when we click Font option of Format menu to change font size,

fonts and font styles. To give specific color to the text, we have to

select the font color from the Font color drop-down menu. The

default font color is black. We can also specify different effects to

the text by selecting the Effects that we want to add to the text by
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clicking on the checkbox in the Effects box. The Preview box at the

bottom displays the specified changes that we have made to our

text. To save the modifications that have been made in the text, we

have to press the OK button.

Fig. 7.18 : Font dialog box

7.11 WORKING WITH PARAGRAPH

In this section we will learn various ways to arrange a paragraph. In

MS-Word, whenever we press the Enter key, we create a new paragraph.

When we open a new document, the default paragraph setting stored as a

style is applied. When we are formatting a paragraph, we do not need to

highlight the entire paragraph. Placing the cursor anywhere in the paragraph

enables us to format it. After we set a paragraph format, subsequent

paragraphs will have the same format unless we change their format.
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Line Spacing : Spacing is used to design our document and make

it more readable. Line Spacing sets the amount of space between lines

within a paragraph.The default setting of spacing is single. Word enables

us to change the line spacing in our text. We can set spacing to single,

double or one and half lines. To set the line spacing, we have to follow the

following steps:

Fig. 7.19 : The Paragraph dialog box

 select the Paragraph option on the Format menu. The

Paragraph dialog box gets invoked as displayed in the Fig. 7.19.

 select the Indents and spacing tab

 select an option from the Line spacing drop-down list.

 select the value from the At list box.

 click on the OK button to close the dialog box

At 1.5 lines, the Line Spacing is set to one-and-a-half times the

single-space amount. For double-spaced lines, the line spacing is set to
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two times the single-space amount. We can define white space placed

before and after paragraphs by giving values in the spacing area of

Paragraph dialog box.

Indenting Text : Indentation allows us to indent a paragraph from

the left or right margin. Indents are added to margins thereby increasing

the white space and decreasing the text area for specific paragraphs. To

set the Indents for text by using paragraph dialog box:

 Enter the specification for left, right and first line indents in the

indentation area of Paragraph dialog box.

 Select an option from the drop-down list.

 Click n the OK button.

In the Paragraph dialogue box, Spacing Before specifies how much

space to leave before the paragraph. Spacing After specifies how much

space to leave after the paragraph. Line Spacing sets the space between

lines within a paragraph. One can type a paragraph of text and see the

effect of Spacing Before, Spacing  After, and Line Spacing by performing

the following steps.

 Highlight the paragraph or place the cursor anywhere in the

paragraph.

 Choose Paragraph from Format menu.

 Type 1" in the Left field.

 Type 1" in the Right field.

 Click OK.

The paragraph will be indented one inch from both the left and right.

Alignment of Text in a Paragraph : Alignment is the way of

organizing the text. It refers to the position of the text relative to margins. It

enables us to left-align, right-align, center-align and justify the text in

our document. The default alignment in MS-Word  is left alignment.

 Right-Aligned Text:  If the text is aligned with the right margin of

the page then it is said to be right-aligned.

 Left-Aligned Text: If the text is aligned with the left margin of the

page then it is said to be left-aligned. The default alignment for

MS Word is.
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 Center-Aligned Text: If the text is aligned to the center of the

page then it is said to be center-aligned.

 Justified: This feature aligns a paragraph both the left and the

right margins.

The following screenshot (Fig.7.20) shows all the above alignement

options.

Fig. 7.20 : Allignment of paragraph showing four types of allignments

CHECK  YOUR  PROGRESS

Q.6. Fill in the blanks :

(i) To delete a letter just before the cursor position in a single

step, we have to press __________ key.
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(ii) To delete a letter above the cursor position, just press

__________ key.

(iii) To insert text, we must be in the __________ mode.

(iv) Font Size is a __________ toolbar option.

(v) Bold,Italics and Underline options are present in

__________ toolbar.

(vi) The default font color is __________.

Q.7. Write T for True and F for False :

(i) Highlight color option is used to change the color behind

a text selection

(ii) Outside Boarder option is used to remove a border

around a text selection

(iii) Indent and Spacing tab is present in paragraph dialog

box.

(iv) Right is default alignment for MS Word.

7.12 ADDING BULLETS AND NUMBERS

Bullets and Number highlight the portion of a text we want to highlight.

We can use bullets and numbers to make the lists and it is easy to read. For

this, we have to:

 select the text before adding bullets and numbers.

 select the "Bullets and Numbering" options of the Format

menu. The Bullets and Numbering dialog box get invoked shown

in Fig. 7.21.

 click on the Bulleted tab in the Bullet and Numbering dialog

box.

 click to select a style of your choice.

 click on OK
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Fig. 7. 21 : Bullets and Numbering dialog box

Alternatively, we can also click on the Bullets and Numbering

options of the Formatting toolbar. We can also change the predefined

specifications for bullets and numbering by using Customize option in the

"Bullets and Numbering" dialog box. A few examples of numbered and

bulleted list is given below :

1. CCA I. CCA i. CCA
2. BCA II. BCA ii. BCA
3. PGDCA III. PGDCA iii. PGDCA
4. MCA IV. MCA iv. MCA

a. CCA a) CCA A. CCA
b. BCA b) BCA B. BCA
c. PGDCA c) PGDCA C. PGDCA
d. MCA d) MCA D. MCA

 Physics  Physics  Physics
 Chemistry  Chemistry  Mathematics
 Botany  Botany  Botany
 Zoology  Zoology  Zoology
 Statistics  Statistics  Statistics
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7.13 FIND  AND  REPLACE  OPTION

In MS-Word, we can search for text, special character and other

document items. We can also replace the searched items with a specified

item.

For finding text, we have to:

 click the Find option from the Edit menu. The Find and Replace

dialog box gets invoked as shown in Fig.7.22.

 enter the text in the Find what box.

 click on the Find Next option of the Find and Replace dialog

box to find the position of the text being searched.

The keyboard shortcut for finding text is Ctrl+F.

Fig. 7.22 : Find and Replace dialog box showing Find tab

For replacing text, we have to :

 select the Replace option from the Edit menu. The Find and

Replace dialog box as shown in Fig. 7.23 gets invoked.

 select the Replace tab.

 enter the text to be replaced in the Find what box of the dialog

box.

 enter the text to be replaced with in the Replace with text box.

 click on the Find Next button of the Find dialog box to start the

search.

 click on the replace button to replace the highlighted text with in

text in the Replace with box.

The keyboard shortcut for replacing text is Ctrl+H.
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Fig. 7.23 : Find and Replace dialog box showing Replace tab

7.14 CUT, COPY  AND  PASTE

In MS-Word, we can cut (delete) text from one area of a document

and save that text so that it can be pasted elsewhere in the document.

When we cut  a text, it is stored on the Clipboard. We can also copy text.

When we copy text, it is also stored on the Clipboard. Information stored on

the Clipboard stays there until new information is either cut or copied. Each

time we execute Cut or Copy, we replace the old information on the Clipboard

with whatever we just cut or copied.

Cut and Paste :

Cut - using Menu

Select the content that you want to delete

Click Edit menu and then choose Cut from the menu.

Paste - using Menu

Place the cursor where you want to paste the deleted content.

Click Edit menu and then choose Paste from the menu.

Cut - using Icon 

Select the content that you want to delete

Click the Cut icon from the Standard toolbar.

Paste - using Icon 

Place the cursor where you want to paste the deleted content.

Click the Paste icon from the Standard toolbar .
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Cut - using Keyboard shortcut

Select the content that you want to delete

Press Ctrl + X

Paste - using Keyboard shortcut

Place the cursor where you want to paste the deleted content.

Press Ctrl+ V

Copy and Paste : In Microsoft Word, we can copy text from one

area of the document and place that text elsewhere in the document. As

with cut data, copied data is stored on the Clipboard.

We can copy the text to another location or file by specifying the

path. To copy text, we can selct Copy option from the Edit menu. Another

way to copy content is by clicking Copy icon  from the Standard

toolbar, or simply pressing Crtl+C after selecting the content.

To paste cut or copied text, we have to place the cursor at the location

where the text is to be moved and then select Paste option from the Edit

menu. Alternatively, we can click the Paste icon  from the Standard

toolbar or we can simply press Ctrl+V to paste the text.

CHECK YOUR PROGRESS

Q.8. What is the best option to move a small part of text to a

shorter location in a document?

............................................................................................

............................................................................................

............................................................................................

............................................................................................

Q.9. How do you access  the Find and Replace option?

............................................................................................

............................................................................................

............................................................................................
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7.15 LET  US SUM UP

 Microsoft Word is a Word Processor - a type of application software

used to create letters, memos, reports, term papers etc.

 Title bar, Menu bar, Status bar, Ruler, Formatting and Standard
toolbars are the key elements of a MS-Word document window.

 The Title Bar, located at the very top of the screen, displays the

name of the document you are currently using and maximize,

minimize, close button.

 The various components of Menu Bar are File, Edit, View, Insert,

Format, Tools, Table, Window and Help.

 Rulers are found at the top and left of a document and indicate text

positioning, such as size of the margins.

 The Status Bar appears at the very bottom of the screen and

provides information such as current page, current section, total

number of pages, inches from the top of the page, current line number

and current column number.

 The Horizontal Scroll Bar and Vertical Scroll Bar, enable you to

move up and down or across the window.

 The Text Area, just below the Ruler, is a large area where you can

type your document.

 The Backspace key erases text before the cursor position.

 The Delete key erases text after the cursor position.

 To insert text, you must be in the Insert Mode.

 In the Overtype Mode, you can type over the current text (replace

the current text with new text).

 Text can be formatted by changing font style, size and color.
 Text in a document can be made bold, underline and italicize.
 In Microsoft Word, you can easily create bulleted or numbered

lists of items.

 A paragraph can be formatted by placing the cursor within the

paragraph and selecting Paragraph option from the Format menu.

 Line Spacing sets the amount of space between lines within a

paragraph.
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 The first-line indent feature indents the first line of the paragraph.

 Indentation allows you to indent your paragraph from the left or

right margin.

 The different types of alignments are right, left, centre and justified.

 In Microsoft Word, you can copy text from one area of the document

and place that text elsewhere in the document.

 You can cut (delete) text from one area of a document and save

that text so it can be pasted elsewhere in the document.

 The find and replace option can be accessed either by selecting

Edit > Find or Edit > Replace menu by pressing key combinations

as Ctrl+F and Ctrl+H for replace.

7.16 FURTHER  READINGS

 "Introduction to Information Technology", by Sanjay Saxena, Vikash

Publishing, New Delhi.

 "SAMS teach yourself Microsoft Office 2003 in 24 Hours" by Greg

Prerry, Pearson Education.

 "MS Office XP for Everyone", by Sanjay Saxena, Vikash Publishing,

New Delhi.

7.17 ANSWERS TO CHECK YOUR PROGRESS

Ans. to Q. No. 1 : To select the text drag the mouse over the specific

portion of text while keeping the left mouse button

pressed.

Ans. to Q. No. 2 : To close the current document in MS-Word from the

Menu bar, select Close option from the File menu.

Ans. to Q. No. 3 : To exit MS-Word, we have to click Exit option from the

File menu.

Ans. to Q. No. 4 : (i) Document1,  (ii) .doc, .docx,  (iii) Print Preview,

(iv) Menu, nine, (v) View, standard

Ans. to Q. No. 4 : (i) (a) Ctrl+S,  (ii) (c) Ctrl+O,  (iii)(b) Ctrl+A
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Ans. to Q. No. 6 : (i) backspace,  (ii) delete,  (iii) insert,  (iv) formatting

(v) formatting,  (vi) black

Ans. to Q. No. 7 : (i) T,  (ii) F,  (iii) T,  (iv) F

Ans. to Q. No. 8 : For moving a small part of text to a shorter distance,

use drag-and-drop method. Highlight the text to be

moved. Click the text selection using the mouse and

drag this selection to the location where you want to

move the text and release the mouse button.

Ans. to Q. No. 9 : The Find and Replace option can be accessed either

by selecting Edit > Find or Edit > Replace menu or

by pressing key combinations as Ctrl+F for find and

Ctrl+H for replace.

7.18 MODEL  QUESTIONS

Q.1. What do you mean by Word Processor? Give one example of a

popular Word Processor.

Q.2. What is MS-Word? What is the purpose of MS-Word ?

Q.3. What are the basic components of toolbars and explain them?

Q.4. What is the difference between removing text with the Delete key

and with the Backspace key?

Q.5. What is Insert mode?

Q.6. What is Overtype mode?

Q.7. How can a text be made Bold, Italic and Underlined? Mention the

shortcuts to mark the text as bold, italic and underlined.

Q.8. How can bulleted or numbered text be created in a document?

Q.9. What are the functions of menu bar?

Q.10. How do you create a new document in MS-Word?

Q.11. Explain the steps involved in paragraph formatting.

Q.12. How can line spacing in a paragraph be changed?

Q.13. How can the first line indent be assigned in a paragraph?

Q.14. Differentiate between the copy-paste and cut-paste method.
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UNIT 8 : MICROSOFT  WORD– PART II

UNIT STRUCTURE

8.1 Learning Objectives

8.2 Introduction

8.3 Spelling and Grammar Checker

8.4 Undo and Redo

8.5 Header and Footer

8.6 The Tab Key

8.7 Page Setup

8.8 Printing Documents

8.9 Inserting Picture

8.10 Working with Tables

8.10.1 Inserting a Table

8.10.2 Deleting a Table

8.10.3 Traversing aTable

8.10.4 Selecting a Table, Rows, Column

8.10.5 Inserting Rows and Columns

8.10.6 Deleting Rows and Columns

8.10.7 Merging of Cells

8.10.8 Splitting of Cells

8.11 Creating Multiple Columns

8.12 Let Us Sum Up

8.13 Further Readings

8.14 Answers to Check Your Progress

8.15 Model Questions

8.1 LEARNING  OBJECTIVES

After going through this unit, you will be able to:

 learn how to check spellings and grammars of your document

 use undo and redo option

 insert header, footer and page number to your document
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 learn to setup page margin, paper size and layout of the pages

of your document

 prepare your document for printing

 insert pictures to make your document more attactive

 create table in MS-Word document and enter text into it

 delete a table

 format a table by adding rows and columns

 remove rows and columns from a table

 merge and split cells according to your requirements

 create multiple columns of your document

8.2 INTRODUCTION

In the previous unit (Unit 7) we have discussed the basics of MS-

Word. Our discussion includes how to create a new Word document, how

to open an existing document, exiting Word etc. Learners have also been

acquainted with bulleted and numbered list in a Word document; formatting

text as well as paragraphs and about copy, cut paste option.

In this unit we will learn about some other features of MS-Word

which include checking of spelling and grammars, inserting header and

footer, page number, pictures, undo and redu options etc. We will also learn

to insert tables into our document so that we can represent some data  in

tabular format. We will be able to add/delete rows and columns into/from a

table which is already exists. We will also be able to learn to merge and split

cells of a table according to our requirements .

8.3 SPELLING  AND  GRAMMAR  CHECKER

MS-Word provides spelling and grammar checking facility so that

we can identify or rectify our spelling mistakes as well as grammar.

 AutoCorrect option : The AutoCorrect feature of MS-Word

automatically corrects many commonly misspelled words and

wrong punctuation marks which are predefined. To view the list

of words that can be corrected automatically, from the menu

Microsoft World– Part IIUnit 8



Computer Fundamentals and PC Software 181

bar, we have to select AutoCorrect option from the Tools menu.

The AutoCorrect dialog box will be displayed as shown in Fig.

8.1.

Many options that include the additional capitalization of the first

two letters of a word and capitalization of the first word of the

sentence can be corrected automatically.

Fig. 8.1 : AutoCorrect dialog box

 Spelling and Grammar Check : Word checks spelling and

grammar as we type. Spelling errors are displayed with a red

wavy line under the word. The red wavy line also appears under

a word when there is no Dictionary meaning of that word.

Grammar errors display with a green wavy line under the error.

There are three different methods to spell check our entire

document. These are listed below:

– by pressing F7 key

– by clicking the spelling icon  from the Standard toolbar
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– by choosing Spelling and Grammar option from the Tools

menu. The Spelling and Grammar dialog box will appear as

shown in Fig.8.2.

Fig. 8.2 : Spelling and Grammer dialog box

If we want to check the spellings of a part of a document, we

have to select the area first. After that we can follow any one of

the above three steps.

8.4 UNDO  AND  REDO

We can undo the last action by

clicking the Undo button on the Standard

toolbar or by selecting Edit >Undo Typing

option from the Menu bar. To remove the

Undo action, click the Repeat Typing button

on the Standard toolbar or select Edit >

Repeat Typing.

Fig. 8.3 :  Undo and Redo option of Edit Menu
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8.5 HEADER  AND  FOOTER

Another useful feature of MS-Word is Header and Footer. A header

is a text that appears at the top of each page of our document. A footer

appears at the bottom of our pages.Using this feature, one can create a

standard piece of text and/or an image at the top or end of each page of

their document(s). The most common use of header and footer is to display

page numbers and reference titles.

We can add header and footer by choosing the Header and Footer

option from the View menu Fig. 8.4.  As soon as we select the option, two

dashed line box (one at the top and one at the bottom of the text area) will

appear as shown in Fig.8.5 . We can write any reference title as well as

page number within these dashed line boxes.

Fig. .4 : Header and Footer option of View menu

Fig. 8.5 : The dashed box for Header
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 Inserting Page Number : For inserting page number, we can

choose Page Numbers option from the Insert menu. The

following dialog box (Fig.8.6) will appear on the document. We

can put page number either in the header or in the footer section.

Page number can be aligned in any one of the direction: left,

right, center, inside and outside.

Fig. 8.6 : The Page Numbers dialog box

If we want to insert a clip art graphic in the first page header, we

can choose Clip Art from the Picture  option of the Insert menu.

After that we have to  :

 Organize clips from the right panel. The Clip Organizer  will

pop out.

 choose the Collection list from the left panel

 choose a clip art of your choice from any folder of the Collection

list

 copy and paste the clip art or drag it on to the header. The chosen

graphic would be displayed.

8.6 THE TAB KEY

The default Tab setting for Microsoft Word is .5 inches. When we

press the Tab key, the cursor moves 1/2 inch across the page and an arrow

appears on the screen. The arrow is a nonprinting character, when we print

our document the arrow does not print. One can notice how the cursor

moves across the page by pressing the Tab key a few times. To change the

default Tab setting, we have to :
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 choose Tabs from the Format menu. The Tabs dialog box opens.

 enter 1" in the Default Tab Stops field.

 click OK.

 press the Tab key a few times. We can notice how the cursor

moves across the page. The cursor stops at every inch.

We can also set up Custom Tab Stops. To set our Tab Stops to 1",

3.5", and 5", we have to :

 choose Tabs from the Format menu. The Tabs dialog box will

appear.

 enter 1" in the Tab Stop Position field.

 click Set.

 enter 3.5 in the Tab Stop Position field.

 click Set.

 enter 5 in the Tab Stop Position field.

 click OK.

 press the Tab key a few times. Note how the cursor moves across

the page.

8.7 PAGE   SETUP

The page margins of the MS-Word document can be set and

changed using the Rulers on the page and the Page setup window. To

set the Ruler, we have to:

 move the mouse over the region where the Write ruler changes

to gray,

 click with the mouse and the margin indicator to the desired

location when the cursor becomes a double-ended arrow,

 release the mouse when the margin is set.

Page Margins and Orientation : The margins can also be set or

changed using the Page Setup dialog box as shown in Fig.8.7.  For this,

we have to:

 select Page Setup option from the File menu  and specify the

Margin tab in the dialog box,
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 enter margin values in the Top, Bottom, Left and Right boxes.

The Preview window will reflect the changes.

  click on OK when specified.

We can change the Page Orientation within the Page Setup dialog

box. For this, we have to change the page orientation from Portrait or

Landscape by checking the corresponding radio button.

Fig. 8.7 : Page Setup dialog box showing Margins tab

Paper Size : To set the paper size, we have to :

 click the Paper tab of Page Setup dialog box (Fig. 8.8).

 select the appropriate paper size from the drop-down menu of

Paper size box

 click on OK to save the changes made.
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Fig. 8.8 : Page Setupdialog box showing Paper tab

8.8 PRINTING  DOCUMENTS

MS-Word allows us to take printout of our document. We should

first setup our print properties and layouts before printing the documents.

Before taking the print we should be sure that our computer is connected

with printer. For taking a printout, we have to:

 select Print Preview to check whether the layout of our document

is appropriate or not. Otherwise, select Print from File menu  of

the Menu bar. A Print dialog box will appear.

 set all the parameters like number of copies, take print from

current page or we can specify page number too.

 finally click on Print button.
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CHECK YOUR PROGRESS

Q.1. Fill in the blanks :

(i) The________ feature of MS-Word automatically corrects

many commonly misspelled words and punctuation

marks which are predefined.

(ii) The default tab setting for Microsoft Word is ______.

(iii) Red wavy line under a word indicates that the _______

of the word is wrong. or there is no Dictionary meaning

of that word.

(iv) Grammar errors display with a ______ wavy line under

the error.

Q.2. Write T for True and F for False :

(i) Page number cannot be inserted in the header part of a

document.

(ii) If the spelling of a word is incorrect, then by right clicking

on the word, we will get the probable correct options for

the particular word.

(iii) We can change the size of a picture which is inserted in

a Word document with the help of a mouse.

(iv) The page margins of a MS-Word document can be setup

using the Rulers on the page.

8.9 INSERTING PICTURE

We can add a picture from the Clip-Art gallery or we can put a

picture from the drives. Word facilitates us to design our document through

enabling this feature. For inserting pictures, we have to:

 click where we want add our picture.

 click Insert from the Menu bar.

 select Picture.
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 select Clip Art or From File.

 select picture and click Insert.

 select an appropriate picture from gallery or drives.

 click on the OK button.

8.10 WORKING WITH TABLES

We can create tables in MS-Word document to display our text in

tabular format. We can create multiple tables in one document. As per our

need we can add numbers of rows and columns in the table.

8.10.1 Inserting Table

To insert a table in MS-Word document, we have to :

 click where we want to insert the table

 click on the Table menu from the Menu bar.

 select Insert

 select Table (Fig.8.9). The Insert Table dialog box will appear

on the screen as shown in Fig.8.10.

 enter number of rows and columns according to our need

 click on the OK button.

Fig. 8.9 : Tables option of Table menu

Microsoft World– Part II Unit 8



Computer Fundamentals and PC Software190

Fig. 8.10 : Insert Table dialog box showing table size of

2 rows and 5 columns

A table will be inserted in the current position of the cursor. If we

click the AutoFormat… button, a Table AutoFormat dialog box

will be displayed as shown in the Fig.8.11. We have to select any of

the formats from the Table styles list box. We can also set the

Fig. 8.11 : Table AutoFormat dialog box

AutoFormat
button
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other options in the dialog box according to our need and then have

to click OK button to close the dialog box. After that we have to click

the OK button of the Insert Table dialog box. We also can set this

table format as default format for the new tables by clicking the

Default in the Default table styles dialog box and click the OK button.

Alternate Method : Creating a Table by Using the Insert Table

Icon : We can also create a table by clicking on the Insert Table

icon on the Standard toolbar. For this, we have to:

 click the Insert Table icon as shown below.

 highlight the number of rows and

columns we need. The maximum table

size we can create by this method is a

four-row by five-column table.

 Press Enter (or click) to create the table.

8.10.2 Deleting a Table

To delete a table, we can click any of the cells of the table and

then select the Delete > Table command from the Table menu as

shown in Fig.8.12.

Fig. 8.12 : Delete Table option from Table menu
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8.10.3 Traversing a Table

Each block in a table is termed as a cell. One of the easier ways

to enter data in a table’s cell is to click the cell and type. We can also

use the Tab key to move from cell to cell from left to right. If we use

Shift +Tab key together, then it will move cell to cell in the reverse

direction i.e., from right to left. The keyboard shortcuts to move the

cursor in a table are given below :

Keyboard Location in the table from the

shortcut current position of the cursor

Tab The next cell

Shift+Tab The preceding cell

Alt+PageUp The column’s top cell

Alt+PageDown The column’s bottom cell

Alt+Home The current row’s first cell

Alt+End The current row’s last cell

8.10.4 Selecting a Table, Column, Row, and Cell

A table in MS-Word document can be selected by clicking at

any of the cells of the table and then selecting the Select > Table

option from the Table menu.

A row in a table can be selected by clicking at any of the cells in

the row and then by selecting the Select > Row option from the

Table menu.

The same methods can be applied for selecting a column. We

can select a column by clicking at any of the cells in the column and

then by selecting the Select > Column command from the Table

menu.

A cell in a table can be selected by clicking at the cell of the table

and then by selecting the Select >Cell option from the Table menu.

Alternatively, a table, its cells, rows and columns can also be

seleted with the help of mouse.
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8.10.5 Inserting Rows and Columns

We can insert columns and rows in a table which is already

created. A row in a table can be inserted by clicking a cell in the row

above or below which the new row is to be inserted. By selecting

the Rows Above or Row Below option from the Table menu, we

can insert a row above or below the selected row.

Fig: 8.13 : Insert option for Rows and Columns in the Table menu

Similarly, to insert a column in the table, we have to click at a

cell of the column after or before which the new column is to be

inserted. Now, by selecting the Columns to the Left or Columns

to the Right option from the Table menu (Fig.8.13), we can insert a

column to the left or right of the selected column.

8.10.6 Deleting ROWS and Columns

Similar procedures can be applied for deleting rows and columns

from a table. To delete a column from the table,  we have to click at

a cell of the column, which is to be deleted. Now by selecting the

Table > Delete > Columns option (Fig.8.14) from the Table menu,

the entire column can be deleted.
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Fig. 8.14 : Table menu showing Delete option

We can delete a row in a table by clicking at a cell of the row,

which is to be deleted and then by selecting the Table > Delete >

Rows option from the Table menu.

8.10.7 Merging of Cells

In MS-Word, we have the facility to merge cells in a table. Merging

of cells means combining two or more cells into one single cell. For

example, let us consider the following table for better understanding

of merging of cells.

Subject Physics Chemistry Maths Total Marks

Rahul 65 76 81 222

Preeti 78 76 80 224

If we want to write a table heading above the row containg

subjects name, then it will look better if we merge the all five cells of

first row into a single cell. The structure of the table will be as followes

after merging all the 5 cells of first row. We have written the heading

“Marks of Class Test 1” in the first row.
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Marks of Class Test 1

Subject Physics Chemistry Maths Total Marks

Rahul 65 76 81 222

Preeti 78 76 80 224

Merging of cells can be done by :

 selecting the cells to be merged

 clicking the Merge Cells option from the Table menu.

Fig. 8.15 : Table menu showing Merge Cells option

Alternatively, we can right click on the selected position. As a

result, a  drop-down menu appears on the screen as shown in

Fig.8.16. By  selecting Merge Cells option, we can merge the cells

of the table.

Fig. 8.16 : Drop-down menu showing Merge Cells option
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8.10.8 Splitting of  Cells

There is a Split Cells options in MS-Word table which provides

us the facility to split cells i.e., turn one cell into more than one cell.

Let us consider the previous example. Let us consider the following

table :

Suppose, we want to split the lower left corner cell of the above

table.

To split a cell, we have to:

 place the cursor inside the cell by clicking the left mouse button.

 click  Split Cells option from the Table menu (Fig.8.17).

Fig. 8.17 : Table menu showing Split Cells... option
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A window will be displayed as shown in Fig. 8.18. In the window,

we have to specify the number of rows and number of columns the

cell will contain after splitting. After that we have to click the OK

button.

Fig. 8.18 : Window showing options for number of rows and columns

If we set the number of columns as 2 and the number of rows as

1, then the structure of the table will look like:

Alternatively, we can split cells by right clicking the selected cell

and then choosing Split Cells option.

8.11 CREATING  MULTIPLE  COLUMNS

MS-Word provides us the facility to create newspaper-style columns-

such as those that appear in newsletters and brochures to format our text

with multiple columns. We can assign multiple columns to the entire

documnet or to only a selected part of our document. When we want to set

multiple columns, we have to:

 select the text we want to convert to multiple columns.

 select Columns option from the Format menu.The Columns

dialog box will appear as shown in Fig.8.19.
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Fig. 8.19 : Columns dialog box to set up multiple columns

 In the Preset area, click the column format we want and then

enter the number of columns we want to produce.

 In the Width and Spacing area, adjust the column width and

spacing between columns or accept Word’s default. Gener ally,

the default measurements work well. As we adjust the columns,

Word updates the Preview area to give us an idea of the final

result.

 If we want a line between the columns, select the option Line

between.

When we click OK button, Word formats our selected text into

multiple columns.

Figure 8.20 shows a document with three columns and a single

column at the top of the title area. Generally, we should type our document’s

text before breaking into multiple columns.
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Fig. 8.20 : Text document in Newpaper format showing 3 columns

Multiple columns option can be used when we want our text to flow

from the bottom of one column to the top of another.

CHECK YOUR PROGRESS

Q.3. Multiple Choice :

(i) The keyboard shortcut for Undo operation  is

(a) Ctrl+U (b) Shift+Z

(c) Alt +U (d) Ctrl+Z

(ii) The maximum table size which can be created by the

Insert Table option of toolbar is

(a) 35 table (b) 44 table

(c) 45 table (d) 54 table

Q.4. Write T for True and F for False :

(i) A table can also be drawn with the Tables and Borders

option of the Standard toolbars

(ii) We cannot insert a chart in MS-Word document.

(iii) We can apply cut and paste feature in case of table also.

(iv) Contents within a table cell cannot be aligned.

(v) We can select a table by clicking the plus sign which

appears at the upper right corner of the table while we

move the mouse over the table.
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Q.5. What is the difference between a table and a document

formatted with multiple columns?

............................................................................................

............................................................................................

............................................................................................

............................................................................................

8.12 LET US SUM UP

 Word checks our spelling and grammar as we type. Spelling errors

display with a red  wavy line under the word. Grammatical errors

are displayed with a green wavy line under the error.

 We can quickly reverse most commands we execute by using Undo

command

 Using the Redo command, we can go to the previous state after the

use of  Undo command.

 Header is a special text that appears at the top of the page, which is

often used for repeating the title of a document from a page to

another page. Page number and pictures can also be entered as

header in a document.

 Footer is often used for the same purpose but at the bottom of a

document.

 The default tab setting for Microsoft Word is .5 inches.

 The margin of a MS-Word document can be changed with the Page

SetUp option.

 Print Preview enables us to view either a full readable page or an

unreadable view of page depending on screen size.

 MS- Word provides us the facility to add pictures and graphics into

our document to make the document more attarctive.

 A table in a MS-word document can be created with the Insert >

Table  option from the Table menu. While creating a table, we have

to specify the size of the table (i.e. the Number of Rows and Number

of Columns of the table)
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 To delete a table, click any of the cells of the table and then choose

the Delete > Table option from the Table menu.

 Each block in a table is called a cell.

 After creating a table, additional rows and columns can be inserted

at any position in the table.

 The size of a table can be reduced by deleting row(s) or column(s)

from the table.

 In a table, the cells can be merged.

 In a table, a particular cell can be split to form new cells.

 Multiple columns work well for newsletters and brochures to keep

reader’s attention.

8.13 FURTHER READINGS

 "Introduction to Information Technology", by Sanjay Saxena, Vikash

Publishing, New Delhi.

 "SAMS teach yourself Microsoft Office 2003 in 24 Hours" by Greg

Prerry, Pearson Education.

 "MS Office XP for Everyone", by Sanjay Saxena, Vikash Publishing,

New Delhi.

8.14  ANSWERS TO CHECK YOUR PROGRESS

Ans. to Q. No. 1 : (i) AutoCorrect,  (ii) half inches,  (iii) Spelling, (iv) green

Ans. to Q. No. 2 : (i) F,  (ii) T,  (iii) T,  (iv) T

Ans. to Q. No. 3 : (i) (d) Ctrl+Z, (ii) (c) 45 table

Ans. to Q. No. 4 : (i) T,  (ii) F,  (iii) T,  (iv) F,  (v) T

Ans. to Q. No. 5 : Both tables and multicolumn documents have multiple

columns. The multicolumn document, however, is

useful when we want to create a newspaper-style

documnet with flowing columns of text and graphics.

Tables have both columns as well as rows, making

cells at each row and column intersection for specific
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data. A multicolumn document might contain a table in

one of its columns. We can use tables when we want

side-by-side columns of related information. Multiple

columns option can be used when we want our text to

frow from the bottom of one column to the top of another.

8.15 MODEL QUESTIONS

Q.1. What is the use of the Tab key? How can the Tab key can be set?

Q.2. How can you turn off the automatic spell check?

Q.3. What is Undo and Redo command?

Q.4. What is the use of header and footer in a word document? How can

header and footer be inserted in a document?

Q.5. How can page number be displayed in header and footer in a

document?

(a) Create a header and footer in a word document. The text “PC

Software” should be included in the header part and the page

number should be included in the footer part. The page number

should be right aligned.

(b) Change the margin of the document as: Top 1.20", Bottom 0.80",

Left 1.20" and Right 2.55".

Q.6. Describe the steps to create a new table?

Q.7. How a new row can be inserted in a table?

Q.8. How a new column can be inserted in a table?

Q.9. How two or more cells can be merged to form a new cell in a table?

Q.10 How a cell can be split to more than one cell in a table?

Q.11. Create a table as shown below:

(a) Delete the 2nd row from the table

(b) Delete the 3rd column from the table.

Q.12. Write down the steps to color all cells of a table.

Q.13. Write down the steps to insert an image whcih is saved in the in

computer desktop.
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UNIT 9 : MICROSOFT EXCEL

UNIT STRUCTURE

9.1 Learning Objectives

9.2 Introduction

9.3 Starting MS Excel

9.3.1 Working with Toolbars

9.4 Row, Column and Cell

9.5 Working with Excel

9.5.1 Creating a New Workbook

9.5.2 Working with Cells and Fonts

9.5.3 Merging Cells

9.5.4 Inserting and Deleting Rows and Columns

9.6 Saving a Workbook

9.7 Closing a Workbook

9.8 Let Us Sum Up

9.9 Further Readings

9.10 Answers To Check Your Progress

9.11 Model Questions

9.1 LEARNING OBJECTIVES

After going through this unit, you will be able to:

 work with MS Excel

 use the different toolbar

 know Rows, Columns and Cells

 perform different operations on Cells, Rows and Columns

 create a new Workbook

 save and close a Workbook

9.2 INTRODUCTION

While working with large amounts of data we need to order them

logically. Such data often need to be organized in a nice tabular format. For
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that purpose we need a program that allows us to organize and manipulate

huge amounts of data in a nice and easily understandable manner. Such a

computer program is often called a Spreadsheet. A spreadsheet is the

computer equivalent of a paper ledger sheet. It consists of a grid made from

columns and rows. It is an environment that can make number manipulation

easy and somewhat painless. Excel is an electronic spreadsheet program

that can be used for storing, organizing, making calculations and manipulating

data.

In this unit, we will be discussing these features of MS Excel and

introduce ourselves to the basic features of Excel that one should understand

in order to use and work in the MS Excel environment.

9.3 STARTING MS EXCEL

In order to start using MS Excel 2007, we have to launch it first by

selecting it from the Programs list.

Fig. 9.1 : The Start menu
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To do so we follow these steps :

1. Firstly we have to click on the Start button  located on the

extreme left of the taskbar

2. This opens the Start menu of Figure 9.1

3. We then select the Programs menu, which gives us a list of all

the installed programs

4. From among the installed programs we click on Microsoft Excel

2007 which shows the application window of MS Excel 2007 as

in Figure 9.2.

Fig. 9.2 : MS Excel 2007 application window

9.3.1 Working with Toolbars

The previous versions of MS Excel had many menus and toolbars

wherefrom we could easily select many menu options and tools.

But in MS Excel 2007 the menu bar and toolbar have been done

away with. Excel 2007 introduces the Ribbon, which has replaced

the menus and toolbars found in earlier versions of Excel. The Ribbon

can quickly be hidden to give you more room to work in your

spreadsheet.

Ribbon : The Ribbon is the strip of buttons and icons located

above the work area in Excel 2007. Above the Ribbon are a number
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of tabs, such as Home, Insert, Page Layout etc. Clicking on a tab

displays the options located in this section of the ribbon. For example,

when Excel 2007 opens, the options under the Home tab are

displayed. These options are grouped according to their function -

such as Clipboard (includes cut, copy, and paste options), and Font

(includes current font, font size, bold, italic, and underline options).

Clicking on an option on the ribbon may lead to further options

contained in a Contextual Menu that relate specifically to the option

chosen.

In Excel 2007 we can use the scroll wheel on the mouse to

scroll from one tab to another on the ribbon.

 To Scroll Through Ribbon Tabs :

 We place the mouse pointer in the ribbon area at the top of

the Excel 2007 screen.

 Then we turn the scroll wheel on the mouse to scroll through

the different ribbon commands.

 To Hide the Ribbon Commands :

 We double click on one of the ribbon tabs - such as Home,

Insert, or Page Layout.

OR

 Press the CTRL + F1 keys on the keyboard.

Only the tabs will be left showing above your spreadsheet.

 To Show the Ribbon Commands Again :

 We click on one of the ribbon tabs - such as Home, Insert,

or Page Layout.

OR

 Press the CTRL + F1 keys on the keyboard a second time.

 To always keep the Ribbon minimized:

1. First we click the Customize Quick Access toolbar.

2. In the list, we click Minimize the Ribbon.

3. To use the Ribbon while it is minimized, we click the tab that

we want to use, and then click the option or command we

want to use. For example, with the Ribbon minimized, we
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can select text in MS Office Word document, click the Home

tab, and then in the Font group, we may click the size of the

text needed. After clicking the desired text size, the Ribbon

goes back to being minimized.

Fig. 9.3 : The Ribbon

 The Quick Access toolbar : The Quick Access Toolbar in

Excel 2007 is found in the upper left corner of the spreadsheet

program above the ribbon and next to the Office Button. It is

used to store shortcuts to frequently used features in Excel 2007.

It is also where we add the shortcuts to Excel features that are

not available on the ribbon in Excel 2007.

Fig. 9.4 : The Quick Access toolbar

 Moving the Quick Access toolbar : The Quick Access toolbar

is located above the Ribbon by default. To bring it below the

Ribbon we follow these steps:

1. We click Customize Quick Access Toolbar 

2. Then in the list, we click Show Below the Ribbon

 Customizing the Quick Access toolbar :

 Adding a command to the Quick Access Toolbar directly

from the Ribbon

We can add a command to the Quick Access Toolbar directly

from commands that are displayed on the Ribbon by following these

steps:

1. On the Ribbon, we click the appropriate tab or group to display

the command that is to be added to the Quick Access Toolbar.

2. We right-click the command, and then click Add to Quick

Access Toolbar on the shortcut menu.

 Adding a command to the Quick Access Toolbar by using

the Program Name Options dialog box
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The new Ribbon in Office 2007 can take a while to get used to,

so the Quick Access Toolbar is a great way to put the most frequently

used commands on a single toolbar while getting used to the Ribbon.

We can add a command to the Quick Access Toolbar from a list of

commands in the Program Name Options dialog box, where

Program Name is the name of the program being used, for example,

Word Options

1. Firstly we do any one of the following

 Using the MS Office button

(i) We click the MS Office Button, and then click Program

Name Options, where Program Name is the name of

the program being used, for example, Excel Options.

(ii) We click Customize.

 Using the Quick Access toolbar

(i) We click Customize Quick Access Toolbar 

(ii) In the list we click More Commands which opens the

dialog box of Figure 9.5.

2. In the Program Name Options dialog box, in the Choose

commands from list, we click the command category that we

want.

Fig. 9.5 : The Excel Options dialog box
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3. In the list of commands in the selected category, we click the

command to be added to the Quick Access Toolbar, and then

click Add.

4. After adding we click OK.

9.4 ROW, COLUMN AND CELL

MS Excel can be used to organize data into rows and columns.

When we look at the Excel screen of Figure 9.2, we can see a rectangular

table or grid of rows and columns. The horizontal rows are identified by

numbers (1,2,3 etc) and the vertical columns are identified with letters of

the alphabet (A,B,C etc). For columns beyond 26, columns are identified by

two or more letters combination such as AA, AB, AC etc

Fig. 9.6 : Rows, Columns and Cells in an Excel Worksheet

The intersection point between a column and a row is a small

rectangular box known as a cell. A cell is the basic unit for storing data in

the spreadsheet. Because an Excel spreadsheet contains thousands of

 

Rows 

Cell  C5 
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these cells, each is given a cell reference or address to identify it.

Sometimes referred to as a cell address, a cell reference consists of the

column letter and row number that intersect at the location of the cell such

as A3, B6, AA345. A cell reference identifies the location of a cell or group

of cells in the spreadsheet. When listing a cell reference, the column letter

is always listed first.

 Cell references are used in formulas, functions, charts and other

Excel commands.

 While references often refer to individual cells such as A1, B38,

or Z345, they can also refer to a group or range of cells.

 Ranges are identified by the cell references of the cells in the

upper left and lower right corners of the range.

 The two cell references used for a range are separated by a

colon ( : ) which tells Excel to include all the cells between these

start and end points.

 An example of a range of adjacent cells would be B5:D10.

CHECK YOUR PROGRESS

Q.1. Fill in the blanks.

(i) A __________ is the computer equivalent of a paper

ledger sheet.

(ii) In Excel 2007 the __________ has replaced the menus

and toolbars found in earlier versions of Excel.

(iii) The __________ is used to store shortcuts to frequently

used features in Excel 2007.

(iv) In Excel 2007 we can use the __________ on the mouse

to __________ from one tab to another on the ribbon.

Q.2. State whether the following statements are True or False.

(i) The Ribbon can quickly be hidden to get more room to

work in our spreadsheet.
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(ii) The Ribbon is the strip of buttons and icons located above

the work area in Excel 2007.

(iii) Horizontal rows are identified by letters of the alphabet

and the vertical columns are identified by numbers.

(iv) The intersection point between a column and a row is a

small rectangular box known as a cell.

(v) A cell reference consists of the column number and row

letter that intersect at the cell’s location.

9.5 WORKING WITH EXCEL

Before working with excel and using its various features and functions

that help us to create Worksheets which enable us to manipulate data in

rows and columns, it is important to understand some basic ways of working

in the excel environment which would enable us to use later the more

advanced features and techniques present in Excel 2007.

 Navigating in Excel : Any application program that has windows

includes the navigation bars that allow us to have a full look into

a worksheet, as shown in Figure 9.7.

Fig. 9.7 : Navigating the Worksheet

 

Navigation bars
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Using these two navigation bars we can browse through the entire

worksheet.

 Selecting sheets : In order to work with multiple worksheets in

Excel, we need to select them numerous times. If we have

multiple worksheets in the Excel document, they can be seen

as shown in Figure 9.8

Fig. 9.8 : Multiple Sheets in Excel

 To select a single sheet while working with Excel we click

the tabs of worksheets (or sheets) at the bottom of the

window.

 To select two or more adjacent sheets we click the tab for

the first sheet, and then holding down SHIFT we click the

tab for the last sheet that we want to select.

 To select two or more nonadjacent sheets we click the tab

for the first sheet, and holding down CTRL we click the tabs

of the other sheets that we want to select.

 To select all sheets in a workbook we right-click a sheet tab,

and then click Select All Sheets on the shortcut menu.

 Entering data into cells :

To enter data into Worksheet cells we do the following :

1. Firstly we select the cell where data is to be inserted

2. We then type the text into that cell

3. Finally we press Enter or Tab

 Editing data in cells :

To edit data in a Worksheet cell we do the following:

1. To place the contents of a cell in editing mode

 We double-click the cell whose data is to be edited.

OR
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 We click the cell whose data is to be edited, and then

click anywhere in the formula bar.

This positions the insertion point in the cell or formula bar.

2. To edit the cell contents

 To delete characters, we click where we want to delete

them, and then press BACKSPACE, or select them, and

then press DELETE.

OR

 To insert characters, we click where we want to insert

them, and then type the new characters.

OR

 To replace specific characters, we select them, and then

type the new characters.

OR

 To turn on Overtype mode so that existing characters

are replaced by new characters while typing, we press

INSERT.

OR

 To start a new line of text at a specific point in a cell, we

click where we want to break the line, and then press

ALT+ENTER.

 Deleting data from cells :

To delete data from a Worksheet cell we do the following:

1. Firstly, we select the cell whose data is to be deleted

2. Then we do one of the following

 Press the DELETE key

 Press the BACKSPACE key

 Right-click the cell and select Clear Contents from the

drop-down  menu

 Right-click the cell and select Delete, or on the Home

tab, in the Cells group, we select Delete and click Delete

Cells, which opens up the dialog box in Figure 9.9.
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Fig. 9.9

3. Now we select any of the two options Shift cells left or Shift

cells up.

9.5.1 Creating a New Workbook

A MS Excel workbook is a file containing one or more worksheets

that we use to organize several kinds of related information.

 To create a new workbook, we may

 Open a blank workbook

 Base a new workbook on an existing workbook

 Base a new workbook on a template

 To open a new blank workbook we follow these steps:

1. We click the Microsoft Office Button  and then click

New.

Fig. 9.10 : The New Workbook dialogue box
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OR

Press Ctrl + N

2. This opens the New Workbook dialog box as in Figure 9.10

3. Under Templates, we select Blank and recent, and then

under Blank and recent in the right pane, we click Blank

Workbook.

 To base a new workbook on an existing workbook we follow

these steps:

1. We click the Microsoft Office Button  and then click

New or press Ctrl + N which opens the dialogue box of

Figure 9.10

2. Under Templates, we click New from existing which opens

up the New from Existing Workbook dialog box of Figure

9.11

3. In the New from Existing Workbook dialog box, we browse

to the drive, folder, or Internet location that contains the

workbook that we want to open.

4. We click the workbook, and then click Create New.

Fig. 9.11 : The New from Existing Workbook dialog box
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 To base a new workbook on an existing template we follow

these steps:

1. We click the Microsoft Office Button  and then click

New or press Ctrl + N which opens the dialogue box of

Figure 9.10.

2. Under Templates, we click Installed Templates which opens

the dialog box of Figure 9.12 or My templates which opens

the dialog box of Figure 9.13.

3. Finally we do one of the following

 To use an installed template, under Installed Templates,

we click the template we want, and then click Create.

 To use our own template, on the My Templates tab, we

double-click the template that we want.

Fig. 9.12 : The Installed Templates

Fig. 9.13 : The New dialog box
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9.5.2 Working with Cells and Fonts

When we are working in Excel we are actually dealing with the

data that we insert into the cells. We have already seen how we can

perform operations on cell data like insertion, edition and deletion.

In this section we will look into some other features of working with

cells.

When we work with cells we can apply different formatting

techniques to them. Also we can work with Fonts in Excel in a similar

manner. Some of them are discussed below.

 Working with Styles : A cell style is a defined set of formatting

characteristics, such as fonts and font sizes, number formats,

cell borders, and cell shading. To prevent anyone from making

changes to specific cells, we can also use a cell style that locks

cells. To apply several formats in one step, and to ensure that

cells have consistent formatting, we can use a cell style.

 To apply a cell style, we follow these steps :

1. Firstly we select the cells we want to format

2. On the Home tab, in the Styles group, we click Cell

Styles

3. Lastly we select the cell style that we want to apply

 To create a custom cell style we follow these steps :

1. Firstly on the Home tab, in the Styles group, we click

Cell Styles.

2. Then we click on New Cell Style which opens the dialog

box of Figure 9.14.
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Fig. 9.14 : The New Cell Style dialog box

3. In the Style name box, we type an appropriate name for

the new cell style.

4. Then we click Format to open the Format Cells dialog

box of Figure 9.15.

Fig. 9.15 : The Format Cells dialog box
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5. On the various tabs in the Format Cells dialog box, we

select the formatting and click OK.

6. In the Style dialog box, under Style Includes, we clear

the check boxes for any formatting that we do not want

to include in the cell style.

 To fill cells with solid colors we follow these steps:

1. Firstly we select the cells that we want to apply shading

to or remove shading from

2. On the Home tab, in the Font group, we do one of the

following:

 To fill cells with a solid color, we click the arrow next

to Fill Color  in the Font group on the Home

tab, and then click the color we want.

 To apply the most recently selected color, we can

click Fill Color.

 To fill cells with patterns, we follow these steps :

Fig. 9.16 : The Format Cells dialog box
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1. We select the cells to be fill with a pattern.

2. On the Home tab, we click the Dialog Box Launcher  

next to Font, and then click the Fill tab as shown in

Figure 9.16 below.

3. Under Background Color, we click the background color

that we want to use.

 To apply cell borders we follow these steps :

1. Firstly we select the cell/range of cells that we want to

add a border to, to change the border style on, or to

remove a border from

2. On the Home tab, in the Font group, we click the arrow

next to Borders,  and then click a border style.

 Working with Fonts : We can not only change the font or font

size for selected cells or ranges in a worksheet, but also change

the default font and font size that are used in new workbooks.

 To change the font or font size we follow these steps :

1. Select the cell, range of cells, text, or characters that

you want to format.

2. On the Home tab, in the Font group, we do the following:

 To change the font, we click the needed font in the

Font box 

Fig. 9.17 : The Excel Options dialog box

Microsoft ExcelUnit 9



Computer Fundamentals and PC Software 221

 To change the font size, we click the font size that

we want in the Font Size box  or click Increase

Font Size  or Decrease Font Size  until the size

you want is displayed in the Font Size box.

 To change the default font or font size for new

workbooks we follow these steps :

1. We click the MS Office Button  and then click Excel

Options which opens the dialog box of Figure 9.17

2. In the Popular category, under When creating new

workbooks, we click a font in the Use this font box,

and then specify a font size in the Font Size box.

CHECK YOUR PROGRESS

Q.3. State whether the following statements are True or False :

(i) To select two or more adjacent sheets we click the tab

for the first sheet, and then holding down SHIFT we click

the tab for the last sheet that we want to select

(ii) We cannot base a new workbook on an existing

workbook.

(iii) Base a new workbook on a template.

(iv) We cannot use a cell style that locks cells.

(v) We can fill cells with patterns.

9.5.3 Merging Cells

The Merge formatting feature in Excel 2007 is a handy option to

quickly format titles and headings in Excel 2007 spreadsheets. It

allows us to align titles evenly above our data by merging a number

of cells into one and then aligning the title in this one cell. In previous

versions of Excel problems often occurred when we tried to make

formatting changes to an area of the worksheet where the Merge
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feature had been applied. Adding new columns to the merged area

was particularly difficult and it was necessary to un-merge the cells,

add the new columns, and then reapply Merge. In Excel 2007 this

problem has been corrected. Adding new columns to the merged

area is now quite easily done.

When we merge two or more adjacent horizontal or vertical cells,

the cells become one large cell that is displayed across multiple

columns or rows. The contents of one of the cells appear in the

center of the merged cell. A merged cell is a single cell that is created

by combining two or more selected cells. The cell reference for a

merged cell is the upper-left cell in the original selected range.

 To merge adjacent cells we do the following :

1. Firstly we need to select two or more adjacent cells that we

want to merge

2. On the Home tab, in the Alignment group, we click Merge

and Center.

3. The cells will be merged in a row or column, and the cell

contents will be centered in the merged cell. To merge cells

without centering, we click the arrow next to Merge and

Center, and then click Merge Across or Merge Cells

4. (Optional) We may change the alignment in the merged cell,

if desired. For example, we may click the Align Text Right

button in the Alignment group in case we want the text in

the merged cell to be right-aligned instead of centered.

Example using the Merge and Center cells feature.

1. Firstly, we click on cell A2.

2. Then type in a title such as: The Cookie Shop.

3. Click on cell A3.

4. Then type in a subtitle such as: Income Statement.
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5. We drag select cells A2 to C2

6. Then click on the Home tab.

7. Click on the Merge & Center option on the ribbon.

8. The title should be centered across columns A to C.

9. Drag select cells A3 to C3

10. Click on the Merge & Center option on the Ribbon.

11. The subtitle should be centered across columns A to C.

Before applying Merge After applying Merge and Center

If we try to Merge & Center more than one row at a time only the title

in the top row will be retained by Excel. All other titles will be discarded.

Splitting a merged cell :

We may also unmerge or split a merged cell into its original, individual

cells. We can only split a cell that has previously been merged.

 To split a merged cell we follow these steps :

1. Firstly we select the merged cell that we want to unmerge

2. The Merge & Center button appears selected in the

Alignment group.

3. Finally we click the Merge & Center button in the Alignment

group.

The merged cell reverts to a cell range again, and any text

contained in the merged cell displays in the upper-left cell of the

range.

9.5.4 Inserting and Deleting Rows and Columns

In an Excel workbook we can insert rows above a row and

columns to the left of a column. We can also delete rows and columns

in a worksheet.
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 To insert rows on a worksheet we follow these steps :

1. Firstly, if we want to insert a single row, we select the row or

a cell in the row above which we want to insert the new row.

OR

If we want to insert multiple rows, we select the rows above

which we want to insert rows. We select the same number

of rows as we want to insert.

OR

If we want to insert nonadjacent rows, we hold down Ctrl

while selecting the nonadjacent rows.

2. On the Home tab, in the Cells group, we click the arrow

next to Insert, and then click Insert Sheet Rows.

 To insert columns on a worksheet we follow these steps :

1. Firstly, if we want to insert a single column we have to select

the column or a cell in the column immediately to the right of

where we want to insert the new column.

OR

If we want to insert multiple columns we have to select the

columns immediately to the right of where we want to insert

columns. We similarly select the same number of columns

as we want to insert.

OR

If we want to insert nonadjacent columns, we have to hold

down the Ctrl key while selecting nonadjacent columns

2. On the Home tab, in the Cells group, we click the arrow

next to Insert, and then click Insert Sheet Columns.
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 To delete rows or columns from a worksheet we follow these

steps :

1. Firstly, we select the rows or columns to be deleted.

2. On the Home tab, in the Cells group, we do one of the

following:

 To delete selected rows, we click the arrow next to Delete,

and then click Delete Sheet Rows.

 To delete selected columns, we click the arrow next to

Delete, and then click Delete Sheet Columns.

When we delete rows or columns, the other rows or columns

automatically shift up or to the left.

9.6 SAVING A WORKBOOK

When we save a file, we can save it on the hard disk drive, a network

location, disk, CD, the desktop, or another storage location. We need to

identify the target location in the Save in list. Otherwise, the saving process

is the same, no matter what location we choose.
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 To Save an Excel 2007 file we do the following :
1. Firstly we click the Microsoft Office button
2. From the drop down menu we click Save.

OR
We press Ctrl + S on the keyboard

(If we are saving the file for the first time, the Save As dialog box

opens and we are asked to give a file name)

 To save a copy of an Excel 2007 file we do the following :
1. Firstly we click the Microsoft Office button  and choose

Save As.

2. Click the folder or drive to which we want to save.

3. In the File name box, we enter a new name for the file.

4. Click Save.

 To save an Excel 2007 file to another format we do the

following :

1. Firstly we click the Microsoft Office Button  and then

click Save As.

2. In the File name box, we enter a new name for the file.

3. In the Save as type list, we click the file format that we want

to save the file in

4. Click Save.

9.7 CLOSING A WORKBOOK

After we have finished working with our Excel workbook and saved

it on the hard drive, we should close the workbook. The ways that are involved

in closing a Workbook are discussed below.

 To close a Workbook without quitting MS Excel 2007 we do
the following :
1. We click the MS Office button  and click Close

OR

Click the Close window button  just above the worksheet

2. If the Worksheet has not been saved, the dialog of Figure 9.18
is displayed asking us if we would like to Save the Workbook.
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Fig. 9.18 : Saving a Workbook

2. If we select Yes, another dialog box is provided which allows

us to Close the workbook by saving it.

 To close a Workbook by quitting MS Excel 2007 we do the

following:

1. Firstly we click the Close button   that closes MS Excel

2. If the Worksheet has not been saved, the dialog of Figure

9.18 is displayed asking us if we would like to Save the

Workbook

3. If we select Yes, another dialog box is provided which allows

us to Close the workbook by saving it.

CHECK YOUR PROGRESS

Q.4. Fill in the blanks:

(i) The __________ formatting feature is a handy option to

quickly format titles and headings.

(ii) A __________ is a single cell that is created by combining

two or more selected cells.

(iii) If we try to __________ more than one row at a time

only the title in the top row will be retained by Excel.

(iv) We can only __________ a cell that has previously been

__________.

(v) If we want to insert nonadjacent rows, we __________

the nonadjacent rows.
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9.8 LET US SUM UP

 Excel is an electronic spreadsheet program that can be used for

storing, organizing and manipulating data.

 MS Excel can be used to organize data into rows and columns.

 For columns beyond 26, columns are identified by two or more

letters combination such as AA, AB, AC etc

 A cell is the basic unit for storing data in the spreadsheet.

 To select a single sheet while working with Excel we click the tabs

of worksheets (or sheets) at the bottom of the window.

 When we work with cells we can apply different formatting

techniques to them.

 A cell style is a defined set of formatting characteristics.

 When we merge two or more adjacent horizontal or vertical cells,

the cells become one large cell that is displayed across multiple

columns or rows.

 We can also unmerge or split a merged cell into its original,

individual cell.

 In an Excel workbook we can insert rows above a row and

columns to the left of a column.

9.9 FURTHER READINGS

l "Introduction to Information Technology", by Sanjay Saxena, Vikash
Publishing, New Delhi.

 "SAMS teach yourself Microsoft Office 2003 in 24 Hours" by Greg

Prerry, Pearson Education.

9.10 ANSWERS TO CHECK YOUR
PROGRESS

Ans. to Q. No. 1 : (i) spreadsheet, (ii) ribbon, (iii) quick access toolbar,

(iv) scroll wheel, scroll
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Ans. to Q. No. 2 : (i) true, (ii) true, (iii) false, (iv) true, (v)

false

Ans. to Q. No. 3 : (i) true, (ii) false, (iii) false, (iv) false,

(v) true

Ans. to Q. No. 4 : (i) Merge, (ii) merged cell, (iii) Merge and Center,

(iv) Split, merged, (v) Ctrl + click

9.11 MODEL QUESTIONS

Q.1. What purpose is Excel used for? What are its applications?

Q.2. How do we start working with MS Excel 2007?

Q.3. Describe the Ribbon in Excel 2007.

Q.4. What are Rows, Columns and Cells in Excel?

Q.5. What are the steps involved in creating a new worksheet in Excel

2007?

Q.6. How can we merge cells? Give an example.

Q.7. How do we spit a merged cell? Explain

Q.8. Explain the process of inserting rows and columns in Excel.

Q.9. Explain the process of deleting rows and columns in Excel.

Q.10. How do we close an Excel worksheet?
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UNIT 10 : FUNCTIONS IN EXCEL

UNIT STRUCTURE

10.1 Learning Objectives

10.2 Introduction

10.3 Different Operators Used in Excel

10.4 Working with Formula and Functions

10.5 Sorting Data

10.6 Working with Charts

10.7 Let Us Sum Up

10.8 Further Readings

10.9 Answers To Check Your Progress

10.10  Model Questions

10.1 LEARNING OBJECTIVES

After going through this unit, you will be able to:

 know the different operators used in excel

 use the various calculation techniques

 use functions in excel to work with data

 use sorting to sort data differently

 learn about charts and use different types of charts

 use different charts to display data trends

10.2 INTRODUCTION

In the previous unit, we were introduced to MS Excel 2007, where

we got to know the purpose of Excel and its use. We were introduced to the

terms like rows, columns, cells etc. We have also leant how to add and

delete rows and columns. The basics of an Excel workbook were also

introduced in the previous unit.

One important fact while using excel is data manipulation. Data

manipulation in Excel involves inserting various types of data in cells and
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performing several different operations on them. Excel supports numerous

functions and formulas that we can implement in order to get the desired

result. These involve calculation of data, both simple and complex, using

those functions and formulas.

Another concept involved with data manipulation is that of charts.

Excel 2007 provides several different types of charts, each suited for a

particular type of data-set. These charts give a graphical representation of

data in worksheets, showing the relative comparison among data. In this

unit we will be discussing at length these operations performed on worksheet

data.

10.3 DIFFERENT OPERATORS USED IN EXCEL

Operators specify the type of calculation that we want to perform on

the elements of a formula. There is a default order in which calculations

occur, but we can change this order by using parentheses.

 Types of operators : There are four different types of calculation

operators: arithmetic, comparison, text concatenation, and

reference.

 Arithmetic operators : To perform basic mathematical

operations such as addition, subtraction, or multiplication;

combine numbers; and produce numeric results, we use the

following arithmetic operators.

OPERATOR MEANING EXAMPLE

+ Addition 4+4

– Subtraction, Negation 4-2, -3

* Multiplication 4*2

/ Division 3/3

% Percent 30%

^ Exponentiation 2^3

 Comparison operators : We can compare two values with

the following operators. When two values are compared by
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using these operators, the result is a logical value either TRUE

or FALSE.

OPERATOR MEANING EXAMPLE

= Equal to A2=B2

> Greater than A3>B3

< Less than B3<A3

>= Greater than or equal to A4>=B4

<= Less than or equal to B4<=A4

<> Not equal to A2<>B4

 Text concatenation operator : We use the ampersand (&)

to join, or concatenate, one or more text strings to produce

a single piece of text.

OPERATOR MEANING EXAMPLE

Concatenates, two (“Independence”&”day”)

& values to produce one

continuous text value

 Reference operators : We can combine ranges of cells for

calculations with the following operators.

OPERATOR MEANING EXAMPLE

Range operator, which

produces one reference

: to all the cells between B5:B15

two references, including

the two references

Union operator, which

, combines multiple SUM(B5:B15,D5:D15)

references into one

reference

Intersection operator,

(Space) which produces on B7:d7 c6:c8

reference to cells common

to the two references
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 The order in which excel performs operations in formulas

: In some cases, the order in which calculation is performed can

affect the return value of the formula, so it is important to

understand how the order is determined and how we can change

the order to obtain desired results.

 Calculation order : Formulas calculate values in a specific

order. A formula in Excel always begins with an equal sign

(=), which tells Excel that the succeeding characters

constitute a formula. Following the equal sign are the

elements to be calculated (the operands), which are

separated by calculation operators. Excel calculates the

formula from left to right, according to a specific order for

each operator in the formula.

 Operator precedence : When we combine several

operators in a single formula, Excel performs the operations

in the order shown in the following table. If a formula contains

operators with the same precedence — for example, if a

formula contains both a multiplication and division operator

— Excel evaluates the operators from left to right.

OPERATOR DESCRIPTION

,

: Reference operators

(space)

– Negation

% Percent

^ Exponentiation

* And / Multiplication and division

+ And – Addition and subtraction

& Concatenation

=

<

>
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> Comparison

=

<

=

<

>

 Use of parentheses : In order to change the order in which

an expression is evaluated, we enclose in parentheses the

part of the formula to be calculated first. For example, the

following formula produces 11 because Excel calculates

multiplication before addition. The formula multiplies 2 by 3

and then adds 5 to the result.

= 5+2*3

In contrast, if we use parentheses to change the syntax,

Excel adds 5 and 2 together and then multiplies the result

by 3 to produce 21.

= (5+2)*3

In the example below, the parentheses around the first part

of the formula forces Excel to calculate B4+25 first and then

divide the result by the sum of the values in cells D5, E5,

and F5.

=(B4+25)/SUM(D5:F5)

10.4 WORKING WITH FORMULA AND FUNCTIONS

Calculations in a worksheet are performed using formulas. Formulas

are one of the most useful features of spreadsheets like Excel. Formulas

can be as simple as adding two numbers or can be complex calculations

needed for high end business projections.

Excel 2007 formulas allow us to perform calculations on data entered

into the spreadsheet.

A formula is a set of mathematical instructions that can be used in

Excel to perform calculations. Formals are started in the formula box with

an = sign.
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There are many elements to an Excel formula.

 References – The cell/range of cells use in the calculation.

 Operators – Symbols (+, -, *, /, etc.) specifying the calculation

to be performed

 Constants – Numbers or text values that do not change

 Functions – Predefined formulas in Excel

 To create a basic formula in Excel :

1. We select the cell for the formula

2. Then type = (the equal sign) and the formula

3. Finally we click Enter

Example : The example creates a basic formula. The steps used to

create this basic formula are the same ones to follow when writing more

complex formulas. The formula will add the numbers 3 + 2. The final formula

will look like this:

= E1 + E2

1. Type a 3 in cell E1 and press the ENTER key.

2. Type a 2 in cell E2 and press the ENTER key.

When creating formulas in MS Excel, we always start by typing the

equal sign. We type it in the cell where we want the answer to appear.

3. Click on cell E3 (E3 displays the result).

4. Type the equal sign ( = ) in cell E3.

Following the equal sign, we add in the cell references of the cells

containing our data. By using the cell references of our data in the formula,

the formula will automatically update the answer if the data in cells E1 and

E2 changes. The best way of adding cell references is by using the Excel

feature called pointing. Pointing allows us to click on the cell containing the

data to add its cell reference to the formula.
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5. Click on cell E1 to enter the cell reference into the formula.

6. Type a plus ( + ) sign.

7. Click on cell E2 to enter the cell reference into the formula.

8. Press the ENTER key.

9. The answer 5 should appear in cell E3.

10. Click on cell E3. The formula = E1 + E2 is shown in the formula

bar above the worksheet.

 Functions : Excel functions are mathematical expressions

which are already available in excel, and are categorized by their

functionality. If we know the category of the function we are

looking for, we can click that category. Excel uses functions to

dynamically calculate results from data in our worksheets. There

are several in-built functions in Excel 2007 that can be used to

perform several operations on the data in a worksheet. Before

using those functions, let us go through a list of functions that

are provided by Excel 2007.

 Excel Date and Time Functions : Dates are very important

in spreadsheets. Not only is it important to add the current

date to a spreadsheet when it is created, but much of the

data stored in a spreadsheet is date related - such as the

date of purchases or expenditures, the length of term of

investments, and the date of scientific observations.

Function Description

DATE Returns the serial number of a particular date

DAY Converts a serial number to a day of the month

HOUR Converts a serial number to an hour

MINUTE Converts a serial number to a minute

MONTH Converts a serial number to a month

NOW Returns the serial number of the current date and time

TIME Returns the serial number of a particular time

YEAR Converts a serial number to a year

TODAY Returns the serial number of today’s date
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SECOND Converts a serial number to a second

WEEKDAY Converts a serial number to a day of the week

 Lookup and reference functions : The LOOKUP functions

of MS Excel 2007 help us find specific information in large

data tables such as an inventory list of parts or a large

membership contact list. They can also be used in array

formulas which makes it possible to create lookup formulas

using multiple criteria or to return entire records from a

database rather than just one field.

Function Description

ADDRESS Returns a reference as text to a single cell in a worksheet

COLUMN Returns the column number of a reference

HLOOKUP Looks in the top row of an array and returns the value of

the indicated cell

INDEX Uses an index to choose a value from a reference or

array

LOOKUP Looks up values in a vector or array

ROW Returns the row number of a reference

VLOOKUP Looks in the first column of an array and moves across

the row to return the value of a cell.

 Math and trigonometry functions

Function Description

ABS Returns the absolute value of a number

COS Returns the cosine of a number

DEGREES Converts radians to degrees

EXP Returns e raised to the power of a given number

FACT Returns the factorial of a number

FLOOR Rounds a number down, toward zero

INT Rounds a number down to the nearest integer

LOG Returns the logarithm of a number to a specified base

PI Returns the value of pi
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POWER Returns the result of a number raised to a power

PRODUCT Multiplies its arguments

SIN Returns the sine of the given angle

SQRT Returns a positive square root

SUM Adds its arguments

SUBTOTAL Returns a subtotal in a list or database

TAN Returns the tangent of a number

 Logical functions :

Function Description

AND Returns TRUE if all of its arguments are TRUE

FALSE Returns the logical value of FALSE

IF Specifies a logical test to perform

NOT Reverses the logic of its argument

OR Returns TRUE if any argument is TRUE

TRUE Returns he logical value of TRUE

 Database functions :

Function Description

DAVERAGE Returns the average of selected database entries

DCOUNT Counts the cells that contain numbers in a database

DMAX Returns the maximum value from selected database

entries

DMIN Returns the minimum value from selected database

entries

DPRODUCT Multiplies the values in a particular field of records that

match the criteria in a database

DSUM Adds the numbers in the field column of records in the

database that match the criteria

 Statistical functions :

Function Description

AVEDEV Returns the average of the absolute deviations of data

points from their mean
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AVERAGE Returns the average of its arguments

COUNT Counts how many numbers are in the list of arguments

DEVSQ Returns the sum of squares of deviations

GEOMEAN Returns the geometric mean

HARMEAN Returns the harmonic mean

MAX Returns the maximum value in a list of arguments

MEDIAN Returns the median of the given numbers

MIN Returns the minimum value in a list of arguments

 Text functions :

Function Description

CHAR Returns the character specified by the code number

CONCATENATE Joins several text items into one text item

DOLLAR Converts a number to text, using the $ (dollar)

currency format

LOWER Converts text to lowercase

TEXT Formats a number and converts it to text

TRIM Removes spaces from text

UPPER Converts text to uppercase

Apart from the above listed functions there are several more functions

that Excel uses to perform several other manipulation operation using data

in a spreadsheet.

 Inserting a function : Each of the functions of MS Excel 2007

is a predefined formula acting on a range of cells selected by

us. Excel refers to each range of cells in the function as an

argument. Although a few functions do not use arguments, most

have one or more and some complex functions use as many as

3 or 4 arguments. The Insert Function window of Excel makes

it easy to insert functions into  worksheets and does not require

us to remember the exact syntax of each function.

To insert a function we follow these steps :

1. Firstly we select the cell into which we have to insert the function.
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2. Then we click the Insert Function  button below the Ribbon

to open the Insert Function dialog box as in Figure 10.1

Fig. 10.1 : The Insert Function dialog box

3. Excel remembers the last ten functions used, and displays them

in the box labeled Select a function at the bottom of the window.

4. In order to insert a function, we do any one of the following

 If the function name appears in the last ten function list, we

click on the function name to select it.

OR

 If the function needed does not appear in the list at the bottom

of the window, we type the name of the function that we

want to use into the box labeled Search for a Function.

Then we click Go, which shows a list of recommended

functions in the Select a function list at the bottom of the

window. Then we click on the name of the function you wish

to insert from that list, and click OK to proceed.

5. Clicking OK displays the Function Arguments dialog box of

Figure 10.2
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Fig. 10.2 : The Function Argument dialog box

6. We then have to drag and select the cells that will be used as

the first argument of the function. As we select these cells, the

Function Arguments window will be temporarily minimized.

7. On finishing the selection making, the Function Arguments

window reappears and the first argument of the function will

appear in the box labeled Number 1.

8. In order to specify a second argument for the function we:

 Click inside the box labeled Number 2.

 Select the cell range for use in the second argument.

9. We may follow this process for specifying additional arguments

for our function.

10. Finally, clicking OK inserts the function into the worksheet.

CHECK YOUR PROGRESS

Q.1. Fill in the blanks:

(i) __________ specify the type of calculation that we want

to perform on the elements of a formula.

(ii) When two values are compared using __________

operators, the result is either TRUE or FALSE.
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(iii) A formula in Excel always begins with an __________

sign.

(iv) __________ in a worksheet are performed using

formulas.

(v) _________ are started in the formula box with an = sign.

(vi) The cell or range of cells used in calculation are called

__________.

(vii) __________ are Predefined formulas in Excel.

(viii) The __________ function returns the serial number of a

particular date.

Q.2. State whether the following statements are True or False

(i) The LOOKUP function looks in the first column of an

array and moves across the row to return the value of a

cell.

(ii) The ABS function returns the absolute value of a number.

(iii)  The SUBTOTAL function returns a subtotal in a list or

database.

(iv) AND function Returns TRUE if any argument is TRUE.

(v) DCOUNT counts the cells that contain numbers in a

database.

(vi) CHAR returns the character specified by the code

number.

(vii) Excel functions are not predefined formulas.

10.5 SORTING DATA

Sorting data is an integral part of data analysis. We sort data by

numbers (largest to smallest or smallest to largest) text (Z to A or A to Z),

and dates and times (newest to oldest and oldest to newest) in one or more

columns. We can also sort by a custom list (such as Small, Medium, and

Large) or by formats like font color, cell color, or icon set. Most sort operations

are column sorts, but we can also sort by rows.
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 To sort text we follow these steps :

1. Firstly, we select a column of alphanumeric data in a range

of cells, or make sure that the active cell is in a table column

containing alphanumeric data

2. On the Home tab, in the Editing group, we click Sort &

Filter.

3. Here we do one of the following:

 To sort in ascending alphanumeric order, we click Sort

A to Z.

 To sort in descending alphanumeric order, we click Sort

Z to A.

 To sort numbers we follow these steps :

1. Firstly, we have to select a column of numeric data in a range

of cells, or make sure that the active cell is in a table column

containing numeric data.

2. On the Home tab, in the Editing group, we click Sort &

Filter, and then do one of the following:

 To sort from low numbers to high numbers, we click Sort

Smallest to Largest.

 To sort from high numbers to low numbers, click Sort

Largest to Smallest.

 To Sort by cell color, font color, or icon we follow these

steps :

1. Firstly, we select a column of data in a range of cells, or

make sure that the active cell is in a table column.

2. On the Home tab, in the Editing group, we click Sort &

Filter, and then click Custom Sort, to open the Sort dialog

box of Figure 10.3
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Fig. 10.3 : The Sort dialog box

3. In the Sort by box and under Columns, we select the column

to be sorted.

4. Under Sort On, we select the type of sort. Do one of the

following:

 To sort by cell color, we select Cell Color.

 To sort by font color, we select Font Color.

 To sort by an icon set, we select Cell Icon.

5. Under Order, we click the arrow next to the button, and

depending on the type of format, we may select a cell color,

font color, or cell icon.

6. Under Order, we select define how to sort by doing one of

the following:

 To move the cell color, font color, or icon to the top or

left, we may select On Top for a column sort, and On

Left for a row sort.

 To move the cell color, font color, or icon to the bottom or

right, we may select On Bottom for a column sort, and

On Right for a row sort.

7. To specify the next cell color, font color, or icon to sort by, we

click Add Level, and then repeat steps three through five.

 Sort by more than one column or row : If we have data to be

grouped by the same value in one column or row, we might sort

by more than one column or row and then sort another column
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or row within that group of equal values. For example, if we have

a Department and Employee column, we can first sort by

Department (to group all the employees in the same department

together), and then sort by name (to put the names in alphabetical

order within each department). We can sort by up to 64 columns.

1. We select a range of cells with two or more columns of data,

or make sure that the active cell is in a table with two or

more columns.

2. On the Home tab, in the Editing group, we click Sort &

Filter, and then click Custom Sort to open the Sort dialog

box of Figure 10.3

3. Then under Column, in the Sort by box, we select the first

column to be sorted.

4. Under Sort On, we select the type of sort. We do one of the

following :

 To sort by text, number, or date and time, we select

Values

 To sort by format, we select Cell Color, Font Color, or

Cell Icon.

5. Under Order, we select as to how we want to sort. We do

one of the following:

 For text values, we select A to Z or Z to A.

 For number values, we select Smallest to Largest or

Largest to Smallest.

 For date or time values, we select Oldest to Newest or

Newest to Oldest.

 To sort based on a custom list, we select Custom List.

6. We click Add Level if we want to add another column to sort

by, and then repeat steps 3 through 5.

7. To copy a column to sort by, we select the entry, and then

click Copy Level.

8. To delete a column to sort by, we select the entry, and then

click Delete Level.
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9. To change the sorting order of the columns, we select an entry,

and then click the Up or Down arrow to change the order.

Entries higher in the list are sorted before entries lower in the list.

10.6 WORKING WITH CHARTS

In the previous versions of MS Excel, we had the chart wizard that

helped us to create charts. But in Excel 2007 there is no chart wizard, and

we can create a basic chart by clicking the chart type that we want on the

MS Office Fluent user interface known as Ribbon. To create a professional-

looking chart that displays the details that we want, we can modify the

chart, apply predefined styles and layouts, and add eye-catching formatting.

We can also reuse our favorite chart by saving it as a chart template.

Charts can convey much more than numbers alone can because

charts present data in a visual way that makes it easier to see the meaning

behind the numbers. MS Excel 2007 supports numerous types of charts

like Column Chart, Line Chart, Pie Chart, Bar Chart, XY-Scatter Chart etc.

to display data in ways that are meaningful to the user. We will introduce

only the Column Chart and Pie Chart in this section.

Creating a Chart

Different chart types have different data arrangement requirements

that relate to that particular type of chart. Therefore it is important to know

how the data has to be arranged before applying a chart to a data set. We

have shown only two types of data arrangement. You can explore the

remaining types using MS Excel’s help.
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 To create a chart we follow these steps :

1. Firstly, we arrange the data on the worksheet by following

any of the above mentioned ways of arrangement.

2. Select the cells that contain the data to be used for the chart

3. On the Insert tab, in the Charts group, we do one of the

following:

 We click the chart type, and then click a chart subtype

that we want to use.

 In order to see all available chart types, we click a chart

type, and then click All Chart Types to display the Insert

Chart dialog box, then click the arrows to scroll through

all available chart types and chart subtypes, and then

click the ones to be used.

Column charts : Data that is arranged in columns or rows on a

worksheet can be plotted in a column chart. Column charts are useful for

showing data changes over a period of time or for illustrating comparisons
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among items. In column charts, categories are typically organized along

the horizontal axis and values along the vertical axis.

Example : Let us consider the marks obtained by three students in

three subjects as shown below. We will create a chart to represent their

individual performances.

English Mathematics Science

Ramesh 65 70 72

Jyoti 75 60 55

Suraj 88 77 68

We represent this data using a 2D column chart by the following

steps:

1. We insert the above data in an Excel worksheet as shown.

2. Then we select the data

3. Clicking the Insert tab of the Ribbon we select a Chart type

from the Charts group.

4. The data in the table is then displayed in the selected chart type

as shown in Figure 10.4

Fig. 10.4 : A 2D Column chart

 The different elements in a chart : A Chart has many elements.

Some of these elements are displayed by default, while others

can be added as needed. We may change the display of the
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chart elements by moving them to other locations in the chart,

resizing them, or by changing the format. We can also remove

chart elements that we do not want to display.

Fig. 10.5 : The different elements of a chart

1. The chart area of the chart, which includes the entire chart and

all its elements.

2. The plot area of the chart, which is the area bounded by the

axes, including all data series in a 2D chart. In a 3D chart, it is

the area bounded by the axes, including the data series, category

names, tick-mark labels, and axis titles.

3. The data points of the data series that are plotted in the chart.

Data series: The related data points that are plotted in a chart.

Each data series in a chart has a unique color or pattern and is

represented in the chart legend. We can plot one or more data

series in a chart. Pie charts have only one data series. Data

points are the individual values plotted in a chart and represented

by bars, columns, lines, pie or doughnut slices, dots, and various

other shapes called data markers. Data markers of the same

color constitute a data series.
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4. The horizontal (category) and vertical (value) axis along which

the data is plotted in the chart. The Axis is a line bordering the

chart plot area used as a frame of reference for measurement.

The y axis is usually the vertical axis and contains data. The x-

axis is usually the horizontal axis and contains categories.

5. The legend of the chart which is a box that identifies the patterns

or colors that are assigned to the data series or categories in a

chart.

6. A chart and axis title used to describe text that is automatically

aligned to an axis or centered at the top of a chart.

7. A data label used to identify the details of a data point in a data

series, provides additional information about a data marker, which

represents a single data point or value that originates from a

datasheet cell.

When we hover the mouse pointer over one of these elements in

the chart area, Excel displays information about that element in a ScreenTip.

Clicking anywhere in a chart also makes the Chart Tools available,

adding the Design, Layout, and Format tabs.

Pie charts : Data that is arranged in one column or row only on a

worksheet can be plotted in a pie chart. Pie charts show the size of items in

one data series proportional to the sum of the items. The data points in a

pie chart are displayed as a percentage of the whole pie.

We should use a pie chart when :

 We only have one data series to plot.

 None of the values to be plotted are negative.

 Almost none of the values to be plotted are zero values.

 We do not have more than seven categories.

 The categories represent parts of the whole pie.

Example : Let us consider the example of marks obtained by a

student in five subjects. This time we will create a pie chart to represent the

student’s individual performance in each subject.
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English Maths Science Hindi Computer

Ramesh 65 80 72 70 90

We represent this data using a 2D pie chart by the following steps:

1. We insert the above data in an Excel worksheet as shown.

2. Then we select the data

3. Clicking the Insert tab of the Ribbon we select a Chart type

from the Charts group.

4. The data in the table is then displayed in the selected chart type

as shown in Figure 10.6

Fig. 10.6 : A Pie chart

CHECK YOUR PROGRESS

Q.3. Fill in the blanks:

(i) We can ____ data by text, numbers, dates and times in

one or more columns.

(ii) We can sort by more than one _______ or ___.

(iii) Excel 2007 does not have a ______ wizard.

(iv) _______ present data in a visual way.

(v) ____ charts show the size of items in one data series,

proportional to the sum of the items.
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10.7 LET US SUM UP

 Excel 2007 is used to perform tasks related to the data organized in

rows and columns in a spreadsheet.

 Operators in Excel are used to perform numerous operations on

different types of data.

 Calculations in Excel are performed using formulas

 Functions are mathematical expressions already available in Excel

 Formulas are mathematical expressions that we create to calculate

result

 LOOKUP Functions can help you find specific information in large

data tables

 Excel’s Insert Function window makes it easy to insert functions into

your worksheets and eliminates the need to remember the exact

syntax of each function.

 Sorting data is an integral part of data analysis

 You can also reuse a favorite chart by saving it as a chart template

 The chart area of the chart, which includes the entire chart and all

its elements.

10.8 FURTHER READINGS

 "Introduction to Information Technology", by Sanjay Saxena, Vikash

Publishing, New Delhi.

 "SAMS teach yourself Microsoft Office 2003 in 24 Hours" by Greg

Prerry, Pearson Education.

10.9  ANSWERS TO CHECK YOUR
PROGRESS

Ans. to Q. No. 1 : (i) Operators, (ii) logical, (iii) equal, (iv) calculations,

(v) Formulas, (vi)  references, (vii) Functions, (viii) DATE
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Ans. to Q. No. 2 : (i) False, (ii) True, (iii) True, (iv) False, (v) True,

(vi) True, (vii) False

Ans. to Q. No. 3 : (i) sort, (ii) column, row, (iii) chart, (iv) Charts, (v) Pi

10.10 MODEL QUESTIONS

Q.1. What are operators in Excel? How many types of operators are there

in Excel?

Q.2. What is the text concatenation operator in Excel and why is it used?

Q.3. How are calculations performed in excel? give examples.

Q.4. What is a formula? Give an example showing the use of formulas in

excel

Q.5. What are excel functions? Give examples  of the LOOKUP function

Q.6. How do we create a function in a worksheet

Q.7. What do you mean by sorting data in excel? Give the steps to apply

sorting by cell color

Q.8. What are charts in excel and why are they used ?

Q.9. What are pie charts? Create a pie chart to show data trends.

Q.10. Define the different elements in a chart.
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UNIT 11 : MICROSOFT POWERPOINT

UNIT STRUCTURE

11.1 Learning Objectives

11.2 Introduction

11.3 Starting MS PowerPoint

11.4 Creating a New Presentation

11.5 Working with Slides

11.6 Applying Text and Graphics

11.7 Applying Themes

11.8 Customizing Slide Show

11.8.1 Applying Custom Animation

11.8.2 Applying Slide Transition

11.9 Saving, Running and Closing a Presentation

11.10 Opening an Existing Presentation

11.11 Let Us Sum Up

11.12 Further Readings

11.13 Answers to Check Your Progress

11.14 Model Questions

11.1 LEARNING OBJECTIVES

After going through this unit, you will be able to:

 know the use of PowerPoint

 create presentations in PowerPoint

 work with text and graphics in PowerPoint

 use design templates

 apply slide animation and transition effects

 work with PowerPoint presentations

11.2 INTRODUCTION

Before computers were commonplace, presenters usually had an

easel with posters or drawings to show any necessary graphics to the
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audience. In some cases the speaker would have a slide projector with a

carousel of individual slides to show photographs on a screen.

Today, many software package suites contain a program designed

to accompany the speaker when he makes a presentation. The specific

presentation program in this suite of programs is usually (but not always)

in the form of a slide show, much like the ones used in the past. These

presentation software programs make it simple and often fun to create a

presentation for the audience. They contain a text editor to add written

content, and abilities within the program to add charts and graphic images

such as photographs, clip art or other objects to liven up the slide show

and get our point across simply. Microsoft PowerPoint, usually just called

PowerPoint, is a commercial presentation program developed by Microsoft,

and is part of the Microsoft Office suite.

Microsoft Office PowerPoint 2007 provides a comprehensive set of

features that can be used to create and format our information. We can

create and add designer-quality SmartArt graphics with only a few mouse-

clicks. This unit provides an introduction to MS PowerPoint 2007, and

describes the methods and tools to create powerful and eye-catching

presentations.

11.3 STARTING MS POWERPOINT

In order to work with PowerPoint and start building presentations

we first have to start PowerPoint 2007. To start MS PowerPoint 2007, we

have to follow these steps:

1. Firstly, we click on the START button.

2. Then we click/hover on All Programs which opens a list of all

the installed programs.

3. We then click on the Microsoft Office option which shows a list

of the installed MS Office applications as shown in Figure 11.1
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Fig. 11.1 : The MS Office 2007 applications

Fig. 11.2 : The Microsoft PowerPoint 2007 application window
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Slide pane : Allows us to work directly on individual slides.

Placeholders : These are the borders that are part of most slide

layouts, where we can type text or insert pictures, charts, and other objects.

Slides tab : This tab shows a thumbnail version of each full size

slide shown in the Slide pane.

Notes pane : Here we can type notes about the current slide.

11.4 CREATING A NEW PRESENTATION

After we start PowerPoint as shown in the previous section, we are

presented with the PowerPoint working interface as in Figure 11.2 above.

To begin working with PowerPoint and start creating a new presentation

we follow these steps.

1. Firstly we click the MS Office button of PowerPoint and select

New.

OR

Click the New icon  on the Quick Access toolbar

OR

Press Ctrl + N on the keyboard

2. If we click the New icon or press Ctrl + N, a blank presentation

automatically opens.

OR

If we select New from the Office button, the New Presentation

dialog box of Figure 11.3 opens where we do any one of the

following.

 To apply a recently used template, we click Blank and

recent, and click the template that we want, and then click

Create.

 To apply a template installed to the local hard drive, we click

Installed Templates, and then click Create.

 To create (and apply) a new template based on another

template that is installed on the local hard drive, we click

New from existing, and then click Create New.
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 To apply a template that has been saved to C:\Program

Files\Microsoft Office\Templates\, we click My templates,

select a custom template, and then click OK.

 To download and apply a template from Office Online, under

Microsoft Office Online, we click a template category,

select a template, and then click Download.

Fig. 11.3 : The New Presentation dialog box

Now that we are ready to begin working on our new presentation,

we will be discussing further on how to work with the different elements of

a PowerPoint presentation in the later units.

11.5 WORKING WITH SLIDES

When working with MS PowerPoint we apply text, sound, color,

graphic, animation, transitions etc to our presentation, and these effects

are represented on slides. To create an effective PowerPoint presentation

we should be able to carry out slide related tasks. Inserting, deleting, reusing

slides to a presentation are a few of them and which will be discussed in

this section.

 Adding Slides : There are several choices when we want to

add a new slide to the presentation: Office Themes, Duplicate

Selected Slide, or Reuse Slides.

To create a new slide from Office Themes, we follow these
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steps :

1. Firstly, we select the slide immediately BEFORE where the

new slide is to be inserted.

2. Then we click the New Slide button on the Home tab.

3. Finally, we click the slide choice that fits our material.

 Duplicate Slides :

To create a slide as a duplicate of a slide in the presentation

we follow these steps :

1. Firstly we select the slide that we want to duplicate.

2. Then we click the New Slide button on the Home tab

3. Finally we click Duplicate Selected Slides

A Slide may also be duplicated by right-clicking the slide and

selecting Duplicate Slide.

 Reusing Slides

To create a new slide from another presentation we follow

these steps :

1 Firstly we select the slide immediately BEFORE where we

want the new slide

2 Then we click the New Slide button on the Home tab

3 We click Reuse Slides

4 We click Browse

5 We click Browse File and locate the slide show and click

on the slide to import.

 Changing the layout of slide/slides : We can change the layout

of slide/slides by applying a different layout to.

To do so we follow these steps :

1. Firstly we select the slide/slides.

2. From the Slides group on the Home tabs, we click on the

layout button 

3. Finally we select the layout that we want.

 Deleting slide/slides : We can delete one or many slides at a

time.

To do so we follow these steps :
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1. First we select the slide/slides that we want to delete

2. Then we right-click on the selected slide/slides, and select

Delete Slide.

OR

From the Slides group on the Home tabs, we click on the

Delete button 

 Changing the background of a slide/slides :

1. Firstly we select the slide.

2. Then we right-click the slide and select Format

Background, which opens the Format Background dialog

box of Figure 11.4.

Fig. 11.4 : The Format Background dialog box

In the dialog box of Figure 11.4, we have several options to

choose from whereby we can apply different fills to the

background.

3. After selecting the background Fills, we may Close the

dialog box, which applies the effects only to the selected

slide. Clicking on Apply to All applies them to all the slides
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in the presentation.

 Changing the order of slides : When we create a presentation,

we may sometimes want to change the order of the slides.

1. In the pane that contains the Outline and Slides tabs, we

click the Slides tab.

2. Then on the Home tab, we select the slide thumbnails that

are to be moved, and then drag them to their new location.

11.6 ADDING TEXT AND GRAPHICS

When creating presentations in PowerPoint 2007, we have to work

with text and graphics. Text and graphics are an integral part of any

presentation since they act together to bring forward the purpose and

objective of a PowerPoint presentation. Text can be inserted, edited, cut,

copied, pasted, and formatted by changing the Face, Type and Color.

Paragraphs of text can be formatted by indenting them, etc. Graphics in

PowerPoint can be included by inserting pictures, Clip Art, Shape, Smart

Art etc. in this section we discuss these aspects of PowerPoint.

 Working with text :

 To enter text we follow these steps:

1. Firstly, we select the slide where we want the text

2. Then we click in a Textbox to add text

 To add a text box we follow these steps:

1. Firstly, we select the slide where we want to place the

Text Box

2. On the Insert tab, we click Text Box

3. Then we click on the slide and drag the cursor to expand

the Text Box

4. Finally we type in the text.

 To copy and paste data we follow these steps:

1. Firstly, we select the item(s) to be copied

2. On the Clipboard group of the Home tab, we click Copy

3. Then we select the item(s) where we would like to copy
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the data

4. Finally, on the Clipboard group of the Home tab, we

click Paste

 To cut and paste data we follow these steps:

1. Firstly, we select the item(s) to be cut

2. On the Clipboard group of the Home tab, we click Cut

3. Then we select the items(s) where we would like to copy

the data

4. Finally, on the Clipboard group of the Home tab, we

click Paste

 To change the font typeface we follow these steps:

1. In the Font group under the Home menu, we click the

arrow next to the font name and choose a font.

2. We can preview how the new font will look by highlighting

the text, and hovering over the new font typeface.

 To change the font size we follow these steps:

 We click the arrow next to the font size and choose the

appropriate size

OR

 We click the increase or decrease font size buttons.

 Font Styles and Effects : Font styles are predefined formatting

options that are used to emphasize text.  They include:  Bold,

Italic, and Underline.

 To add these to text we follow these steps:

 We select the text and click the Font Styles included on

the Font group of the Home tab
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OR

 We select the text and right click to display the font tools

 To change the text color we follow these steps :

1. We select the text and click the Colors button 

included on the Font Group of the Ribbon

OR

We highlight the text, right click and choose the colors

tool.

2. Then we select the color by clicking the down arrow next

to the font color button.

 WordArt : WordArt is a gallery of text styles that we can add to

any 2007 Microsoft Office system documents to create

decorative effects, such as shadowed or mirrored (reflected)

text. In Microsoft Office PowerPoint 2007, we can also convert

existing text into WordArt.

 To apply Word Art we follow these steps :

1. Firstly, we select the text

2. Then from the Text group of the Insert tab we click the

WordArt button

3. Finally we choose the WordArt to be applied

 Working with Graphics : We can add Pictures, ClipArt, Shapes,

SmartArt or a Photo Album to a presentation.

 To add a picture we follow these steps :

1. Firstly we click the Insert tab.

2. We click the Picture button  from the Illustrations

group

3. We browse to the picture from the files and click the

name of the picture

4. We click insert

5. To move the graphic, we click it and drag it to where we
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want it.

 Clipart : Clipart is a single piece of ready-made art, often

appearing as a bitmap or a combination of drawn shapes that

we can use in our presentation.

 To add Clip Art we follow these steps:

1. Firstly, we click the Insert tab

2. Then from the Illustrations group we click the Clip Art

button

3. We may search for the clip art using the search Clip Art

dialog box

4. Finally we click the clip art

5. To move the graphic, we click it and drag it to where we

want it

 To add Shapes to a presentation we follow these steps:

1. Firstly, we click the Insert tab

2. On the Illustrations group, we click the Shapes button

         and click the shape we want

3. Then we click and drag on the slide to draw the shape

4. Finally we drag the cursor to resize the Shape.

 Adding SmartArt : SmartArt is a feature in Office 2007 that

allows us to choose from a variety of graphics, including flow

charts, lists, cycles, and processes.

 To add SmartArt we follow these steps:

1. Firstly, we click the Insert Tab

2. We click the SmartArt button                 on the Illustrations

group

3. This opens the Choose a SmartArt Graphic dialog box

Microsoft PowerPointUnit 11



Computer Fundamentals and PC Software 265

of Figure 11.5

Fig. 11.5 : The Choose a SmartArt Graphic dialog box

4. We select the SmartArt and click OK

5. Finally we drag it to the desired location on the slide

 Photo Album : The photo album feature is new in PowerPoint

2007 and allows us to easily create a photo album to share

pictures.

 To create a photo album we follow these steps:

1. Firstly, we click the Insert tab

2. Then from the Illustrations group, we click the Photo

Album button

3. Then we select New Photo Album which opens the

Photo Album dialog box of Figure 11.6

4. We click File/Disk which opens up the Insert New
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Pictures dialog box of Figure 11.7

Fig. 11.6 : The Photo Album dialog box

Fig. 11.7 : The Insert New Pictures dialog box

5. We browse through to find the picture to add to the photo
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album.

6. Finally, we move the pictures up and down in the order

of the album by clicking the up/down arrows in the Photo

Album dialog box.

11.7 APPLYING THEMES

Design themes are a new addition to PowerPoint 2007. They work

in a similar way as the design templates in earlier versions of PowerPoint.

A really nice feature of the design themes, is that we can immediately see

the effect reflected on our slides, before making a decision as to which

theme has to be applied to our presentation finally. Microsoft Office

PowerPoint 2007 contains several built-in themes which include theme

colors, theme fonts, and theme effects such that if we change the theme, a

complete set of new colors, fonts, and effects is applied to our entire

document. We can use these themes and customize them by changing a

few elements according to our needs.

 To apply a theme to our presentation we follow these steps :

If a blank presentation is already open–

1. In the Themes group on the Design tab are shown the

available themes. More themes can be seen on clicking the

More  button as shown in Figure 11.8

2. Clicking on any theme applies that theme to the slides.

Fig. 11.8: The Themes group

If a blank presentation is not open already–

1. In the New Presentation dialog box of Figure 11.3, we

select any of the installed themes

2. Then we click Create to apply the selected them to the slide/

slides.

 Design Theme Color Schemes : Once we have selected a
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style of design theme that we like for the PowerPoint presentation,

we are not limited to the color of the theme as it is currently

applied.

1. We click on the Colors button  at the right end of

the design themes on the Design ribbon.

2. Then we hover the mouse over the various color schemes

shown in the drop down list. The current choice will be

reflected on the slide.

3. Finally we click the right color scheme.

 Select a Font Family : Each design theme is assigned a font

family. Once the design theme for the PowerPoint presentation

is selected, we can change the font family to one of the many

groupings within PowerPoint 2007.

1. Firstly, we click the Fonts button  at the right end

of the design themes shown on the Design ribbon.

2. Then we hover over any of the font families to see how this

group of fonts will look in the presentation.

3. On making the selection, we click the mouse and the font

family will be applied to our presentation.

 Change the Background Style : Just as we changed the

background on a plain PowerPoint slide, we can do the same

while using one of the many design themes.

1. We Click the Background Styles button 

on the Design ribbon.

2. Then we hover over any of the background styles.

3. The background style will be reflected on the slide for us to

evaluate.

4. Finally on getting our desired background style we click the

mouse.

 Hide background Graphics : Sometimes we want to show

slides with no background graphics. which is often the case for

printing purposes. The background graphics will remain with
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the design theme, but can be hidden from view.

1. We check the Hide Background Graphics box on the

Design ribbon. 

2. The background graphics will disappear from our slides, but

can be turned back on at any later time, by simply removing

the check mark in the box.

 Select a set of theme effects : Theme effects are sets of lines

and fill effects. When we click the Theme Effects button, we

see the lines and fill effects used for each set of theme effects

in the graphic displayed with the Theme Effects name. Even if

we cannot create our own set of theme effects, we can choose

the one we want to use in our own document theme.

1. Firstly, on the Design tab, in the Themes group, we click

Theme Effects 

2. Then we click the effect we want.

 Save a theme : We can save any changes made to the colors,

fonts, or line and fill effects of a theme as a custom theme that

we can apply to other documents or presentations.

1. On the Design tab, in the Themes group, click More.

2. Then we click Save Current Theme.

3. In the File Name box, we type an appropriate name for the

theme, and then click Save.

The custom theme is saved in the Document Themes folder

as a .thmx file and is automatically added to the list of custom

themes.

CHECK YOUR PROGRESS

Q.1. Fill in the blanks:

(i) _________ allows us to work directly on individual slides.

(ii) _________ are the borders that are part of most slide

layouts, where you can type text or insert pictures, charts,
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and other objects.

(iii) __________ is a single piece of ready-made art, often

appearing as a bitmap or a combination of drawn shapes

that we can use in our presentations.

(iv) __________ is a feature in Office 2007 that allows us to

choose from a variety of graphics, including flow charts,

lists, cycles, and processes.

(v) We can customize __________ by changing a few

elements according to our needs.

Q.2. State whether the following statements are True or False.

(i) Font styles are predefined formatting options that are

used to emphasize text.

(ii) In PowerPoint 2007, we cannot convert existing text into

WordArt.

(iii) We can add Pictures, ClipArt, Shapes, SmartArt or a

Photo Album to a presentation.

(iv) We cannot delete one or many slides at a time.

(v) Theme effects are sets of lines and fill effects.

11.8 CUSTOMIZING SLIDE SHOW

In the previous section we have learnt the basics of PowerPoint,

the way PowerPoint presentations are created and the different methods

of working with slides were also discussed. Text and Graphics, that are the

heart and soul of every powerful and eye-catching PowerPoint presentation,

have already been discussed. Apart from text and graphics we can also

customize a presentation by applying animation and transition effects to

our slides. Animation is nothing but the way of adding a special visual or

sound effect to a slide object. For example, we can have our text bullet

points fly in from the left, one word at a time, or hear the sound of applause

when a picture is uncovered. We can use animation to focus on important

points, to control the flow of information, and to increase viewer interest in

our presentation.

Slide transitions are the visual effects that are applied to a
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presentation, and can be seen when we move from one slide to another

slide during the presentation. These slide transition effects prevent the viewer

from seeing a sudden change between slides, and present a smooth and

gradual change between the slides.

In the next two sections, we shall be dealing with these two aspects

of PowerPoint presentations.

11.8.1 Applying Custom Animation

PowerPoint 2007 has numerous animation effects to choose

from. Apart from that, we can also apply other animation effects

that have been customized by us to gain more control over how

and when effects are applied. For example, we can make text grow

or shrink, spin or shimmer, and we can set an animation to hear the

sound of applause when a picture is revealed. We can apply more

than one animation, so we can make a line of text fly in with or

without sound, and then make the text fly out. We can use emphasis,

entrance, or exit options in addition to preset or custom motion

paths.

We create custom animations in the Custom Animation task

pane.  The Custom Animation task pane shows important information

about an animation effect, including the type of effect, the order of

multiple effects in relation to each other, and a portion of the text of

the effect.

 Add a Custom Animation from the Quicklist :

 Animations Tab on the Ribbon :

1. Firstly, we click the Animations tab on the ribbon.

2. We select the object to be animated, such as a text box,

or a graphic object.

3. We click the drop down button beside the Custom

Animation button located beside Animate

4. The list of options allows us to quickly add one of the
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most commonly used animation types.

 Open the Custom Animations Task Pane :

1. We simply click on the Custom Animation button on the

Animations group under the Animations menu.

2. This opens the Custom Animations task pane on the right

side of the screen.

Fig. 11.9 : The Custom Animation task pane

3. We choose the title, a picture or clip art, or a bulleted list to

apply the first animation by the following.

 We select graphics by clicking on the object.

 We select a title or bulleted list by clicking on the border

of the text box.

4. Once an object has been selected, the Add Effect button

becomes active in the Custom Animations task pane.

5. We select a style of effect, such as Entrance, Emphasis,

Exit or Motion Path. Choosing one of these styles will reveal

a sub-menu with selections of animations.

6. We click on different animations and we will see a preview

of the effect on the slide.
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7. Lastly we make our selection.

 Modifying an Animation Effect :

1. Firstly, we select the object whose animation effect has to

be modified

2. To modify the custom animation effect, we select the drop-

down arrow beside each of the three categories – Start,

Direction and Speed.

a) Start

 On click – Starts the animation on the mouse click

 With previous – Starts the animation at the same time

as the previous animation (could be another animation

on this slide or the slide transition of this slide)

 After previous – Starts the animation when the previous

animation or transition has finished

b) Direction

 This option will vary depending on which Effect we have

chosen. Directions can be from top, from right side,

from bottom and so on.

c) Speed

 Speeds vary from Very Slow to Very Fast.

 Move Animation Effects Up or Down in the List : After

applying more than one animation to a slide, we may wish to re-

order them so that the title appears first and objects appear as

they are referred.

1. Firstly, we click on the animation to be moved.

2. Then we use the Re-Order arrows at the bottom of the

Custom Animation task pane to move the animation up or

down in the list.

 Other Effect Options for Custom Animations : We can apply

additional effects to objects on our PowerPoint slides such as

sound effects or dim the previous bullet points as each new

bullet appears.

1. Firstly we select the effect in the list.
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2. Then we click the drop-down arrow to see available options.

3. We select Effect Options which opens the dialog box in

Figure 11.10

Fig. 11.10 : The Effect Options dialog box

Timings are sett ings that automate our PowerPoint

presentation. We can set the number of seconds for a specific item

to show on screen and when it should start.

In the Timing dialog box we can also modify settings previously

set.

Text Animations allow us to introduce text on the screen by

paragraph level, automatically after a set number of seconds or in

reverse order.

11.8.2 Applying Slide Transition

Slide transitions are the animation-like effects that occur in Slide

Show view when moving from one slide to the next during an on-

screen presentation. We can control the speed of each slide

transition effect, and can also add sound.

Transition effects add some great animation to the slides in a

presentation. Microsoft Office PowerPoint 2007 includes many

different types of slide transitions. These transition effects are
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included in groups, each group having several effects of different

types. The groups are Fades and Dissolves, Wipes, Push and Cover

and Stripes and Bars.

 To add the same slide transition to all of the slides in a

presentation we follow these steps:

1. Firstly, on the left side of the slide window, in the pane that

contains the Outline and Slides tabs, we click the Slides tab.

2. Then we select the slide thumbnails of the slides that we

want to apply slide transitions to.

3. On the Animations tab, in the Transition To This Slide

group, we click a slide transition effect.

To see more transition effects we may click the More button

4. To set the slide transition speed between the current slide

and the next slide, in the Transition To This Slide group,

we click the arrow next to Transition Speed, and then select

the speed that we want.

5. In the Transition To This Slide group, we click Apply to All.

 To add different slide transitions to the slides in a

presentation we follow these steps:

1. On the left side of the slide window, in the pane that contains

the Outline and Slides tabs, we click the Slides tab, and

then click a slide thumbnail.

2. On the Animations tab, in the Transition To This Slide

group, we click the slide transition effect that we want for

that slide.

To see more transition effects, we may click the More button

3. To set the slide transition speed between the current slide

and the next slide, in the Transition To This Slide group,

we click the arrow next to Transition Speed, and then select

the speed that we want.

4. To add a different slide transition to another slide in the
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presentation, we may repeat steps 2 through 4.

11.9 SAVING, RUNNING AND CLOSING A
PRESENTATION

After we have finished creating our presentation in PowerPoint 2007,

we have to save it in order to later use it. Let us now see how we can save,

run and close a presentation in PowerPoint 2007.

 To save a presentation we follow these steps:

1. Firstly, we click the Microsoft Office button  then click Save.

OR

Click the Save button 

OR

Press Ctrl + S

2. If we are saving the file for the first time, we are asked to

give it a name as in Figure 4.11

Fig. 11.11 : The Save As dialog box

We then specify the file format type in the Save as type list, in

which the presentation is to be saved. If we want to save the file for use in

earlier version of PowerPoint, we may save our file in the 97-2003 file

Microsoft PowerPointUnit 11



Computer Fundamentals and PC Software 277

format by selecting 97-2003 from that list.

 Running a presentation : Running a finished presentation in

PowerPoint gives us several options to choose from, that allow

us to run a presentation in a variety of ways.

Clicking on the Slide Show tabs on the Ribbon shows us a lot

of options as shown in Figure 11.12

Fig. 11.12 : Options for slide show

In the Start Slide Show group there are options to choose from

that allow us to begin the slide show.

 From beginning : Clicking on this option begins the slide

show from the very first in the presentation.

 From Current Slide : Clicking on this option begins the

slide show from the slide that is selected.

 Custom Slide Show : Clicking this option and then selecting

Custom Shows opens the dialog box of Figure 11.13, which

allows us to define the sequence of the slides in the show.

Fig. 11.13 : The Custom Shows dialog box

 We click the New button to open the Define Custom Show
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dialog box of Figure 11.14

Fig. 11.14 : The Define Custom Show dialog box

The Slides in presentation box display the slides that are

included in the current presentation, and the Slides in custom

show list display the slides that are included in the Custom

show. To add slides to the Custom show, we select the slide in

the Slides in presentation list and click the Add button, which

adds that particular slide to the Slides in Custom show list.

 After including the slides to our Custom show, we give it a

name and click OK, which closes the Define Custom Show

dialog box. The Custom Shows list in the Custom Shows

dialog box now includes the name of our custom show.

 To run the presentation we may click the Show button of

the Custom Shows dialog box or Close the Custom Shows

dialog box to run the presentation at a later stage.

 To run the presentation at a later stage, we click on the

Custom Slide Show button on the Ribbon in the Start Slide

Show group under the Slide Show menu, and click on the

name of our Custom show which starts the show.

 Closing a presentation : We can have several ways by which

we close a presentation.

When we finish viewing the last slide of a presentation, we get

to see the screen as in Figure 11.15

Microsoft PowerPointUnit 11



Computer Fundamentals and PC Software 279

Fig. 11.15 : End of a Presentation

From the figure It is quite obvious that the presentation has

ended and we are asked to close the presentation with a mouse-

click.

We can also close a presentation mid-way during the slide show

by

 Right-clicking on the slide being shown and selecting End

show.

OR

 Pressing the Esc key.

11.10OPENING AN EXISTING PRESENTATION

We have already learnt how to create various kinds of presentations

in PowerPoint 2007, adding text, graphics, transitions etc. Let us now see

how to open an already existing PowerPoint presentation.

 To open a presentation we follow these steps :

1. We click the Microsoft office button and select the Open

option

OR

Use the keyboard shortcut Ctrl + O

OR

Click the Open icon  on the Quick Access toolbar
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2. This opens the Open dialog box as in Figure 11.16

Fig. 11.16 : The Open dialog box

3. We browse through directories and select an already existing

MS PowerPoint file.

4. Then we click the Open button to open the selected file in

PowerPoint.

CHECK YOUR PROGRESS

Q.3. Fill in the blanks:

(i) Animation is the way of adding a special __________ or

__________ effect to a slide object.

(ii) We can apply animation effects that have been

__________ to gain more control over how and when

effects are applied.

(iii)  We create custom animations in the __________ task

pane.

(iv) __________ are settings that allow us to automate our

 

Microsoft PowerPointUnit 11



Computer Fundamentals and PC Software 281

PowerPoint presentation.

(v)  We can set the number of __________ for a specific

item to show on screen and when it should start.

(vi) We can control the speed of each slide __________

effect.

(vii)  __________ effects are included in groups, each group

having several effects of different types.

(viii) The Slides in __________ box display the slides that

are included in the current presentation, and the Slides

in __________ display the slides that are included in

the Custom show.

11.11 LET US SUM UP

 PowerPoint, is a commercial presentation program

 Slides in a PowerPoint presentation may contain text, graphic,

effects, sounds etc

 We can change the layout of our PowerPoint slide/slides

 WordArt is a gallery of text styles

 The photo album feature is new in PowerPoint 2007 and it allows

us to easily create a photo album to share pictures.

 Design themes are a new addition to PowerPoint 2007.

 Slide transitions are the visual effects that are applied to a

presentation, and can be seen when we move from one slide to

another slide during the presentation.

 The Custom Animation task pane shows important information about

an animation effect.

 Text Animations allow us to introduce text on our screen by

paragraph level, automatically after a set number of seconds or in

reverse order.

 Slide transitions are the animation-like effects that occur in Slide

Show view when you move from one slide to the next during an on-
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screen presentation.

11.12 FURTHER READINGS

 "Introduction to Information Technology", by Sanjay Saxena, Vikash
Publishing, New Delhi.

 "SAMS teach yourself Microsoft Office 2003 in 24 Hours" by Greg

Prerry, Pearson Education.

11.13 ANSWERS TO CHECK YOUR
PROGRESS

Ans. to Q. No. 1 : (i) Slide pane, (ii) Placeholders, (iii) ClipArt,

(iv) SmartArt, (v) themes

Ans. to Q. No. 2 : (i) True, (ii) False, (iii) True, (iv) False, (v) True

Ans. to Q. No. 3 : (i) visual, sound, (ii) customized, (iii) Custom Animation,

(iv) Timings, (v) seconds, (vi) transition, (vii) Transition,

(viii) presentation, custom show list

11.14 MODEL QUESTIONS

Q.1. What is MS PowerPoint 2007, and why is it used?

Q.2. How do we create a new PowerPoint presentation?

Q.3. What are slides and what are the operations that we perform on

slides?

Q.4. What are text and Graphics in PowerPoint and how can we use

them?

Q.5. What are PowerPoint SmartArt? How do we use them?

Q.6. What are design themes in PowerPoint 2007, and how do we apply

them?
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Q.7. What is animation in PowerPoint 2007?

Q.8. How can we apply Custom Animation to our PowerPoint presentation

slides?

Q.9. What are slide transition effects? Give an example of applying any

transition effect to slides.

Q.10. How do we run a PowerPoint presentation?
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